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Bem-vindo ao
Autodesk Navisworks
Freedom 2012

O software Autodesk Navisworks Freedom 2012 é um visualizador grátis para arquivos
NWD e DWF™. Use o Navisworks Freedom para ampliar a visualização de todo o
projeto a todos os interessados no projeto, a fim de ajudar a aprimorar a comunicação
e a colaboração. Os modelos multidisciplinares criados em aplicativos de modelagem
de informações de construção (BIM), protótipo digital (DP) e projeto de plantas de
processo podem ser combinados em um único modelo de projeto integrado e
publicados no formato NWD usando o software Autodesk Navisworks Manage ou o
Autodesk Navisworks Simulate. O arquivo publicado fornece acesso à hierarquia do
modelo, às propriedades do objeto e aos dados de revisão incorporados, incluindo
os pontos de vista, as animações, as linhas de marcação e os comentários.

O que há de novo nesta versão?
O Autodesk Navisworks Freedom 2012 contém muitos novos recursos e
aprimoramentos.

Interface do usuário

Acesso fácil às ferramentas de navegação e revisão mais usadas para aumentar
a produtividade da revisão.

■ A guia Viewpoint agora inclui o painel Navigate, fornecendo acesso a
ferramentas como Navegar, Pan, Zoom e Órbita, os menus de rastreamento
SteeringWheels, o mouse 3D 3Dconnexion e as configurações de
realismo.

1
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Suporte a formatos de arquivo da Autodesk

Agora, o Autodesk Navisworks oferece suporte a DWF 2D e DWF de várias
folhas, permitindo que você abra, revise e explore os conjuntos de dados 2D
ao lado de seus modelos 3D. Importante: a vista 2D é integrada ao ambiente
3D. Ele permite selecionar um componente no modelo 3D e, a seguir, localizar
e revisar o mesmo componente em uma representação 2D (como uma planta
baixa ou corte), fornecendo a você a visualização mais apropriada dos dados
para a tarefa que está executando. Ao trabalhar com o formato de arquivo de
visualização FBX, agora é possível obter uma transferência precisa de materiais,
texturas e luzes ao importar ou exportar dados entre o Autodesk Navisworks
e outros aplicativos compatíveis com FBX.

■ Suporte para abrir arquivos DWF e DWFx 2D/3D. Consulte o Leitor de
arquivos DWF.

■ Suporte para exportar arquivos DWFx e DWF 3D. Consulte Exportar
arquivos DWFx/DWF 3D.

■ Suporte a arquivos de múltiplas folhas. Consulte Arquivos de múltiplas
folhas e 2D na página 104.

■ Suporte à associação de objetos 2D/3D. Consulte Localizar todas as folhas
e os modelos que contêm o objeto selecionado na página 222.

■ Suporte a materiais consistentes de FBX para iluminação, materiais e
texturas. Consulte Leitor de arquivos FBX.

Aprimoramentos do Autodesk Navisworks Freedom 2012

■ Agora, a guia Review contém o acesso a um campo de suporte a
ferramentas Measure para dimensionamento e cálculo da área.
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■ Agora, é possível abrir arquivos 2D DWF e DWF de várias folhas, bem como
arquivos NWD.

■ Uma visualização Gantt agora está disponível durante as simulações 4D
do TimeLiner.

Aprimoramentos diversos

■ Suporte aprimorado para o mouse 3D

■ por meio de uma interface estendida. Consulte Mouse 3D 3Dconnexion
na página 173.

■ O Centro de comunicações agora suporta atualizações em tempo real.

■ Novos avatares a serem utilizados em uma variedade de funções, variando
operários de construção e profissionais de segurança até funcionários do
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escritório. Já que os avatares podem variar de acordo com o ponto de vista,
você pode exibir, com facilidade, como os interessados no projeto irão
interagir em uma determinada fase do projeto no contexto relevante.

Como obter Ajuda
Há diversas maneiras de se encontrar informações sobre como usar este
programa e múltiplos recursos estão disponíveis.

Encontrar informações utilizando o
InfoCenter

É possível utilizar o InfoCenter para pesquisar o arquivo de Ajuda do Autodesk
Navisworks para obter informações. Também é possível acessar com facilidade
atualizações e avisos de produtos.

Visão geral do InfoCenter

Você pode utilizar o InfoCenter para procurar ajuda relacionada ao produto,
exibir o painel Subscription Center para os serviços de assinatura, exibir o
painel Centro de comunicações para os avisos e as atualizações de produtos e
exibir o painel Favoritos para acessar os tópicos salvos.
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É possível usar o InfoCenter para:
■ Pesquisar informações na Ajuda principal do produto através de

palavras-chave (ou inserindo uma frase)

■ Acessar os serviços de assinatura através do painel "Subscription Center"

■ Acessar as atualizações e os avisos relativos a produtos através do painel
"Communication Center"

■ Acessar os tópicos salvos através do painel "Favorites"

Para exibir a caixa InfoCenter em um estado retraído, clique na seta à sua
esquerda.

Para reorganizar os tópicos exibidos no painel.

1 Exiba um painel ao efetuar um dos seguintes:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique e arraste um cabeçalho de categoria ou grupo para a posição
desejada.

DICA Para manter os painéis Subscription Center, Centro de comunicações
e Favorites expandidos, clique no ícone de pino no canto inferior direito do
painel.

OBSERVAÇÃO É possível organizar as categorias em um grupo, mas não é possível
movê-las para outros grupos.
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Procurar por informações

É possível inserir palavras-chave ou uma frase na caixa InfoCenter para
pesquisar informações.

Quando você insere palavras-chave ou uma frase na caixa InfoCenter, você
procura o conteúdo do arquivo principal de ajuda do Autodesk Navisworks.

Pesquisas por palavra-chave produzem melhores resultados. Os resultados são
listados na guia Help Search. Clique em um tópico para exibi-lo na Ajuda.

Quando você utiliza o InfoCenter para procurar por informações, poderá
utilizar os seguintes símbolos especiais em sua consulta para efetuar seu ajuste
fino ou expandi-la. Estes símbolos podem ser usados sozinhos ou podem ser
combinados.

DescriçãoSímbolo

Substitui um ou mais caracteres quando usado no começo, meio
ou fim de uma palavra. Por exemplo, “*lish”, “p*lish”, e “pub*” irá

*

encontrar “publish”. Também, “anno*” irá encontrar “annotative”,
“annotation”, “annoupdate”, “annoreset”, e assim por diante.

Substitui um único caractere. Por exemplo, “cop?” irá encontrar
“copy”, mas não “copybase”.

?

Adiciona formas de variações gramaticais em uma palavra-chave,
quando adicionada no início ou fim de uma palavra. Por exemplo,

~

“plotting~” irá encontrar “plots”, “plotted”, e assim por diante.
Também, “~plot” irá encontrar “preplot”, “replot”, e assim por
diante.

Ao executar uma pesquisa pela frase exata, utilize aspas (" ") para incluir
palavras que precisam aparecer perto uma das outras na seqüência de texto
especificada. Por exemplo, insira "especificar unidades de medida" para
encontrar somente os tópicos com todas estas palavras nesta ordem. Também
é possível utilizar os símbolos previamente mencionados em uma seqüência
de texto entre aspas duplas.

6 | Capítulo 1   Bem-vindo ao Autodesk Navisworks Freedom 2012



Para pesquisar o principal arquivo de ajuda para obter informações

1 Na caixa InfoCenter, insira uma palavra-chave ou frase.

2 Clique no botão Pesquisar.

O arquivo de ajuda principal é aberto e os resultados da pesquisa são exibidos
na guia Help Search.

Acessar o Subscription Center

O Subscription Center exibe links para informações sobre os serviços de
assinatura, como aprimoramentos do produto, suporte na web personalizado
dos técnicos da Autodesk e e-Learning de ritmo próprio.

Se você for um membro de assinatura, poderá acessar os serviços de assinatura

ao clicar no botão Communication Center  na caixa InfoCenter, e a
seguir clicando no link Subscription Center. Para aprender mais sobre
membros de assinatura Autodesk, visite
http://www.autodesk.com/subscriptioncenter.

Sobre o Subscription Center

Com o Autodesk Subscription, você obtém as versões recentes do software da
Autodesk, aprimoramentos incrementais do produto, suporte da Web
personalizado por técnicos especializados da Autodesk e aprendizado eletrônico
autodidático. Os serviços de assinatura estão disponíveis somente para membros
com assinatura.

Ao clicar no botão Communication Center  na caixa InfoCenter, os
membros têm acesso às seguintes opções (no Subscription Center):
■ Subscription status. Verifica o status de sua assinatura.

■ Create support request. Fornece uma comunicação direta um-a-um
com técnicos de suporte da Autodesk. Você recebe respostas rápidas e
completas para suas perguntas sobre instalação, configuração e solução de
problemas.

■ View support requests. Acompanha e gerencia suas perguntas e respostas
por meio do sistema de suporte de ponta da Autodesk.

■ Edit Subscription Center profile. Configura e mantém sua conta de
assinatura.
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■ View support requests. Contém lições interativas organizadas em
catálogos de produtos.

■ e-Learning Lessons. (Somente para os membros de assinatura). Cada
lição dura 15-30 minutos e contém exercícios ao vivo, com uma opção
para usar uma simulação ao invés do software aplicativo. É possível usar
uma ferramenta de avaliação on-line que identifique falhas de qualificações,
determine quais lições serão mais úteis e avalie o progresso do aprendizado

Recursos e Privacidade de Assinatura

Os recursos de assinatura fornecem funções interativas de produtos por meio
da Internet. Cada vez que você acessa os recursos de assinatura (como o
e-Learning ou Create Support Request) do Communication Center em um
produto da Autodesk, as informações do produto (como o número de série,
versão, idioma e ID do contrato de assinatura) são enviadas para a Autodesk
para verificar se seu produto está com uma assinatura.

A Autodesk compila estatísticas usando as informações enviadas para os
recursos de assinatura, para monitorar como estão sendo usados e como podem
ser aprimorados. A Autodesk mantém a informação fornecida por ou coletada
de você de acordo com a política de privacidade publicada da Autodesk, que
está disponível em http://www.autodesk.com/privacy-ptb.

Para abrir o Subscription Center

1 Clique no botão Communication Center  na caixa InfoCenter.

2 No painel Communication Center, em Subscription Center, clique
no recurso de assinatura que deseja acessar.

OBSERVAÇÃO  O Subscription Center não está disponível para todos os usuários
do produto. Se o Subscription Resources não estiver disponível em seu produto,
este não tem o direito aos benefícios da assinatura.

Gerenciar arquivos com o Autodesk Vault

Se você for um cliente de assinatura, tem acesso ao Autodesk Vault, uma
ferramenta de gerenciamento de arquivos que fornece um repositório onde
os documentos e arquivos são armazenados e gerenciados.

O Autodesk Vault lhe fornece mais poder para gerenciar arquivos e acompanhar
alterações. Cópias de versão dos arquivos mestre são mantidos, permitindo a
fácil reversão para versões anteriores dos arquivos. Você pode retirar arquivos
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para edição e mais tarde devolvê-los. A cópia mestre nunca é diretamente
editada.

O Autodesk Vault consiste em dois componentes requeridos: o Autodesk Data
Management Server e o Vault Client. Opcionalmente, você também pode
instalar o Vault Office Add-in.

Para obter informações sobre o uso do Vault, consulte a ajuda do sistema Vault.

DICA Os principais componentes do Autodesk Vault podem ser descarregados
do site de Assinatura da Autodesk.

Utilizar o Communication Center

O Communication Center fornece informações atualizadas sobre produtos,
atualizações de software, avisos de suporte de produtos e outros avisos relativos
aos produtos.

Visão geral do Centro de comunicação

É possível clicar no botão Centro de Assinaturas para exibir links de
informações sobre atualizações e avisos de produtos, e incluir links para fontes
RSS.

Sempre que novas informações estão disponíveis, o Communication Center
lhe notifica exibindo uma mensagem em balão abaixo do botão
Communication Center na caixa InfoCenter.

O Communication Center fornece os seguintes tipos de anúncios:
■ Canais da Autodesk: Receba informações de suporte, atualizações de

produto, e outros avisos (incluindo artigos e dicas).

■ Alimentações RSS.Receber informações sobre alimentações RSS as quais
você se subscreve. As fontes RSS geralmente lhe notificam quando um novo
conteúdo é lançado. Você é automaticamente inscrito em diversas fontes
RSS padrão quando instala o programa.

■ Informações sobre suporte a produtos. Obtenha notícias recentes
da equipe de Suporte de Produto da Autodesk, incluindo quando as
correções de manutenção Live Update são liberadas.

■ Avisos de assinatura. Receber avisos de assinatura e notícias do programa
de assinatura, assim como vínculos para e-Learning Lessons, se você for
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um membro de assinatura da Autodesk (disponível em países/regiões onde
a assinatura da Autodesk é oferecida).

■ Articles and Tips. Seja notificado quando novos artigos e dicas estejam
disponíveis nos websites da Autodesk.

■ Live Update Maintenance Patches. Receba notificações automáticas
sempre que novas correções de manutenção forem liberadas pela Autodesk.

■ Tecnologias e conteúdo apresentados. Aprenda mais sobre os
aplicativos e conteúdo de desenvolvedores terceiros.

Você pode personalizar os itens que são exibidos no painel Communication
Center. Para obter mais informações, consulte Especificar as configurações
do InfoCenter na página 17.

Política on-line do Centro de comunicação

O Centro de comunicação é um recurso interativo que precisa estar conectado
à Internet para poder fornecer conteúdo e informações. Cada vez que o Centro
de comunicação está conectado, envia suas informações para a Autodesk para
que o usuário receba as informações corretas. Todas as informações são enviadas
anonimamente para a Autodesk para manter sua privacidade.

O Centro de comunicação envia as seguintes informações para a Autodesk:
■ O nome do produto (no qual se está usando o Centro de comunicação)

■ Número de versão do produto

■ Idioma do produto

■ O país/região (especificado nas configurações no Centro de comunicação)

■ Sua ID única do Programa de Participação do Cliente (CIP) caso esteja
participando do programa CIP.

A Autodesk compila estatísticas usando as informações enviadas do
Communication Center para monitorar como ele está sendo utilizado e
como pode ser aprimorado. A Autodesk mantém a informação fornecida por
você ou coletada de acordo com a política de privacidade publicada da empresa,
que está disponível em http://www.autodesk.com/privacy.

Para abrir o Communication Center

■ Na caixa InfoCenter, clique no botão Communication Center  .

Para receber novas notificações sobre informações

■ Clique no link, no balão da mensagem, para abrir o artigo ou anúncio.
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Salvar e acessar tópicos favoritos

É possível clicar no botão Favoritos para exibir links salvos para tópicos ou
locais da web.

Qualquer link exibido no painel Subscription Center ou no
Communication Center pode ser marcado como um favorito.

Um link marcado como favorito é exibido como um ícone de estrela no painel
Subscription Center ou no painel Communication Center.

Para exibir o painel Favoritos do InfoCenter

■ Na caixa InfoCenter, clique no botão Favoritos.

OBSERVAÇÃO Os links exibidos no painel Favoritos são organizados nos mesmos
grupos ou categorias em que foram adicionados.

Para salvar um vínculo no InfoCenter como um favorito

1 Exiba um painel ao efetuar um dos seguintes:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

2 Clique no ícone de estrela que é exibido próximo ao link que você deseja
salvar como um favorito.

Para remover um link favorito do painel Favoritos do InfoCenter

1 Na caixa InfoCenter, clique no botão Favoritos para exibir o painel
Favoritos.

2 Clique no ícone de estrela que é exibido próximo ao link que você deseja
remover do painel Favoritos.

Utilizar o sistema de Help

Clique no botão Ajuda para exibir os tópicos na Ajuda.
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Você poderá aproveitar muito mais o sistema de Help quando aprender a
utilizá-lo com eficiência. É possível encontrar rapidamente descrições gerais,
procedimentos, detalhes sobre caixas de diálogo e paletas, ou definições de
termos.

O sistema de Help contém informações completas sobre como usar este
programa. Na janela Help, use o painel esquerdo para localizar informações.
As guias acima do painel esquerdo fornecem várias maneiras de localizar os
tópicos que você deseja visualizar. O painel direito exibe os tópicos
selecionados.

Para exibir tópicos na Ajuda

■ Na caixa InfoCenter, clique no botão Ajuda.

Como os tópicos do Help estão organizados

A maioria dos tópicos neste sistema de Help têm três guias acima do painel
direito da janela Help. Essas guias exibem diferentes tipos de informações.

■ Guia Concept. Descreve um recurso ou função. Quando você clica na
guia Concept, a lista Help Contents no painel esquerdo da janela Help
expande e realça o tópico atual. A guia Contents exibe a estrutura do Help
nesse tópico. Você pode com facilidade exibir facilmente os tópicos
próximos clicando neles na lista.

■ Guia Procedure.Fornece instruções passo-a-passo para procedimentos
comuns relativos ao tópico atual. Depois de exibir um procedimento, você
poderá clicar na guia Procedure para exibir novamente a lista atual de
procedimentos.

■ Guia Quick Reference.Lista as informações de referência relativas ao
tópico atual:

Quando se clica uma guia diferente, o tópico permanece o mesmo. Somente
o tipo da informação é exibido—conceitos, procedimentos ou vínculos de
referência rápida—são diferentes.
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Pesquisar no Help

Use a guia Search do Help para localizar tópicos relevantes com base nas
palavras-chave inseridas.

As regras de pesquisa básica são:
■ Digite suas palavras-chave caracteres maiúsculos ou minúsculos; as pesquisas

não fazem distinção entre caracteres maiúsculos e minúsculos.

■ Procure qualquer combinação de letras (a-z) e números (0-9).

■ Não utilize marcas de pontuação como ponto, dois-pontos, ponto-e-vírgula,
vírgula, hífen e aspas simples; elas serão ignoradas durante uma pesquisa.

■ Agrupe os elementos da pesquisa utilizando aspas duplas ou parênteses
para separar cada elemento.

Usar caracteres curinga

Você pode usar os seguintes caracteres curinga em uma palavra-chave:

DescriçãoSímbolo

Substitui um ou mais caracteres quando
usado no começo, meio ou fim de uma

*

palavra. Por exemplo, “*lish”, “p*lish”, e
“pub*” irá encontrar todos “publish”.
Também, “anno*” irá encontrar
“annotative”, “annotation”, “annoupdate”,
“annoreset”, e assim por diante.

Substitui um único caractere. Por exemplo,
“cop?” irá encontrar “copy”, mas não
“copybase”.

?

Expande o tempo do verbo da palavra no
começo ou fim de uma palavra. Por

~

exemplo, “plotting~” irá encontrar “plots”,
“plotted”, e assim por diante. Também,
“~plot” irá encontrar “preplot”, “replot”, e
assim por diante.
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Pesquisar por frases

Ao pesquisar por uma frase, use aspas duplas (" ") entre as palavras que devem
ficar próximas entre si na sequência especificada. Por exemplo, insira
"especificação de unidades de medida" para localizar somente os tópicos com
todas essas palavras nessa ordem. Se as aspas não forem utilizadas no texto, a
ajuda encontrará todos os tópicos que contenham qualquer uma das palavras
listadas, ou seja, todos os tópicos que contenham "especificação", "unidades",
"de" e "medida".

DICA Se não puder encontrar as informações que precisa com uma pesquisa,
tente usar a guia Contents.

Usar operadores Booleanos

Com os operadores AND, OR, NOT e NEAR, é possível definir uma pesquisa
precisamente criando uma relação entre os termos dessa pesquisa. A tabela a
seguir mostra como você pode utilizar cada um desses operadores. Se nenhum
operador for especificado, será utilizado E. Por exemplo, a consulta spacing
border printing é equivalente a spacing AND border AND printing.

ResultadosExemploPesquisar por

Tópicos contendo as palavras
"tree view" e "palette"

"tree view" AND “palette”Os dois termos no
mesmo tópico

Tópicos contendo ou a palavra
"viewpoint" ou a palavra
"animation" ou ambas

viewpoint OR animationUm dos dois termos em
um tópico

Tópicos contendo a palavra
"NWD", mas não a palavra "NWC"

nwd NOT nwcO primeiro termo sem
o segundo

Tópicos contendo a palavra "user"
a oito palavras da palavra "menu"

user NEAR menuOs dois termos no
mesmo tópico e juntos

OBSERVAÇÃO Os caracteres |, & e ! não funcionam como operadores Booleanos.
Deve-se utilizar AND (também +), OR e NOT (também -).
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Localizar informações nos tópicos do Help

As guias no lado esquerdo da janela Help fornecem diferentes métodos para
localizar informações.

Guia Contents

■ Apresenta uma visão geral da documentação disponível em uma lista de
tópicos e subtópicos.

■ Permite que você pesquise selecionando e expandindo tópicos.

■ Fornece uma estrutura para que você sempre possa visualizar o ponto em
que se encontra na Help e saltar rapidamente para outros tópicos.

Guia Index

■ Exibe uma lista em ordem alfabética de palavras-chave relacionadas a todos
os tópicos listados na guia Contents

■ Acessa rapidamente as informações, quando já se conhece o nome da
função, comando ou operação, ou quando já se conhece que ação você
deseja que o programa execute.

Guia Search

■ Oferece uma pesquisa por palavra-chave de todos os tópicos listados na
guia Contents.

■ Aceita os operadores Booleanos AND (+), OR, NOT (-) e NEAR.

■ Aceita os caracteres curinga *, ?, e ~.

■ Permite executar a pesquisa por uma frase quando esta está dentro de aspas
duplas.

■ Exibe uma lista de tópicos classificada contendo a palavra ou palavras
digitadas no campo da palavra-chave.

■ Organiza os resultados alfabeticamente por título ou localização se você
clicar nos cabeçalhos de coluna Title e Location.

Para localizar uma palavra ou frase específica no tópico do Help exibido no
momento

1 Clique no texto do tópico e pressione CTRL+F.

2 Na caixa de texto Find, insira uma palavra-chave ou frase.
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3 Clique em Next. Se a palavra-chave ou frase for localizada, o tópico é
rolado para exibir o resultado.

Imprimindo tópicos do Help

A forma mais rápida para imprimir o tópico atual é a de clicar com o botão
direito do mouse e a seguir clicar em Print.

O botão Print na barra de ferramentas Help fornece três opções de impressão:
■ Imprimir o tópico selecionado (recomendado)

■ Imprimir o título selecionado e todos os subtópicos

OBSERVAÇÃO Quando a segunda opção é selecionada, você pode obter várias
páginas impressas, dependendo do número de subtópicos presentes no tópico
atualmente selecionado.

Para imprimir um tópico da Help

1 Exiba o tópico que você deseja imprimir.

2 Clique com o botão direito do mouse no painel do tópico. Clique em
Print.

3 Na caixa de diálogo Print, clique em Print.

Para imprimir um cabeçalho selecionado e todos os subtópicos

1 Exiba o tópico que deseja imprimir e assegure que a guia Contents esteja
exibida.

2 Na barra de ferramentas Help, clique em Print.

3 Na caixa de diálogo Print Topics, clique em Print the Selected
Heading and All Subtopics.

4 Clique em OK.

Mostrar e ocultar o painel Conteúdo

Você pode controlar o tamanho da janela de Ajuda.

Utilize o botão Hide  na barra de ferramentas Help para diminuir a
janela Help para um tamanho compacto ao ocultar o painel que contém as
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guias Contents, Index e Search. Esse tamanho compacto de janela é mais
adequado para a exibição dos procedimentos enquanto você trabalha.

Utilize o botão Show  para expandir a janela Help para exibir o painel
que contém as guias Contents, Index e Search. Esse tamanho expandido
de janela é mais adequado para a localização e exibição de informações
conceituais e de referência.

Especificar as configurações do InfoCenter

É possível especificar as configurações do Centro de comunicações na caixa
de diálogo InfoCenter Settings.

Na caixa de diálogo InfoCenter Settings, você pode especificar as seguintes
configurações:
■ General. Sua localização atual, freqüência de verificação de conteúdo

on-line e a opção de ativar ou não os efeitos de transição animada para os
painéis do InfoCenter.

■ Communication Center. Defina a idade máxima dos artigos exibidos
no painel Communication Center.

■ Autodesk Channels. Canais a serem exibidos no painel Communication
Center, assim como o número de artigos a serem exibidos para cada canal.

■ Notificação em balão. Notificações para novas informações de produto,
atualizações de software, e avisos de suporte do produto. Também, é possível
personalizar a transparência e a hora de exibição do balão.

■ RSS Feeds. Assinatura de alimentação RSS. É possível adicionar ou remover
fontes RSS. As fontes RSS geralmente lhe notificam quando um novo
conteúdo é lançado.

Para especificar canais a serem exibidos no painel Centro de comunicação

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique no botão InfoCenter Settings  (Configurações do InfoCenter).

3 Na caixa de diálogo InfoCenter Settings, no painel esquerdo, clique em
Autodesk Channels.
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4 No painel direito, selecione ou desmarque os canais que deseja exibir no
painel no Communication Center.

5 Clique em OK.

Para especificar as configurações de notificações em balão do InfoCenter

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique no botão InfoCenter Settings  (Configurações do InfoCenter).

3 Na caixa de diálogo Configurações do InfoCenter, no painel esquerdo,
clique em Notificação em balão.

4 No painel direito, selecione ou desmarque as opções para ativar ou
desativar as notificações em balão.

5 Insira o número de segundos para definir a duração de tempo para
notificações em balão a serem exibidas:

6 Insira o valor de transparência do balão ou defina o valor usando o
deslizador.

7 Clique em OK.

Para adicionar uma fonte RSS no Centro de comunicação

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

2 Clique no botão InfoCenter Settings. 

3 Na caixa de diálogo InfoCenter Settings, no painel esquerdo, clique em
RSS Feeds.

4 No painel direito, faça um dos seguintes:
■ Clique em Adicionar.

■ Clique com o botão direito do mouse em qualquer lugar do painel
direito. Clique em Adicionar.

5 Na caixa de diálogo Adicionar alimentação RSS, insira a localização da
alimentação RSS que deseja adicionar. Clique em Adicionar.

6 Na caixa de diálogo InfoCenter - Confirmação da alimentação RSS, clique
em Fechar.
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7 Clique em "OK".

Para remover uma fonte RSS do Centro de comunicação

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique no botão InfoCenter Settings  .

3 Na caixa de diálogo InfoCenter Settings, no painel esquerdo, clique em
RSS Feeds.

4 No painel direito, faça um dos seguintes:
■ Clique em Remove.

■ Clique com o botão direito do mouse em uma alimentação RSS. Clique
em Remove.

5 Na caixa de diálogo InfoCenter - Remover alimentação RSS, clique em
Sim.

6 Clique em "OK".

Obter mais ajuda

Você pode acessar diversas fontes de ajuda adicionais.

■ Use o Communication Center.Exiba o painel Communication
Center para obter atualizações e avisos relacionados a produtos.

■ Pressione F1.Exibe as informações de referência sensíveis ao contexto.

■ Clique no botão Help em diversas caixas de diálogo. Exibe as
informações de referência para a caixa de diálogo.

■ Visualizar o Readme do produto.Exibe informações mais recentes
sobre este produto.

Outros recursos ajudam a obter informações sobre os produtos da Autodesk e
ajuda à suas perguntas sobre este programa.
■ Site da Autodesk na Web. Acesse http://www.autodesk.br.

■ Local support. Consulte seu revendedor ou o escritório do país/região
da Autodesk.
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Visualizar o Readme do produto

Você pode encontrar as informações mais recentes sobre este software no
Readme.

Convém ler todo o Readme do Autodesk Navisworks para obter informações
sobre componentes de hardware recomendados, instruções de instalação
atualizadas e problemas de software conhecidos. O arquivo Leiame está
disponível no grupo do programa do produto no menu Iniciar do Windows.

Juntar-se ao Programa de Participação do
Cliente

Você está convidado a participar na ajuda de direcionamento do projeto de
software da Autodesk.

Se você participa no Programa de Participação do Cliente (CIP), informações
específicas sobre como você utiliza o Autodesk Navisworks são enviadas para
a Autodesk. Estas informações incluem quais recursos você mais utiliza,
problemas encontrados e outras informações úteis na direção futura do produto.

Consulte os links a seguir para obter mais informações.
■ Aprenda mais sobre o Programa de Participação do Cliente da Autodesk:

http://www.autodesk.com/cip

■ Leia a Desclaração de privacidade da Autodesk:
http://www.autodesk.com/cipprivacy

Quando você passa a fazer parte, será capaz de visualizar relatórios que podem
ajudá-lo a otimizar seu uso do Autodesk Navisworks.

Para ativar ou desativar o CIP

1 Na barra de ferramentas InfoCenter, à direita do botão Ajuda, clique na
seta suspensa.

2 Clique em Programa de Participação do Cliente.

3 Na caixa de diálogo Programa de Participação do Cliente, escolha se
deseja começar ou parar de participar.
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4 Clique em "OK".
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Instalação

Guia de Início Rápido da Instalação
Independente

Esta seção oferece instruções passo a passo sobre como preparar e, a seguir,
instalar o Autodesk Navisworks.

A instalação independente é recomendada para usuários individuais ou grupos
pequenos. O ponto principal é que você repetirá o processo de instalação em
cada computador. Para uma licença independente, este é o único tipo de
instalação válida, mas também pode ser usado com uma licença de rede ou
independente com múltiplas instalações.

Preparar para a instalação

Para preparar para a instalação, você deveria rever os requisitos de sistema,
entender os requisitos de permissão administrativa, e fechar todos os aplicativos
em execução.

Ao concluir estas tarefas, você estará pronto para iniciar a instalação do Autodesk
Navisworks Freedom 2012.

OBSERVAÇÃO Também é recomendado que você instale o Microsoft. Net
Framework 4.0 antes de instalar o produto. Consulte Instalar o Microsoft .NET
Framework 4.0 na página 25.

2
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Requisitos do sistema para a instalação
independente

A primeira tarefa a ser completada é a de assegurar que seu computador atenda
os requisitos mínimos de sistema. Se o sistema não corresponder a estes
requisitos, poderão ocorrer problemas, tanto no Autodesk Navisworks como
no nível do sistema operacional.

A detecção se o sistema operacional Windows é da versão de 32 bits ou de 64
bits é automaticamente feita durante a instalação.

Consulte na tabela a seguir os requisitos de hardware e software.

Requisitos de hardware e software para a máquina cliente

RequisitoHardware/Software

Microsoft® Windows 7 (32 bits ou 64 bits) Home
Basic, Home Premium, Professional, Enterprise ou
Ultimate (recomendado)

Sistema operacional

Microsoft® Windows Vista® SP2 (32 bits ou 64 bits)
Home Premium, Business, Enterprise ou Ultimate

Microsoft® Windows XP SP3 (32 bits) Home ou
Professional

Microsoft® Windows XP SP2 (64 bits) Professional

Microsoft® Internet Explorer® 7.0 ou posteriorNavegador da Web

AMD Athlon™, 3.0 GHz ou mais rápido (no

mínimo); Intel® Pentium® 4, 3.0 GHz ou mais
rápido (recomendado) - com tecnologia SSE2

Processador

512 MB (mínimo); 2 GB ou mais (recomendado)Memória (RAM)

1024 x 768 com True Color (no mínimo)Tela VGA
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Requisitos de hardware e software para a máquina cliente

Placa adaptadora de vídeo de 1280 x 1024 32 bits
com True Color (recomendado)

Placa gráfica compatível com Direct3D 9® e

OpenGL® com Shader Model 2 (no mínimo)

Placa gráfica

11 GB de espaço livre em disco para a instalaçãoDisco rígido

Dispositivo apontador compatível com o mouse da

Microsoft®
Dispositivo apontador

Qualquer velocidade (somente para a instalação)DVD-ROM

Impressora ou plotadoraHardware opcional

Modem ou acesso a uma conexão de Internet

Placas de interface de rede

Instalar o Microsoft .NET Framework 4.0

O Autodesk Navisworks Freedom 2012 requer que o Microsoft .Net 4.0 seja
instalado antes da instalação do produto.

A maioria das atualizações do Windows deve incluir o Microsoft .NET
Framework 4. No entanto, para versões antigas do Windows, é possível fazer
o download e instalar os Microsoft .NET Framework 4 redistribuíveis em
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-
4fc0-919f-b21f31ab88b7 ou instale o Microsoft .Net Framework 4 no seguinte
diretório da mídia de instalação: \3rdParty\NET\4\wcu\dotNetFramework\.

O assistente de instalação  instalará o Microsoft .Net Framework 4 se ele detectar
as atualizações necessárias não foram instaladas.
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OBSERVAÇÃO  Se o assistente de instalação solicitar que você instale o Microsoft
.NET 4.0 Framework, o instalador do .NET 4.0 Framework poderá solicitar que
você instale primeiro o Windows Imaging Component (WIC). Isto pode ocorrer
se você não possui as últimas atualizações do Microsoft Windows ou Service Packs.
É mais provável precisar do WIC se você estiver executando o Windows XP SP2
sem determinadas atualizações do Windows instaladas. Se necessário, o Microsoft
WIC installers estão disponíveis nas seguintes localizações:
■ Instalador de 32 bits:

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=8e011506-
6307-445b-b950-215def45ddd8&displaylang=en

■ Instalador de 64 bits:
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=f64654ac-6e26-
41d9-a90a-0e7783b864ee

Compreender os requisitos de permissão
administrativa

Para instalar o Autodesk Navisworks, você precisa ter permissões de
administrador.

Não é necessário ter permissões de administrador de domínio. Consulte o
administrador do sistema para obter informações sobre permissões de
administrador.

Para executar o Autodesk Navisworks, não é preciso ter permissões
administrativas. Você pode executar o programa como um usuário limitado.

Evitar a perda de dados durante a instalação

O processo de instalação do Autodesk Navisworks pode parar se alguns
aplicativos (como o Microsoft® Outlook® ou programas de verificação antivírus)
estiverem sendo executados.

Feche todos os aplicativos em execução para evitar uma possível perda de
dados.
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Escolher um idioma

É possível selecionar um outro idioma para instruções de instalação e um
idioma para as instalações individuais do produto no mesmo processo de
instalação.

Ao iniciar o processo de instalação, o instalador automaticamente determina
o idioma de seu sistema operacional. Se um idioma suportado for detectado,
suas páginas de instalação serão exibidas naquele idioma. Se você deseja alterar
aquele idioma, basta escolher outro idioma na lista Idioma do Instalador na
primeira página do assistente de Instalação.

OBSERVAÇÃO Alguns produtos podem não ter o suporte para múltiplos idiomas
no momento da liberação do produto. Suporte de idiomas adicionais pode estar
disponível em outro momento. Consulte http://support.autodesk.com para verificar
a disponibilidade de pacotes de idiomas adicionais.

Utilizar pacotes de idiomas

O pacote de idioma apoia o uso de diferentes idiomas em cada produto
Autodesk Navisworks, incluindo exportadores. Os nomes dos pacotes começam
com NAVFREE_, NAVSIM_, NAVMAN_ e exporters_ respectivamente.

OBSERVAÇÃO É preciso instalar ao menos uma pacote de idioma para cada
produto.

É possível instalar pacotes adicionais de idiomas nos produtos do Autodesk
Navisworks posteriormente. É possível instalar manualmente os pacotes de
idiomas necessários ao clicar com o botão direito do mouse no arquivo MSI
do pacote de idioma.

Os pacotes de idioma estão localizados no DVD de instalação e em mídia não
empacotada baixada da pasta x86 para produtos de 32 bits e da pasta x64
para produtos de 64 bits.

■ Os pacotes de idiomas para produtos específicos estão incluídos nas
subpastas NAVFREE , NAVSIM, NAVMAN e NWEXPORT das pastas
x86 e x64.

■ Pacotes de idioma para idiomas específicos estão incluídos nas subpastas
en-US (Inglês), de-DE (Alemão), es-ES (Espanhol), fr-FR (Francês), it-IT
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(Italiano), ja-JP (Japonês), ko-KR (Coreano), pt-BR (Português do Brasil),
ru-RU (Russo) e zh-CN (Chinês PRC) das pastas dos produtos.

Portanto, por exemplo, para instalar o pacote de idioma Francês de 32 bits
para o Autodesk Navisworks Freedom, clique duas vezes em
x86/NAVFREE/fr-FR/NAVFREE_LP.msi.

Configuração

Durante o processo de instalação, você escolhe uma instalação típica (instalar
os produtos com as configurações padrão) ou uma instalação personalizada.
Na página Install  ➤ Configure Installation, para qualquer produto que
você selecionou para instalar, você verá um controle triangular para acessar
um painel de configuração.

Clique em qualquer lugar na caixa do produto para abrir o painel de
configuração:
■ Tipo de instalação Se você selecionar a instalação Typical (configurações

padrão), o produto instalará as operações de aplicativos mais comuns. A
instalação Custominstala somente os recursos do aplicativo selecionados
na listaSelect Features To Install. As operações disponíveis dependerão
do produto que está sendo instalado:

Contém o controle ActiveX redistribuível
do Autodesk Navisworks.

Redistributable ActiveX Control

Contém o conjunto completo dos arquivos
do Autodesk Navisworks.

Programa

■ Create the Desktop Shortcut (Criar o atalho na área de trabalho).
Selecione a caixa de seleção para criar o atalho na área de trabalho para o
Autodesk Navisworks.

■ Pastas de projeto e terreno. Utilize os botões Browse para selecionar
os diretórios que irão conter as configurações do Autodesk Navisworks que
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podem ser compartilhadas em todo um local de projeto ou por um grupo
de projetos específico (consulte Selecionar as pastas Projeto e Site).

■ Service Packs. Se um service pack estiver disponível, é possível incluí-lo
na instalação.

Uma vez configuradas as configurações conforme necessário, clique no nome
do produto para fechar o painel de configuração.

Instalar múltiplos produtos ou produtos
combinados

Alguns pacotes da Autodesk são compostos de múltiplos produtos ou são parte
de produtos de múltiplos pacotes.

O assistente de Instalação para pacotes que são compostos por múltiplos
produtos, lhe fornece a opção de escolher quais produtos deseja instalar.

No assistente de Instalação para pacotes contendo múltiplos produtos, é
possível escolher quais produtos e idiomas que você deseja instalar. Durante
o processo de instalação você é informado se já existe um cópia do software
instalado. Também é avisado se seu sistema não atende os requisitos mínimos
para o produto. Cada nome de produto é exibido no seu próprio painel com
abas; é possível configurá-los individualmente.

Se você comprou um pacote que é um pacote com múltiplos produtos, como
um pacote educacional ou institucional, poderá ter um pacote que inclui
diversos produtos da Autodesk. Para estes pacotes combinados, um disco
Instalador contém informações para todos os produtos no pacote. O disco do
Instalador ajuda na instalação dos produtos.

Instalar e executar o Autodesk Navisworks
Freedom 2012

É preciso ter permissões administrativas para instalar o Autodesk Navisworks.

Esta seção fornece instruções para instalar e ativar o Autodesk Navisworks para
um usuário individual em um computador independente.

OBSERVAÇÃO A Autodesk não recomenda nem suporta a distribuição de um
produto Autodesk usando um software de imagens.
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Instalar o Autodesk Navisworks

O assistente de instalação do Autodesk Navisworks contém todos os materiais
relativos à instalação em um só lugar.

No assistente de Instalação você pode acessar a documentação do usuário,
alterar o idioma do instalador, selecione um produto específico para o idioma,
instalar ferramentas suplementares, visualizar soluções de suporte e aprender
sobre como instalar seu produto em uma rede.
■ Verifique a documentação de instalação antes de instalar.

Recomenda-se dedicar algum tempo para se familiarizar com o processo
completo de instalação antes de instalar o Autodesk Navisworks. A
documentação é acessada a partir de links no canto inferior esquerdo do
instalador.

■ Instalar o Autodesk Navisworks Freedom 2012. No assistente de
Instalação, clique em Instalar. Siga as instruções exibidas na tela para
completar a instalação.

Instalar o Autodesk Navisworks utilizando valores
padrão

Esta é a maneira mais rápida de instalar o Autodesk Navisworks em seu sistema.

Somente valores padrão são utilizados, o que significa que uma instalação
típica está sendo instalada em C:\Program Files\Autodesk\Navisworks Freedom

2012.

Para instalar o Autodesk Navisworks usando valores padrão em um
computador independente

1 Feche todos os aplicativos em execução no seu computador e inicie o
assistente de Instalação.

2 No assistente de instalação, se necessário, selecione um idioma
alternativo para o assistente de instalação no menu suspenso
Installation Instructions e, a seguir, clique em Install.
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3 Revise o contrato de licença de software da Autodesk para o seu país ou
região. É necessário aceitar os termos do contrato para prosseguir com a
instalação. Escolha seu país ou região, clique em Aceito e a seguir clique
em Avançar.

OBSERVAÇÃO Se não concordar com os termos da licença e desejar terminar
a instalação, clique em Cancelar.

4 Na página Configure Installation, selecione os produtos a serem
instalados e, se necessário, adicione pacotes de idiomas do menu suspenso
Product Language (consulte Choose a Language na página 27).

5 Se necessário, utilize o botão Installation PathBrowse para selecionar
a unidade e a localização onde o produto será instalado.

6 Clique em Install. O assistente instala os produtos selecionados
utilizando uma instalação Typical, que instala os recursos mais comuns
do aplicativo. Para verificar quais recursos estão incluídos em uma
instalação Typical, consulte Recursos típicos instalados na página 37.

OBSERVAÇÃO Por padrão, o assistente de Instalação ativa
automaticamente os plugins do exportador para todos os produtos de
terceiros já instalados no computador.

7 Clique em Concluir.

Instalar o Autodesk Navisworks usando valores
configurados

Com este método de instalação, é possível selecionar exatamente o que será
instalado.

É possível alterar o tipo de licença, o tipo de instalação, o caminho da
instalação e especificar a localização das pastas Projeto e Local.

Para instalar o Autodesk Navisworks usando valores configurados em um
computador autônomo

1 Feche todos os aplicativos em execução no seu computador e inicie o
assistente de Instalação.

2 No assistente de instalação, se necessário, selecione um idioma
alternativo para o assistente de instalação no menu suspenso
Installation Instructions e, a seguir, clique em Install.
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3 Revise o contrato de licença de software da Autodesk para o seu país ou
região. É necessário aceitar os termos do contrato para prosseguir com a
instalação. Escolha seu país ou região, clique em Aceito e a seguir clique
em Avançar.

OBSERVAÇÃO Se não concordar com os termos da licença e desejar terminar
a instalação, clique em Cancelar.

4 Na página Configure Installation, selecione os produtos a serem
instalados e, se necessário, adicione pacotes de idiomas do menu suspenso
Product Language (consulte Choose a Language na página 27).

5 Clique no nome do produto para abrir o painel de configuração, onde
é possível revisar e alterar as configurações. Consulte Configuração na
página 28. Uma vez configuradas as configurações conforme necessário,
clique no nome do produto para fechar o painel de configuração.

6 Se necessário, utilize o botão Installation PathBrowse para selecionar
a unidade e a localização onde o produto será instalado.

7 Clique em Install. O assistente instala os produtos selecionados
utilizando as configurações de instalação Custom (Personalizadas).

8 Clique em Concluir.

Inicie o Autodesk Navisworks

Considerando que todos os passos anteriores destacados na seção do Início
rápido foram seguidos corretamente, é possível iniciar Autodesk Navisworks
e começar a usufruir das operações novas e atualizadas.

Você pode iniciar o Autodesk Navisworks das seguintes maneiras:
■ Ícone de atalho na área de trabalho.Quando você instala o Autodesk

Navisworks, um ícone de atalho é colocado em sua área de trabalho. Clique
duas vezes no ícone do Autodesk Navisworks para iniciar o programa.

■ BotãoIniciar. Clique em Start ➤ All
Programs ➤ Autodesk ➤ Navisworks Freedom 2012 ➤ Autodesk
Navisworks Freedom 2012.

■ Local onde o Autodesk Navisworks é instalado. Se você tem
permissões administrativas, poderá executar o Autodesk Navisworks do
local em que foi instalado. Se o usuário for um usuário restrito, é possível
executar Autodesk Navisworks a partir do botão Iniciar ou a partir do
ícone de atalho na área de trabalho. Se desejar criar um atalho
personalizado, verifique se o diretório Iniciar em do atalho aponta para
um diretório no qual você tem permissões de gravação.
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OBSERVAÇÃO Quando o produto é iniciado, por padrão, ele utiliza o idioma que
melhor coincida com as configurações em seu computador. Também é possível
iniciar o Autodesk Navisworks em outro dos idiomas suportados.

Como iniciar o Autodesk Navisworks em outro
idioma

Para executar o Autodesk Navisworks em outro dos idiomas instalados, é
preciso adicionar um dos argumentos do seletor de idiomas no atalho da área
de trabalho.

Para executar o Autodesk Navisworks em outro idioma

1 Clique com o botão direito do mouse no atalho do Autodesk Navisworks
na área de trabalho e clique em Properties no menu de atalho para
abrir a caixa de diálogo Autodesk NavisworksProperties.

2 Na guia Atalho , insira um espaço no campo Destino após ..\roamer.exe,
e a seguir insira um dos seguintes argumentos:
■ -lang en-US para a localização em Inglês

■ -lang de-DE para a localização em Alemão

■ -lang es-ES para a localização em Espanhol

■ -lang fr-FR para a localização em Francês

■ -lang it-IT para a localização em Italiano

■ -lang ja-JP para a localização em Japonês

■ -lang ko-KR para a localização em Coreano

■ -lang pt-BR para a localização em Português do Brasil

■ -lang ru-RU para a localização em Russo

■ -lang zh-CN para a localização em Chinês (PRC)

3 Clique em OK para salvar as alterações.

Reparar Autodesk Navisworks Freedom 2012

Se você excluir ou alterar por engano arquivos necessários para o Autodesk
Navisworks Freedom 2012, o Autodesk Navisworks pode não funcionar
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corretamente e você receberá mensagens de erro quando tentar executar um
comando ou localizar um arquivo. É possível tentar resolver este problema
reparando Autodesk Navisworks Freedom 2012.

A reparação utiliza operações que são parte do tipo de instalação selecionado
ao iniciar o programa.

Para reparar o Autodesk Navisworks Freedom 2012

1 Efetue um dos seguintes procedimentos:
■ (Windows XP) Clique no menu Iniciar ➤ Configurações ➤ Painel

de controle ➤ Adicionar ou remover programas.

■ (Windows Vista e Windows 7) Clique em Iniciar ➤ Painel de
controle ➤ Programas e recursos.

2 Na lista de programas, clique em Autodesk Navisworks Freedom 2012 e
então em Alterar/Remover (Windows XP) ou Desinstalar/Alterar
(Windows Vista e Windows 7).

O assistente de instalação do Autodesk Navisworks Freedom 2012 reabre
em modo de manutenção.

3 Clique em Reparar ou Reinstalar.

4 Na página Repair or Reinstall, clique em RepairAutodesk Navisworks
Freedom 2012. Esta opção substitui todas as entradas do registro que o
Autodesk Navisworks instalou inicialmente e restaura o Autodesk
Navisworks Freedom 2012 para seu estado padrão. Clique em Repair.

OBSERVAÇÃO ReinstallAutodesk Navisworks Freedom 2012 repara o
registro e reinstala todos os arquivos da instalação original. Utilize essa opção
se a opção RepairAutodesk Navisworks Freedom 2012 não solucionar o
problema.

5 Na página Reparo completado, clique em Concluir.

Desinstalar o Autodesk Navisworks Freedom 2012

Quando você desinstala o Autodesk Navisworks Freedom 2012, todos os
componentes são removidos. Isso significa que mesmo se você adicionou ou
removeu componentes anteriormente, ou se você reinstalou ou reparou o
Autodesk Navisworks Freedom 2012, a desinstalação remove todos os arquivos
de instalação do Autodesk Navisworks de seu sistema.
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IMPORTANTE  Não utilize programas de limpeza de registro nem tente modificar
as entradas de registro sozinho para desinstalar o Autodesk Navisworks Freedom
2012. Não seguir o procedimento oficial de desinstalação resultará na
impossibilidade de instalar o software.

Para desinstalar o Autodesk Navisworks Freedom 2012

1 Efetue um dos seguintes procedimentos:
■ (Windows XP) Clique no menu Iniciar ➤ Configurações ➤ Painel

de controle ➤ Adicionar ou remover programas.

■ (Windows Vista e Windows 7) Clique em Iniciar ➤ Painel de
controle ➤ Programas e recursos.

2 Na lista de programas, clique em Autodesk Navisworks Freedom 2012 e
então em Alterar/Remover (Windows XP) ou Desinstalar/Alterar
(Windows Vista e Windows 7).

O assistente de instalação do Autodesk Navisworks Freedom 2012 reabre
em modo de manutenção.

3 Clique em Desinstalar.

4 Quando informado que o produto foi desinstalado com êxito, clique em
Concluir.

OBSERVAÇÃO Mesmo se o Autodesk Navisworks Freedom 2012 for
removido do sistema, a licença do software permanecerá. Se você reinstalar
o Autodesk Navisworks Freedom 2012 futuramente, não será necessário
registrar e ativar o programa novamente.

Solução de problemas de instalação
Esta seção fornece soluções para questões de instalação e respostas para
perguntas frequentes que podem surgir ao instalar seus produtos.

Informações adicionais para resolução de problemas e suporte estão disponíveis
em http://support.autodesk.com.

Questões gerais sobre a instalação

Esta seção fornece soluções para questões de instalação e respostas para
perguntas frequentes que podem surgir ao instalar seus produtos.
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Como posso verificar se meu driver de placa
gráfica precisa ser atualizado?

É recomendável assegurar que o seu computador possui a placa gráfica mais
atual para obter o melhor desempenho de exibição possível.

Para identificar o driver de sua placa gráfica

1 Inicie o Autodesk Navisworks Freedom 2012.

2 Na caixa InfoCenter, clique na seta para baixo ao lado do botão
Help ➤ System Info.

A caixa de diálogo de informações do Autodesk Navisworks Freedom
2012 é aberta.

3 Reveja as informações sobre seu sistema, incluindo o driver da placa
gráfica e a versão do driver, e clique em OK para fechar a caixa de diálogo.

Para procurar na Web por um driver de placa gráfica atualizado

■ Use o Windows Update. Se um driver de placa gráfica mais recente estiver
disponível, selecione-o para que o Windows possa efetuar o download e
instalar.

■ Pesquise no website do fabricante da placa gráfica pelo tipo de placa gráfica
instalada. Se um driver de placa gráfica mais recente estiver disponível,
instale-o seguindo as instruções fornecidas pelo fabricante.

Para instalar um driver de placa gráfica atualizado

1 Consulte a Web para saber se um driver atualizado está disponível.
■ Use o Windows Update.

■ Pesquise no website do fabricante da placa gráfica pelo tipo de placa
gráfica instalada.

2 Se um driver de placa gráfica mais recente estiver disponível, siga as
instruções do site para efetuar o download e instalá-lo.
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Como trocar minha licença de independente para
rede ou de rede para independente?

Se você apenas inseriu o tipo de licença errado por engano e ainda estiver
executando o instalador, utilize o botão Back para retornar para a página
Product Information e alterar o License Type.

Se você deseja alterar o tipo de licença para um produto instalado, entre em
contato com o revendedor ou fornecedor de licenças oficial da Autodesk para
obter a nova licença e o número de série. Depois, desinstale o produto e execute
uma nova instalação para alterar o tipo de licença e inserir o novo número de
série.

Ao executar uma instalação Típica, o que é
instalado?

Uma instalação Típica inclui os seguintes recursos:

Contém o controle ActiveX redistribuível
do Autodesk Navisworks.

Redistributable ActiveX Control

Contém o conjunto completo dos arquivos
do Autodesk Navisworks.

Programa

Porque preciso especificar a pasta do projeto e a
pasta de terreno?

Você pode compartilhar configurações globais, espaços de trabalho, ferramentas
de dados, avatares, regras e testes personalizados do Clash Detective, arquivos
do Presenter, scripts de animação de objeto etc. do Autodesk Navisworks com
outros usuários.

Estas configurações podem ser compartilhadas através de todo um local de
projeto, ou através de um grupo de projetos específico, dependendo no nível
de granularidade.

O Autodesk Navisworks examina o perfil do usuário atual e os perfis de todos
os usuários na máquina local e, a seguir, verifica as configurações no Project
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Directory e no Site Directory. Os arquivos no Project Directory tem
prioridade.

Como compartilho as configurações do Autodesk
Navisworks com base no projeto e terreno?

Compartilhar configurações do Autodesk Navisworks requer exportar as
configurações desejadas como um arquivo XML para a pasta global_options
apropriada dos diretórios Site ou Project. O nome do arquivo XML não é
significante. No entanto, ele precisa ser armazenado na pasta global_options.

DICA Quando você configura opções globais, poderá bloquear algumas das opções
para prevenir que os usuários ou editem em outro momento em máquinas locais.
Para criar um arquivo de opções globais bloqueadas, execute o Options Editor
independente a partir da linha de comando ao digitar
“drive:pathname\OptionsEditor.exe” -l. O Options Editor é aberto com o
recurso de bloqueio.

Para compartilhar configurações com base um terreno e projeto

1 Crie diretórios Terreno e Projeto e subpastas apropriados em uma
localização central para ser acessa por outros usuários do Navisworks.

2 No Autodesk Navisworks, clique no botão do aplicativo  ➤ Options
Editor.

3 Clique em Export.
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4 Na caixa de diálogo Select Options to Export, verifique todas as
opções que deseja exportar e clique em OK.

5 Na caixa de diálogo Save As, nomeie o arquivo XML como desejado e
salve-o na pasta global_options no diretório Site ou Project apropriado.

Consulte também:

Opções de localização na página 94

Opções do Autodesk Navisworks na página 89

NO LABEL

Execute o instalador novamente a partir da mídia original e clique em Install
Tools & Utilities (Instalar ferramentas e utilitários) na primeira tela. O
instalador o guiará pelo processo de seleção, configuração e instalação de
ferramentas e utilitários.

Quando devo reinstalar o produto em vez de
repará-lo?

Reinstale o produto se, por acidente, você excluir ou alterar arquivos que são
requeridos pelo programa.

Arquivos faltando ou alterados de forma adversa afetam o desempenho do
produto e causam mensagens de erro quando se tenta executar um comando
ou encontrar um arquivo.

Se o reparo de uma instalação falhar, reinstalar é a próxima melhor opção.

Quando eu desinstalo meu software, quais arquivos
são deixados no meu sistema?

Se o produto for desinstalado, alguns arquivos permanecem no seu
computador, como arquivos criados ou editados (por exemplo, desenhos ou
menus personalizados).

Seu arquivo de licença também permanece no computador quando você
desinstala o produto. Se você reinstalar no mesmo computador, as informações
de licença permanecem válidas e não é preciso reativar o produto.
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Questões de desinstalação e de manutenção

Esta seção descreve as questões comuns e suas soluções em relação a adição e
remoção de recursos, reinstalação ou reparação da instalação, e desinstalação
de produtos.

IMPORTANTE  Não utilize programas de limpeza de registro nem tente modificar
as entradas de registro sozinho para desinstalar o Autodesk Navisworks Freedom
2012. Não seguir o procedimento oficial de desinstalação resultará na
impossibilidade de instalar o software.

Quando devo reinstalar o produto ao invés de
reparar?

Você deve reinstalar seu produto se por acidente exclui ou altera arquivos que
são requeridos pelo programa. Arquivos faltando ou alterados de forma adversa
afetam o desempenho do produto e causam mensagens de erro quando se
tenta executar um comando ou encontrar um arquivo.

Se o reparo de uma instalação falhar, reinstalar é a próxima melhor opção.

Os dados da instalação estão armazenados localmente em sua unidade e tais
dados são reutilizados ao reinstalar. Se qualquer arquivo não puder ser
localizado ao reinstalar o produto, você será solicitado a carregar a mídia
original. Se o produto for instalado a partir de uma implantação de rede, é
necessário acessar a implementação original, inalterada por mais tarde as
alterações, como a adição de uma atualização.

Quando eu desinstalo meu software, quais arquivos
são deixados no meu sistema?

Se o produto for desinstalado, alguns arquivos permanecem no seu sistema,
como arquivos criados ou editados.

Seu arquivo de licença permanece na estação de trabalho quando você
desinstala o seu produto. Se você reinstala na mesma estação de trabalho, as
informações da licença permanecem válidas e não é preciso reativar o produto.
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Início rápido

Iniciar e sair do Autodesk Navisworks
Após ter instalado na página 23Autodesk Navisworks Freedom 2012, você poderá
iniciá-lo a partir da área de trabalho do Windows ou da linha de comando.

Para iniciar o Autodesk Navisworks, siga uma das seguintes opções a partir
da área de trabalho do Windows:
■ Clique duas vezes no ícone do Autodesk Navisworks ou

■ Clique em Start ➤ All Programs ➤ Autodesk ➤ Navisworks Freedom
2012 ➤ Freedom 2012.

O Autodesk Navisworks é iniciado no idioma que melhor se encaixar nas
configurações em seu computador. Você também pode iniciar o Autodesk
Navisworks em qualquer outro dos idiomas instalados na página 33.

Para sair do Autodesk Navisworks, clique no botão do aplicativo  .
Na parte inferior do menu do aplicativo, clique em Exit Autodesk Navisworks.

A interface do usuário
A interface do Autodesk Navisworks contém um número de elementos
tradicionais do Windows, como o menu de aplicativos, barra de ferramentas
Quick Access, faixa de opções, janelas encaixáveis, caixas de diálogo e menus
de atalho, nos quais você completa tarefas.

3
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Partes da interface do Autodesk Navisworks

Esta seção descreve brevemente os componentes principais da interface padrão
do Autodesk Navisworks.

A interface do Autodesk Navisworks é intuitiva e fácil de aprender e usar. Você
pode ajustar a interface do aplicativo para coincidir com sua forma de trabalho.
Por exemplo, é possível ocultar janelas encaixáveis raramente usadas, para
que não tumultuem a interface. É possível adicionar e remover botões da faixa
de opções e da barra de ferramentas Acesso rápido.

Você pode aplicar um tema diferente à interface padrão. Também é possível
voltar para a interface clássica do Autodesk Navisworks com menu e barras de
ferramentas do estilo antigo.

5. Scene View1. Botão e menu do aplicativo

6. Barra de navegação2. Barra de ferramentas Quick Access
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7. Janelas encaixáveis3. InfoCenter

8. Barra de status4. Faixa de opções

Consulte também:

Visão geral do InfoCenter na página 4

Para alterar o tema da interface do usuário padrão

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção User
Interface.

3 Na página User Interface, selecione o tipo de tema requerido a partir
da lista suspensa Theme.

4 Clique em OK.

Botão e menu do aplicativo

O menu do aplicativo permite que você acesso ferramentas comuns.

Ele fornece acesso a diversas ações de arquivo comuns, e também permite que
você gerencie seus arquivos usando ferramentas mais avançadas, como Import,
Export e Publish. Algumas escolhas do menu do aplicativo possuem menus
adicionais que mostram comandos relacionados.

Para abrir o menu do aplicativo, clique no botão do aplicativo  . Clicar
novamente fecha o menu do aplicativo.
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DescriçãoOpção

Fecha o arquivo no momento aberto e cria
um novo arquivo. (Novo)

Abre arquivos. (Abrir)

Imprime a cena.
 (Imprimir)

Mostra uma visualização de como o
documento será impresso. (Visualização de impressão)

Especifica as configurações de impressão.
 (Configurações de impressão)

Abre o Options Editor.Opções

Sai do programa.Sair do Navisworks
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Lista de documentos recentes

É possível visualizar, classificar e acessar arquivos suportados que foram abertos
recentemente.

Os arquivos mais recentes são exibidos na lista Recent Documents. A lista
é ordenada com o arquivo usado mais recentemente no topo.

Por padrão, são exibidos até quatro arquivos. Caso deseje modificar o tamanho
da lista, utilize o Options Editor.

É possível fixar os arquivos ao usar o botão de pino à direita. Fixar lhe permite
manter um arquivo na lista até que desative o botão de pino.

Classificar e agrupar arquivos

Utilize a lista suspensa no topo da lista Recent Documents para classificar
ou agrupar arquivos por:

■ By Ordered List

■ By Access Date

■ By Size

■ By Type

Visualizar documentos

Ao mover o mouse sobre o arquivo na lista Recent Documents, é exibida a
seguinte informação:

■ Caminho onde o arquivo está armazenado

■ Data em que o arquivo foi modificado por último

■ Nome da pessoa que está trabalhando com o arquivo atualmente

Para alterar o número de documentos recentes listados

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó General, e clique na opção
Environment.

3 Na página Environment, insira o número de documentos recentes a
serem listados na caixa Maximum Recently Used Files.
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4 Clique em OK.

Para manter um documento na lista Recent Documents

■ Clique no botão de pino à direita do documento.

Para visualizar a lista Recent Documents por data de acesso

■ No canto superior esquerdo da lista Recent Documents, na lista suspensa
By Ordered List, selecione By Access Date.

Para visualizar a lista Recent Documents por tamanho

■ No canto superior esquerdo da lista Recent Documents, na lista suspensa
By Ordered List, selecione By Size.

Para visualizar a lista Recent Documents por tipo

■ No canto superior esquerdo da lista Recent Documents, na lista suspensa
By Ordered List, selecione By Type.

Barra de ferramentas Acesso rápido

No topo da janela do aplicativo, a barra de ferramentas Acesso rápido exibe
os comandos usados frequentemente.
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É possível adicionar um número ilimitado de botões à barra de ferramentas
Acesso rápido. Os botões são adicionados à esquerda dos comandos padrão.
Você pode adicionar separadores entre os botões. Os comandos que se estendem
além do comprimento máximo da barra de ferramentas são exibidos em um

botão desdobrável  .

OBSERVAÇÃO Apenas comandos da faixa de opções podem ser adicionados à
barra de ferramentas Acesso rápido.

É possível mover a barra de ferramentas Acesso rápido acima ou abaixo da
faixa de opções.

Para adicionar um botão da faixa de opções à barra de ferramentas Acesso
rápido

1 Exiba a guia e painel que contêm o botão que você deseja adicionar à
barra de ferramentas Acesso rápido.

2 Clique com o botão direito na faixa de opções, e clique em Add to
Quick Access Toolbar.

Para remover um botão da faixa de opções da barra de ferramentas Acesso
rápido

1 Clique com o botão direito no botão na barra de ferramentas Acesso
rápido

2 Clique em Remove from Quick Access toolbar.

Para exibir a barra de ferramentas Acesso rápido abaixo da faixa de opções

■ Clique no botão suspenso Customize Quick Access Toolbar, e clique
em Show Below the Ribbon.
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Menu de atalho: Clique com o botão direito em qualquer botão na barra
de ferramentas Acesso rápido. Clique em Show Quick Access Toolbar
below the Ribbon.

Para exibir a barra de ferramentas Acesso rápido acima da faixa de opções

■ Clique no botão suspenso Customize Quick Access Toolbar, e clique
em Show Above the Ribbon.

Menu de atalho: Clique com o botão direito em qualquer botão na barra
de ferramentas Acesso rápido. Clique em Show Quick Access Toolbar
above the Ribbon.

Por padrão, ela contém as seguintes ferramentas:

DescriçãoOpção

Fecha o arquivo no momento aberto e cria
um novo arquivo.

 (Novo)

Abre arquivos. (Abrir)

Imprime o ponto de visão atual. (Imprimir)

Cancela a ação mais recente (Desfazer)

Refaz a ação mais recente (Refazer)

Seleciona itens com um clique do mouse. (Selecionar)

Personalize os itens exibidos na barra de
ferramentas Quick Access. Para ativar ou

 (Personalizar barra de ferramentas Acesso
rápido)

desativar um item, clique junto ao menu
suspenso Customize Quick Access
Toolbar.
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Faixa de opções

A faixa de opções é uma paleta que exibe ferramentas e controles com base
nas tarefas.

A faixa de opções é dividida em guias, cada guia suporta uma atividade
específica. Em cada guia, ferramentas são agrupadas em uma série painéis com
base em tarefa.

Para especificar quais guias da faixa de opções são exibidas, clique com o botão
direito do mouse na faixa de opções e, no menu de atalho, clique ou desmarque
as guias ou os painéis.

É possível personalizar a faixa de opções dependendo de suas necessidades,
nas seguintes formas:
■ Altere a ordem das guias da faixa de opções. Clique na guia que deseja

mover, arraste-a para a posição desejada e solte.

■ Altere a ordem dos painéis da faixa de opções em uma guia. Clique na
painel que deseja mover, arraste-o para a posição desejada e solte.

Você pode controlar a quantidade de espaço que a faixa de opções ocupa na
janela do aplicativo. Existem dois botões à direita das guias da faixa de opções
que lhe permitem escolher os estados de alternância e de minimizar da faixa
de opções.
■ O primeiro botão alterna entre o estado completo da faixa de opções

completa  e o estado de minimizar da faixa de opções. 

■ O segundo botão suspenso  lhe permite selecionar um dos quatros estados
de minimizar da faixa de opções:
■ Minimizar para guias: minimiza a faixa de opções para que somente

os títulos das guias sejam exibidos.

■ Minimizar para títulos dos painéis: minimiza a faixa de opções
para que somente os títulos das guias e dos painéis sejam exibidos.

■ Minimizar para os botões do painel: minimiza a faixa de opções
para que somente os botões do painel e os títulos das guias sejam
exibidos.
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■ Navegar entre todos: navega entre todos os quatro estados da faixa
de opções na ordem, faixa de opções completa, minimizar para botões
do painel, minimizar para títulos de painéis, minimizar para guias.

Guias contextuais

Algumas das guias são contextuais. Quando alguns comandos são executados,
uma guia contextual especial da faixa de opções é exibida, em vez de uma
barra de ferramentas ou caixa de diálogo. Por exemplo, assim que você começa
a selecionar itens na Scene View, a guia Item Tools anteriormente oculta
é exibida. Quando nada é selecionado, ela é ocultada novamente.

Painéis deslizantes

Uma seta para baixo  à direita de um título de painel indica que é possível
expandi-lo para exibir ferramentas e controles adicionais. Por padrão, uma
painel expandido se fecha automaticamente quando se clica em outro painel.

Para manter um painel expandido, clique no ícone de pino  no canto inferior
esquerdo do painel deslizante.

Painéis flutuantes

Se você puxar um painel para fora de uma guia da faixa de opções e para uma
área diferente na janela do aplicativo ou área de trabalho, aquele painel flutua
onde for colocado. O painel flutuante continua aberto até que seja retornado
para a faixa de opções, mesmo que você troque de guias na faixa de opções.

Inicializador de ferramentas

Alguns painéis da faixa de opções exibem uma caixa de diálogo ou uma janela
encaixável relacionadas aquele painel. Uma seta de inicializador de ferramenta
 no canto inferior esquerdo do painel indica que você pode exibir uma

ferramenta relacionada. Clique no ícone para exibir a caixa de diálogo ou
janela encaixável relacionadas.

Caixas de seleção

As caixas de seleção permitem alternar entre a ativação e desativação de uma
opção.
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Deslizadores

Quando uma opção pode ser executada com intensidade variável, o deslizador
permite controlar a configuração de mais baixa para mais alta ou o inverso.

Para exibir a faixa de opções

Se você estiver usando a interface de usuário Classic, poderá voltar para a
faixa de opções.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção User
Interface.

3 Na página User Interface, selecione Standard (recomendado) na
lista suspensa User Interface.

4 Clique em OK.

Para ocultar ou exibir uma guia da faixa de opções

1 Clique com o botão direito do mouse em qualquer lugar dentro da faixa
de opções.

2 Em Show Tabs, clique ou desmarque o nome de uma guia.

Para ocultar ou exibir um painel da faixa de opções

1 Clique na guia da faixa de opções que deseja organizar.

2 Clique com o botão direito do mouse na guia da faixa de opções.

3 Em Show Panels, clique ou desmarque o nome de um painel.

Para exibir ou ocultar legendas de texto nos painéis da faixa de opções

■ Clique com o botão direito em uma guia da faixa de opções, e clique ou
desmarque Show Panel Titles.

Para retornar um painel flutuante para a faixa de opções

■ Passe o mouse sobre o lado direito do painel flutuante e clique no ícone
Return Panels to Ribbon.
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Para alternar o tamanho da faixa de opções

1 Clique na seta suspensa na barra da guia da faixa de opções e selecione
o estado desejado minimizado da faixa de opções.

2 Clique duas vezes no nome da guia da faixa de opções ativa ou em
qualquer lugar na barra de guias da faixa de opções.

A faixa de opções alterna entre o estado de minimizar e o estado completo
selecionado da faixa de opções.

Para redefinir a faixa de opções e a barra de ferramentas Acesso rápido

1 Clique com o botão direito do mouse em qualquer lugar dentro da faixa
de opções.

2 Clique em Restore Default Ribbon.

Guia Home

Contém ferramentas para...Painel

controlar toda a cena.Project

selecionar itens e salvar seleções na cena
através de uma faixa de métodos, incluindo
utilizar pesquisas.

Select & Search

exibir e ocultar itens na geometria do
modelo.

Visibility

exibir e ocultar informações, incluindo
propriedades e links.

Display

iniciar a ferramenta TimeLiner Playback.Tools
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Guia Ponto de visão

Contém ferramentas para...Painel

carregar e reproduzir pontos de visão salvos
e animações de ponto de vista.

Salvar, Carregar e Reproduzir

aplicar várias configurações à câmera.Camera

definir a velocidade angular e linear do
movimento, selecionar ferramentas de

Navigate

navegação e configurações de mouse 3D,
além de aplicar configurações de realismo,
como gravidade e colisões.

controlar as configurações de iluminação e
renderização.

Render Style

Guia Review

Contém ferramentas para...Painel

medir distâncias, ângulos e áreas.Medir

exibir e localizar comentários na cena.Comentários

Guia Animation

Contém ferramentas para...Painel

selecionar e reproduzir animações.Reproduzir

ativar scripts.Script
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Guia View

Contém ferramentas para...Painel

ativar visão estereoscópica, desde que o
hardware adequado esteja disponível.

Estéreo

definir a velocidade angular e linear do
movimento, selecionar ferramentas de

Navigate

navegação e configurações de mouse 3D,
além de aplicar configurações de realismo,
como gravidade e colisões. Este painel é
oculto por padrão.

alternar entre controles de navegação,
como a Barra de navegação, ViewCube,
elementos HUD e vistas de referência.

Ajuda para a navegação

controlar a janela Scene View, incluindo ir
para tela cheia, dividir a janela e configurar
o estilo/cores do segundo plano.

Vista da cena

controlar quais janelas flutuantes são
exibidas, e carregar/salvar configurações de
espaço de trabalho.

Espaço de trabalho

Guia Output

Contém ferramentas para...Painel

imprimir e visualizar o ponto de vista atual,
e definir as configurações de impressão.

Imprimir

enviar um e-mail com o arquivo atual como
um anexo.

Send
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Guia Item Tools

Contém ferramentas para...Painel

reter itens selecionados para que eles se
movam com você, conforme navega ao
redor de uma cena.

Suspender

focar e aplicar zoom nos itens selecionados
na vista atual.

Look At

controlar a visibilidade dos itens
selecionados.

Visibility

redefinir a posição, rotação, e escala dos
itens selecionados de volta para os seus
valores originais.

Transform

redefinir a cor e transparência dos itens
selecionados de volta para os seus valores
originais.

Appearance

redefinir os links nos itens selecionados de
volta para os seus valores originais.

Vínculos

Dicas de ferramentas

Posicionar o ponteiro do mouse sobre uma opção do menu ou botão exibe
uma dica de ferramenta contendo o nome da ferramenta, uma atalho de
teclado (se aplicável), e uma breve descrição da ferramenta.

Algumas dicas de ferramentas no menu do aplicativo, barra de ferramentas
Acesso rápido, e faixa de opções são progressivas. Se você deixar o cursor
sobre a opção do menu ou um botão por mais um momento, a dica de
ferramenta pode se expandir para exibir informações adicionais.

Enquanto a dica de ferramenta estiver visível, é possível pressionar F1 para
obter ajuda sensível ao contexto que fornece mais informações sobre aquela
ferramenta.
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Atalhos de teclado

O Autodesk Navisworks fornece teclas de aceleração, ou dicas de teclas, para
permitir que você use o teclado, ao invés do mouse, para interagir com a janela
do aplicativo.

Dicas de teclas são fornecidas para o menu do aplicativo, barra de ferramentas
Acesso rápido, e faixa de opções. É possível usar também os atalhos de
teclado "old style", tais como CTRL + N para abrir um novo arquivo e CRTL +
P para imprimir o arquivo atual.

Para exibir dicas de teclas, pressione ALT. As dicas de teclas (letras ou números)
são exibidas na tela próximas do comando correspondente ou elemento da
interface do usuário. Pressione a tecla de aceleração exibida para imediatamente
invocar o comando desejado ou para exibir o elemento da interface do usuário.
Por exemplo, ao pressionar ALT, e a seguir, pressionar 1 criará um novo arquivo.

Para ocultar as dicas de tecla, pressione ALT novamente.

Consulte também:

Atalhos de teclado padrão na página 83

Ferramentas de navegação

A barra de navegação fornece acesso a ferramentas relacionadas à navegação
interativa e orientação no modelo incluindo Autodesk®, ViewCube®,
SteeringWheels® e o mouse 3D 3Dconnexion®.
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É possível personalizar a barra de navegação com base naquilo que você
considera importante exibir. Você também pode alterar a posição de encaixe
da barra de navegação na Scene View.

A interface de usuário clássica

Se preferir, pode voltar à interface de usuário Classic e usar as barras de
ferramentas e menus suspensos da barra de menu ao invés da faixa de opções.

OBSERVAÇÃO A interface de usuário Classic não está mais sendo atualizada com
aprimoramentos para Autodesk Navisworks. Recomenda-se que você trabalhe
usando a interface do Autodesk Navisworks.

Para alternar para a interface de usuário clássica

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção User
Interface.

3 Na página User Interface, selecione Classic na lista suspensa User
Interface.

4 Clique em OK.

Barra de menus

A barra de menus contém todos os comandos disponíveis no Autodesk
Navisworks, agrupados por funcionalidades similares ou parecidas.

Por exemplo, todos os comandos relativos a funcionalidade de revisão estão
localizados no menu Review , todos os comandos relativos a ajuda ao usuário
estão localizados no menu Help, e assim por diante.

Quando um menu tiver uma seta apontando para a direita, como

 , há um submenu associado com aquela escolha.

Quando um menu é seguido por uma série de pontos, como

 , há uma caixa de diálogo associada com aquela escolha.
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Menu File

Este menu contém os comandos para gerenciar arquivos.

DescriçãoOpção

Reinicializa o programa e fecha o arquivo do
Autodesk Navisworks aberto atualmente.

New

Exibe a caixa de diálogo Open.Abrir

Exibe a caixa de diálogo Open URL.Abrir o URL

Exibe a caixa de diálogo Print.Imprimir

Ativa o modo de visualização de impressão.Visualização de impressão

Exibe a caixa de diálogo Print Setup.Configurações de impressão

Salva o arquivo do Autodesk Navisworks aberto
atualmente, acessa seu programa de e-mail e

Send by Email

adiciona o arquivo salvo como um anexo de e-
mail.

Exibe atalhos para os arquivos mais recentemente
abertos.

Recent Files

Sai do programa.Exit

Menu Edit

Este menu contém os comandos para localizar, selecionar e editar geometria
em seu modelo.

DescriçãoOpção

Reverte a última operação executada.Undo
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DescriçãoOpção

Reverte a última operação executada pelo
comando Undo.

Redo

Fornece o acesso a funcionalidade de seleção.Select

Exibe a caixa de diálogo Quick Find.Quick Find

Repete a execução anterior da pesquisa rápida.Quick Find Next

Ativa o modo oculto para itens selecionados.Hidden

Ativa o modo requerido para itens selecionados.Required

Ativa o modo oculto para itens com o
cancelamento da seleção.

Ocultar objetos não selecionados

Permite reinicializar os itens selecionados de volta
para seu estado original.

Reset Item

Permite reinicializar todos os itens sobrepostos de
volta para seu estado original.

Reset All

Permite classificar os itens da Selection Tree na
ordem alfabética.

Sort

Exibe a caixa de diálogo File Units and
Transform.

File Units an Transform

Menu View

Este menu contém comandos que controlam a interface do Autodesk
Navisworks.

DescriçãoOpção

Permite alternar a exibição das barras de controle.Control Bars
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DescriçãoOpção

Permite controlar os espaços de trabalho.Workspaces

Permite controlar as vistas na Vista da cena.Vista da cena

Permite alternar entre controles de navegação,
como o ViewCube, Barra de navegação e
elementos HUD.

Exibição para acima

Permite controlar o SteeringWheels.SteeringWheels

Coloca o vídeo de saída no modo estéreo.Ativar estéreo

Exibe a caixa de diálogo Stereo Options.Opções de estéreo

Exibe estatísticas de cena úteis.Estatísticas da cena

Menu Viewpoint

Este menu contém um conjunto de comandos que afetam o ponto de vista
atual, incluindo a aparência do modelo e a navegação.

DescriçãoOpção

Permite olhar de um ponto de vista predefinido.Look From

Define o vetor acima do ponto de visão para
alinhar com a orientação selecionada.

Set Viewpoint Up

Permite selecionar o modo de renderização.Rendering

Permite selecionar o modo de iluminação.Lighting

Permite exibir primitivos.Display

Permite selecionar o modo de navegação.Navigation Mode
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DescriçãoOpção

Permite controlar a câmera durante a navegação
interativa.

Ferramentas de navegação

Exibe a caixa de diálogo Edit Current
Viewpoint para o ponto de vista atual.

Editar ponto de vista atual

Menu Tools

Este menu contém comandos para a análise e revisão avançada do modelo e
também comandos para personalizar o Autodesk Navisworks.

DescriçãoOpção

Ativa a janela TimeLiner Playback.TimeLiner Playback

Ativa a exibição de links.Vínculos

Ativa a exibição das propriedades rápidas.Propriedades rápidas

Permite controlar a reprodução da animação,e
alternar scripts.

Animation

Permite selecionar uma cor de segundo plano para
a Scene View.

Background

Exibe a caixa de diálogo File Options.File Options

Exibe o Options Editor.Global Options

Barras de ferramentas

As barras de ferramentas do Autodesk Navisworks fornecem acesso rápido aos
comandos utilizados com frequência.
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Cada botão em uma barra de ferramentas inclui uma dica da ferramenta, que
descreve a função que o botão ativa. Colocar o mouse sobre um botão exibe
na barra de Status um breve instrução de como utilizar este recurso.

É possível reorganizar, abrir e fechar barras de ferramentas.
■ Para mover uma barra de ferramentas, clique na linha tracejada an borda

da barra de ferramentas e a arraste para outra localização.

■ Para abrir ou fechar barras de ferramentas, clique com o botão direito do
mouse em uma área vazia próxima a última barra de ferramentas na tela,
e escolha na lista de barras de ferramentas disponíveis no menu de atalho.

Quando um botão da barra de ferramentas do Autodesk Navisworks tem uma

seta apontando para baixo, como  , uma barra de ferramentas de submenu
está associada a essa escolha. Clique no triângulo para abrir o menu e selecione
uma opção específica. Quando você move através do menu, uma ajuda
adicional é exibida na barra de Status. Quando a opção é selecionada, ela se
torna o comando atual e é exibida como um botão na barra de ferramentas.
Para repetir o comando, clique no botão na barra de ferramentas. Para escolher
outro comando, clique novamente no triângulo.

Alguns botões da barra de ferramentas permitem escolher um modo de
programa. Por exemplo, para olhar em torno de seu modelo, é preciso estar
no modo de olhar em torno. Para girar o modelo, é necessário estar no modo
Free Orbit e assim por diante. O Autodesk Navisworks permanece no modo
selecionado, salvo instrução em contrário. Para identificar em qual modo você
está olhe os botões. Se o botão está realçado e tem uma borda azul escura em
torno do mesmo, o modo correspondente está no momento ativo.

Para sair do modo, clique novamente no mesmo botão ou escolha outro modo.

Alguns botões são utilizados para alternar a exibição de caixas de diálogo e
janelas encaixáveis (por exemplo, a janela Presenter , a janela Animator ,
etc.). Novamente, se um botão está realçado e tem uma borda azul escura em
torno do mesmo, significa que a exibição do elemento correspondente está
no momento aberta.

Quando você abre mais barras de ferramentas na tela ou redimensiona a janela
do Autodesk Navisworks, as barras de ferramentas podem se sobrepor para
não encher demais a tela. Quando isso acontece, alguns botões estarão ocultos
abaixo das sobreposições. Para acessar com rapidez todo o conjunto de
comandos em uma barra de ferramentas, clique no botão com barra  na
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extremidade direita da barra de ferramentas. Os comandos remanescentes
disponíveis para aquela barra de ferramentas irão aparecer.

Nesta seção, você irá encontrar uma lista completa das barra de ferramentas
do Autodesk Navisworks e os botões associados a elas.

OBSERVAÇÃO O conteúdo real da barra de ferramentas pode diferir desta
referência dependendo do espaço de trabalho que você utiliza.

Barra de ferramentas Standard

Esta barra de ferramentas fornece o acesso rápido para os comandos de
gerenciamento de arquivo. Também permite desfazer/refazer suas ações e abrir
o sistema de ajuda.

DescriçãoBotão

Reinicializa o programa e fecha o arquivo
do Autodesk Navisworks no momento
aberto.

Atualiza sua tela com as versões mais
recentes dos arquivos de modelo no
momento carregados.

Exibe a caixa de diálogo Open.

Exibe a caixa de diálogo Append.

Exibe a caixa de diálogo Merge.

Salva o arquivo do Autodesk Navisworks
aberto no momento.

Exibe a caixa de diálogo Publish.
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DescriçãoBotão

Salva o arquivo do Autodesk Navisworks no
momento aberto, acessa seu programa de
e-mail e adiciona o arquivo salvo como um
anexo de e-mail.

Reverte a última operação executada.

Reverte a última operação executada pelo
comando Undo.

Exibe a caixa de diálogo Print.

Exibe as informações de direito autoral e de
licença sobre sua cópia do Autodesk
Navisworks.

Abre o sistema de ajuda.

Barra de ferramentas Selection Tools

Esta barra de ferramentas fornece o acesso aos comandos de seleção e permite
ocultar objetos de geometria.

DescriçãoBotão

Ativa o modo Select.

Ativa o modo Select Box.

Ativa o modo requerido para itens
selecionados.

64 | Capítulo 3   Início rápido



DescriçãoBotão

Ativa o modo oculto para itens
selecionados.

Ativa o modo oculto para itens com o
cancelamento da seleção.

Barra de ferramentas Navigation Mode

Esta barra de ferramentas inclui nove modos e seis SteeringWheels para a
navegação interativa em torno de seus modelos 3D.

DescriçãoBotão

Seleciona o círculo.

Ativa o modo Walk.

Ativa o modo Look Around

Ativa o modo Zoom.

Ativa o modo Zoom Box.

Ativa o modo Pan.

Ativa o modo Orbit.

Ativa o modo Free Orbit.

Ativa o modo Fly.
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DescriçãoBotão

Ativa o modo Constrained Orbit.

Barra de ferramentas Rendering Style

Esta barra de ferramentas controla a aparência no Autodesk Navisworks.

DescriçãoBotão

Seleciona o modo Lighting .

Seleciona o modo Rendering.

Ativa a renderização de superfícies.

Ativa a renderização de linhas.

Ativa a renderização de pontos.

Ativa a renderização de pontos de snap.

Ativa a renderização de texto 3D.

Barra de ferramentas Workspace
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Esta barra de ferramentas fornece o acesso rápido às ferramentas de revisão e
de análise do Autodesk Navisworks.

DescriçãoBotão

Ativa a janela da ferramenta Redline Tools.

Ativa a exibição de links.

Ativa a exibição das propriedades rápidas.

Ativa a janela da ferramenta Measure
Tools.

Ativa a barra de controle Viewpoints.

Ativa a barra de ferramentas Sectioning.

Ativa a barra de controle Plan View.

Ativa a barra de controle Section View.

Ativa a barra de controle Selection Tree.

Ativa a barra de controle Sets.

Ativa a barra de controle Comments.

Ativa a caixa de diálogo Find Comments.

Ativa a barra de controle Find Items.

Ativa a barra de controle Properties.
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DescriçãoBotão

Ativa a janela da ferramenta Clash
Detective.

Ativa a janela da ferramenta Presenter.

Ativa a janela da ferramenta TimeLiner.

Ativa a janela TimeLiner Playback.

Ativa a janela da ferramenta Animator.

Ativa a janela da ferramenta Scripter.

Controla os espaços de trabalho.

Barra de ferramentas Animation

Esta barra de ferramentas permite reproduzir animações de ponto de visão e
de objeto e ativar a funcionalidade de script.

DescriçãoBotão

Rebobina a animação atual de volta ao
início.

Volta um quadro ou um quadro-chave da
animação.

Reproduz a animação atual no sentido
inverso.
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DescriçãoBotão

Grava a animação do ponto de vista.

Pausa a animação.

Pára a reprodução da animação atual e
rebobina de volta ao início.

Reproduz a animação no momento
selecionada.

Avança um quadro ou um quadro-chave.

Avança rápido a animação atual para o fim.

Ativa e desativa o mecanismo Scripter no
arquivo do Autodesk Navisworks.

Barra de ferramentas Navigation Tools

Esta ferramenta permite controlar a câmera durante a navegação interativa.

DescriçãoBotão

Efetua a elevação e pan da câmera para que
todos o modelo esteja na Vista da cena.

Efetua o zoom da câmera para que os itens
selecionados preencham a Vista da cena.

Coloca a Vista da cena no modo de foco.
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DescriçãoBotão

Armazena os itens selecionados. Ao
percorrer o modelo, este objetos irão mover
juntos.

Utiliza uma câmera em perspectiva.

Utiliza uma câmera ortogonal.

Ativa a colisão.

Ativa a gravidade.

Ativa o agachar-se.

Ativa a vista da terceira pessoa.

Alinha o ponto de vista atual com o eixo X.

Alinha o ponto de vista atual com o eixo Y.

Alinha o ponto de vista atual com o eixo Z.

Scene View

Esta é a área onde você visualiza e interage com seus modelos 3D.

Ao iniciar o Autodesk Navisworks, a Scene View contém somente uma vista
da cena, mas caso seja necessário, é possível adicionar mais. Vistas de cenas
personalizadas são nomeadas como "VistaX" onde "X" é o próximo número
disponível. A vista de cena padrão não pode ser movida.

70 | Capítulo 3   Início rápido



Olhar para diversas vistas de seu modelo simultaneamente é útil quando você
compara estilos de iluminação e renderização, efetua a animação de diferentes
partes de seu modelo, e assim por diante.

Somente uma vista de cena pode estar ativa de cada vez. Uma vista da cena
se torna ativa quando você trabalha nela. Se você clica com o botão esquerdo
do mouse na vista, a vista da cena é ativada e seja o que for clicado é
selecionado, ou se for clicado em uma área vazia, tudo tem a seleção cancelada.
Clicar com o botão direito do mouse em uma vista da cena a ativa e abre um
menu de atalho.

Cada vista da cena lembra o modo de navegação sendo utilizado. A gravação
e reprodução de animações somente ocorre na vista ativa no momento.

Cada vista da cena pode ser redimensionada. Para redimensionar vistas da
cena, mova o cursor sobre a intersecção da vista da cena e arraste a barra

divisora  .

Você pode tornar vistas de cenas personalizadas encaixáveis. As vistas de cenas
encaixáveis têm barras de título e podem ser movidas, encaixadas, colocadas
lado a lado e automaticamente ocultadas da mesma forma que as janelas
encaixáveis na página 73. Caso deseje utilizar várias vistas de cenas
personalizadas, mas não queira ter nenhuma divisão na Scene View, poderá
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movê-las a qualquer outro lugar. Por exemplo, você pode colocar a cena
lado-a-lado na barra de controle Viewpoints.

OBSERVAÇÃO Você não pode cancelar o encaixe da vista de cena padrão.

Modo de tela cheia

No modo Full Screen a vista da cena atual ocupa toda a tela.

Para interagir com o modelo na vista de cena, é possível usar o ViewCube, a
Barra de navegação, os atalhos de teclado, e o menu de atalho.

DICA Caso você utilize dois monitores, sua vista de cena padrão é colocada na
tela principal e a interface pode ser colocada na segunda tela para controlar a
interação.

Para criar uma vista de cena padrão

■ Para dividir a sua vista de cena ativa horizontalmente, clique na guia

View ➤ painel Split View ➤ Split View ➤ Split Horizontal  .

■ Para dividir a sua vista de cena ativa verticalmente, clique na guia

View ➤ painel Scene View ➤ Split View ➤ Split Vertical  .

Barra de ferramentas:  Interface de usuário Classic: Model

Views ➤ Split Horizontal  e Model Views  ➤ Split Vertical

Para tornar uma vista de cena personalizada encaixável

■ Clique na guiaView ➤ painel Scene View ➤ Show Title Bars.

Todas as suas vistas de cenas personalizadas agora têm barras de títulos.

Barra de ferramentas:  Interface de usuário Classic: Model

Views ➤ Toggle Title Bars

Para excluir uma vista de cena personalizada

1 Se a vista da cena não for encaixável, clique na guia View painel
 ➤ Scene View ➤ Show Title Bars.

2 Clique em  para fechar a vista da cena.

OBSERVAÇÃO Você não pode excluir a vista de cena padrão.
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Para alternar o modo Full Screen

■ Clique na guiaView painel  ➤ Scene View ➤ Full Screen  .

Entrada do comando: F11
Menu de atalho: Viewpoint ➤ Full Screen

Para redimensionar o conteúdo da vista da cena ativa

1 Clique na guia View ➤ painel Scene View ➤ Window Size  .

2 Na caixa de diálogo Window Size , lista suspensa Type, selecione o
tipo de dimensionamento.

■ Use View - faz com que o conteúdo preencha a vista da cena ativa.

■ Explicit - define a largura e a altura exata para o conteúdo.

■ Use Aspect Ratio - utiliza a relação de aspecto da vista da cena atual
para calcular automaticamente a largura do conteúdo quando a altura
é inserida, ou a altura do conteúdo quando a largura é inserida.

3 Se você selecionar a opção Explicit , insira a largura e a altura para seu
conteúdo em pixels.

Se você seleciona a opção Use Aspect Ratio, insira a largura ou a altura
para seu conteúdo em pixels.

4 Clique em OK.

Janelas encaixáveis

A maioria dos recursos do Autodesk Navisworks podem ser acessados a partir
de janelas encaixáveis.

Há várias opções de janelas, que são agrupadas em várias áreas funcionais:
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Janelas de ferramentas principais

Essas janelas fornecem acesso à principal funcionalidade do Autodesk
Navisworks:

■ TimeLiner Playback

Revisar Windows

Estas janelas contêm ferramentas necessárias para executar operações de
selecionar/pesquisar/revisar:

■ Selection Tree

■ Properties

■ Comments

■ Measure Tools

Janelas de ponto de vista

Estas janelas contêm ferramentas necessárias para configurar e usar pontos de
visão :

■ Saved Viewpoints

■ Tilt - somente em um espaço de trabalho 3D.

■ Plan View - somente em um espaço de trabalho 3D.

■ Section View - somente em um espaço de trabalho 3D.

Janelas de múltiplas folhas

Estas janelas permitem trabalhar com arquivos de múltiplas folhas:

■ Project Browser

■ Find Item in Other Sheets and Models (Localizar itens em outras
folhas e modelos)

As janelas podem ser movidas e redimensionadas, e flutuar na Vista da cena
ou encaixar (fixadas ou ocultas automaticamente).

DICA É possível encaixar e desencaixar rapidamente uma janela clicando com o
botão direito na janela da barra de título.
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Uma janela encaixada compartilha uma ou mais bordas com janelas e barras
de ferramentas adjacentes. Se uma aresta compartilhada é movida, as janelas
mudam de forma para compensar. Você também pode flutuar as janelas em
qualquer ponto na tela, se necessário.

OBSERVAÇÃO  A janela Tilt só pode ser encaixada verticalmente na esquerda
ou na direita, recebendo toda a altura da tela, ou flutuando.

Por padrão, uma janela encaixada é fixa, significando que a janela continua
a ser exibida em seu tamanho atual e pode ser movida. Quando você oculta
automaticamente uma janela e move o mouse para longe dela, a janela é
reduzida para uma guia exibindo o nome da janela. Mover o ponteiro do
mouse sobre a guia exibe a janela completa, mas temporariamente, sobre a
tela. Ocultar automaticamente uma janela pode mostrar mais da tela, enquanto
mantém a janela disponível. Ocultar automaticamente também previne que
ela seja desencaixada, agrupada ou desagrupada.

OBSERVAÇÃO Ao encaixar a janela dentro da vista da cena padrão, as
funcionalidades para selecionar e ocultar automaticamente não estarão disponíveis.

Uma janela desencaixada é uma que foi separada da janela do programa. Cada
janela desencaixada pode ser movida ao redor da tela ou telas, se necessário.
Mesmo que janelas desencaixadas não possam ser fixadas, elas podem ser
redimensionadas e agrupadas.

Um grupo de janelas é uma forma de ter mais de uma janela ocupando a
mesma quantidade de espaço na tela. Quando janelas são agrupadas, cada
janela é representada por uma guia na parte inferior do grupo. Em um grupo,
clique em uma guia para exibir aquela janela. É possível agrupar ou desagrupar
janelas como necessário e salvar os espaços de trabalho personalizados. Após
alterar as posições das janelas, você pode salvar suas configurações como um
espaço de trabalho personalizado.

Posição de ocultar automático

Quando você oculta automaticamente uma janela, ele se retrai contra um lado
específico da tela - Superior, Esquerdo, Direito, ou Inferior. O lado para o qual
ela se retrai é determinado pela posição de encaixe. Portanto, por exemplo, se
você encaixar uma janela à esquerda da tela, ela se retrai para a esquerda.

O menu de atalho

Clicar com o botão direito do mouse em uma janela encaixável exibe um
menu de atalho de comandos disponíveis. Se você clicar com o botão direito
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do mouse em um item único, ou seleciona um ou mais itens e clica com o
botão direito do mouse, este menu contém comandos relativos aos itens. Se
você clicar com o botão direito do mouse em uma área que não contenha
itens ou dados, o menu contém comandos relativos a janela encaixável, se
apropriado.

Para exibir uma janela encaixável

1 Clique na guia View painel  ➤ Workspace ➤ Windows  .

2 Selecione a caixa de verificação próxima da janela desejada na lista
suspensa.

Para mover uma janela encaixável

1 Clique e arraste a barra de título no topo ou lateral da janela.

2 Opcional: para impedir que uma janela encaixe automaticamente
enquanto é arrastada, mantenha a tecla Ctrl pressionada.

DICA A ferramenta de encaixe lhe permite posicionar janelas em uma relação
específica às áreas da tela.

Para agrupar janelas encaixáveis

1 Clique a arraste a barra de título da janela a ser adicionada a outra janela
ou grupo.

2 Solte a janela na barra de título da janela ou grupo que está recebendo.
Uma guia com o nome da janela arrastada é adicionada na parte inferior
da janela que está recebendo.

Para desagrupar janelas encaixáveis

1 No grupo, clique na guia da janela que deseja remover.

2 Clique e arraste a guia da janela para fora do grupo.

3 Solte a janela para desagrupá-la.

Para ocultar automaticamente janelas encaixáveis

1 Em uma barra de título de janela, clique em  .

A janela continua a ser exibida até que você mova o ponteiro do mouse
para longe dela. Quando você move o ponteiro do mouse, a janela é
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retraída até que o ponteiro do mouse seja posicionado sobre a guia da
janela no lado da tela onde ela foi encaixada.

OBSERVAÇÃO Para mover ou agrupar janelas, é preciso fixá-las primeiro.

Para fixar janelas encaixáveis

1 Mova o cursor do mouse sobre a barra de título para exibir a janela oculta.

2 Clique em  na barra de título. A janela agora está fixada, e pode ser
movida e agrupada.

Para redimensionar uma janela encaixável ou um grupo de janelas

1 Posicione o ponteiro do mouse sobre a borda de uma janela até que ele

mude para a barra de divisão  .

2 Clique e arraste a borda para o tamanho desejado.

DICA É possível redimensionar janelas fixadas e ocultas automaticamente. Em um
grupo oculto automaticamente, cada janela pode ser redimensionada
separadamente das outras janelas. Em um grupo fixado, redimensionar uma janela
redimensiona o resto das janelas.

Ferramenta de encaixe

A ferramenta de encaixe indica a relação de uma janela arrastada com o resto
da tela, e permite apontar destinos para arrastar e soltar.

A ferramenta contém uma zona interna e zona externa de controles
representando o destino para soltar. Cinco encaixes da zona interna são usados
para encaixar janelas relativas à área adequada mais próxima da tela, enquanto
que quatro encaixes da zona externa são usados para encaixar janelas relativas
à própria tela.
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A ferramenta de encaixe também fornece visualizações de quais espaços serão
ocupados por uma janela. Essas visualizações são exibidas quando você move
uma janela e quando o seu mouse estiver sobre um dos encaixes.

DICA Para criar rapidamente um grupo de janelas, use o encaixe no centro da
ferramenta de encaixe ao arrastar uma janela para a sua localização. Isto funciona
em qualquer lugar da tela excluindo a vista de cena padrão e a janelaTilt. Vistas
de cena personalizadas podem ser agrupadas com outras janelas.

Para mover uma janela com a ferramenta de encaixe

1 Clique e arraste a barra de título no topo ou no lado da janela em direção
ao local onde deseja encaixá-la. Isto ativa a ferramenta de encaixe.

2 Arraste a janela sobre o encaixe na ferramenta de encaixe que representa
a área que você deseja que a janela ocupe.

3 Solte o botão do mouse para encaixar a janela. A janela é
automaticamente redimensionada para preencher a área.

Status Bar

A barra de Status aparece na parte inferior da tela do Autodesk Navisworks.
Ela não pode ser personalizada ou movida

O canto esquerdo da barra de Status é usado para exibir pequenas instruções
sobre como utilizar os recursos do Autodesk Navisworks (se aplica somente à
interface de usuárioClassic).

O canto direito da barra de Status inclui quatro indicadores de desempenho
que fornecem feedback constante sobre como está o desempenho do Autodesk
Navisworks em sua máquina, um botão para alternar para a janela Project
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Browser e controles para navegar entre folhas/modelos em arquivos de

múltiplas folhas. 

Controles de navegação de múltiplas folhas

Clique nas setas anterior/próximo e primeiro/último para abrir o modelo/folha
desejado na Scene View. Isso é equivalente a clicar duas vezes no
modelo/folha na janela Project Browser. O modelo/folha será
automaticamente preparado para utilização no Autodesk Navisworks, se
aplicável.

OBSERVAÇÃO Esses controles estão disponíveis somente para arquivos de múltiplas
folhas.

Botão Navegador de projeto

Clique no botão Project Browser  para alternar a janela Project Browser
na página 104.

Barra de andamento do lápis

A barra de andamento sob o ícone (lápis) no lado esquerdo, indica quanto da
vista atual foi desenhado, ou seja quando de espaço existe no ponto de vista
atual. Quando a barra de andamento estiver em 100%, a cena está
completamente desenhada, sem nenhum espaço. O ícone muda de cor quando
um redesenho está em andamento. Embora a cena esteja sendo desenhada, o
lápis irá mudar para amarelo. Se houver excesso de dados a serem manipulados
e sua máquina não puder processar isso o suficientemente rápido para o
Autodesk Navisworks, então o lápis ficará vermelho para indicar um gargalo.

Barra de andamento do disco

A barra de andamento sob o ícone (disco) central indica quanto do modelo
atual foi carregado do disco, ou seja quanto está carregado na memória. Quando
a barra de andamento estiver em 100%, todo o modelo, incluindo a geometria
e as informações da propriedade, estão carregados na memória. O ícone muda
de cor quando um carregamento de arquivo está em andamento. Embora os
dados estão sendo lidos, o disco muda para amarelo. Se houver excesso de
dados a serem manipulados e sua máquina não puder processar isso o
suficientemente rápido para o Autodesk Navisworks, então o disco ficará
vermelho para indicar um gargalo.
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Barra de andamento do servidor da web

A barra de andamento sob o ícone (servidor da web) no lado direito indica
quanto do modelo atual foi descarregado, ou seja quanto foi descarregado de
uma servidor da web. Quando a barra de andamento estiver em 100%, todo
o modelo foi descarregado. O ícone muda de cor quando um carregamento
de arquivo está em andamento. Embora os dados estão sendo descarregados,
o servidor da web muda para amarelo. Se houver excesso de dados a serem
manipulados e sua máquina não puder processar isso o suficientemente rápido
para o Autodesk Navisworks, então o servidor da web ficará vermelho para
indicar um gargalo.

Barra de memória

O campo à direita dos ícones reporta o montante de memória sendo utilizado
no momento pelo Autodesk Navisworks. Isto é reportado em Megabytes (MB).

Comandos desfazer/refazer

Você pode desfazer ou refazer ações no Autodesk Navisworks.

As configurações padrão são adequadas para a utilização normal do Autodesk
Navisworks, mas é possível ajustar na página 296 o montante de espaço alocado
para o buffer de desfazer/refazer, se necessário.

Para desfazer uma ação

■ Clique em Undo  na barra de ferramentas Quick Access.

Entrada do comando: Ctrl+Z
Barra de ferramentas:  Interface de usuário Classic: Standard ➤ Undo

Para refazer uma ação

■ Clique em Redo  na barra de ferramentas Quick Access.

Entrada do comando: Ctrl+Y
Barra de ferramentas:  Interface de usuário Classic: Standard ➤ Redo
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Espaços de trabalho do Autodesk
Navisworks

Os espaços de trabalho retêm informações sobre quais janelas estão abertas,
suas posições e o tamanho da janela do aplicativo.

Os espaços de trabalho retêm alterações feitas na faixa de opções, mas não na
barra de ferramentas Quick Access.

OBSERVAÇÃO No modo de interface de usuário Clássica (que é quando a faixa
de opções está desativada), os espaços de trabalho retêm as informações sobre
as janelas de encaixe e sobre as barras de ferramentas.

Os espaços de trabalho podem ser compartilhados com outros usuários. Por
exemplo, você poderia criar espaços de trabalho separados para usuários
ocasionais ou avançados do Autodesk Navisworks ou definir sua própria norma
corporativa.

O Autodesk Navisworks é fornecido com diversos espaços de trabalho
pré-configurados:
■ Safe Mode - seleciona o layout com os recursos mínimos.

■ ONavisworks Standard - seleciona o layout com as janelas ocultas
automaticamente usadas com frequência como guias.

■ ONavisworks Minimal - seleciona o layout permitindo o maior espaço
possível à Vista da cena.

Você pode utilizar estes espaços de trabalho como estão ou modificá-los de
acordo com suas necessidades. Ao iniciar o Autodesk Navisworks, o espaço de
trabalho Navisworks Minimal será usado. É possível escolher um espaço
de trabalho diferente a qualquer hora, clicando na guia View ➤ painel
Workspace ➤ Load Workspace  e, a seguir, selecionar na lista o espaço
de trabalho necessário.

Barra de ferramentas:  Interface de usuário Classic:

Workspace ➤ Workspaces

Para salvar o layout atual em um novo espaço de trabalho

1 Defina seu layout de revisão do projeto. Por exemplo, é possível agrupar
as janelas Properties e Saved Viewpoints.

Caso esteja utilizando o modo de interface de usuário Clássica, por
exemplo, é possível fechar todas as barras de ferramentas, exceto as
Standard,Selection Tools, Navigation Mode, e Workspace.
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2 Clique na guia View ➤ painel Workspace ➤ Save Workspace  .

3 Na caixa de diálogo Save Current Workspace  , insira um nome para
o novo espaço de trabalho. Você também pode selecionar o nome de
um espaço de trabalho existente para sobrepô-lo com sua configuração
modificada.

4 Clique em Save.

Para carregar um espaço de trabalho salvo no Autodesk Navisworks

1 Clique na guia View ➤ painel Workspaces ➤ Load Workspace
.

2 Na caixa de diálogo Load Workspace , procure pela pasta que contenha
o espaço de trabalho desejado e selecione-o.
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3 Clique em Open.

Atalhos de teclado padrão

Os atalhos de teclado são alternativas de teclado que podem ser utilizados para
iniciar comandos normalmente acessados com o mouse.

Por exemplo, para abrir a janelaSelection Tree, pode pressionar Ctrl + F12,
para abrir a janela Comments, pode pressionar Shift + F6 e assim por diante.
Os atalhos de teclado oferecem um meio de trabalhar mais rápido e com maior
eficácia. Algumas caixas de diálogo ou janelas encaixáveis podem ser fechadas
como mesmo comando utilizado para abri-las.

Muitos atalhos de teclado já estão definidos para as ações de uso mais comum.
Você pode modificar os atalhos padrão ou adicionar novos atalhos, se
necessário.

DescriçãoAtalho de teclado padrão

Aplica zoom para exibir todos os objetos na Vista da cena.PgUp

Aplica zoom para ampliar todos os objetos selecionados na Vista da cena.PgDn
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DescriçãoAtalho de teclado padrão

Leva você para a vista Home. Este atalho de teclado somente se aplica para
as janelas Scene View. Isso significa que somente irá funcionar quando
esta janela tiver foco.

HOME

Cancela a seleção de tudo.Esc

Usado para modificar as ações do botão do meio do mouse.Shift

Usado para modificar as ações do botão do meio do mouse.Ctrl

Ativa ou desativa as dicas de teclas.ALT

Fecha a janela encaixável no momento ativa quando esta tiver seu encaixe
cancelado ou sai do aplicativo se a janela principal do aplicativo estiver ativa.

ALT + F4

Ativa o modo Turntable.Ctrl+0

Ativa o modo Select.Ctrl + 1

Ativa o modo Walk.Ctrl+2

Ativa o modo Look AroundCtrl+3

Ativa o modo Zoom.Ctrl+4

Ativa o modo Zoom Window.Ctrl + 5

Ativa o modo Pan.Ctrl+6

Ativa o modo Orbit.Ctrl+7

Ativa o modo Free Orbit.Ctrl+8

Ativa o modo Fly.Ctrl+9
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DescriçãoAtalho de teclado padrão

Alterna o modo Collision. É preciso estar no modo de navegação apropriado
(ou seja, Walk ou Fly) para que este atalho de teclado funcione.

Ctrl+D

Exibe a caixa de diálogo Quick Find.Ctrl+F

Alterna o modo Gravity.Ctrl+G

Alterna o modo Hiddenpara itens selecionados.Ctrl+H

Exibe a caixa de diálogo Select File.Ctrl+I

Reinicializa o programa, fecha o arquivo do Autodesk Navisworks aberto no
momento e cria um novo arquivo.

Ctrl+N

Exibe a caixa de diálogo Open.Ctrl+O

Exibe a caixa de diálogo Print.Ctrl+P

Alterna o modo Requirepara itens selecionados.Ctrl+R

Alterna o modo Third Person.Ctrl+T

Reverte a última operação executada pelo comando Undo.Ctrl+Y

Reverte a última operação executada.Ctrl+Z

Exibe a folha anterior.CTRL + PgUp

Exibe a próxima folha.CTRL + PgDn

Abre o sistema de Help.Ctrl + F1

Ativa a janela TimeLiner Playback.Ctrl + F3

Alterna a janela Tilt.Ctrl + F7
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DescriçãoAtalho de teclado padrão

Ativa a janela Plan View.Ctrl + F9

Ativa a janela Section View.Ctrl + F10

Ativa a janela Saved Viewpoints.Ctrl + F11

Ativa a janela Selection Tree.Ctrl + F12

Efetua a elevação e pan da câmera para que todo o modelo esteja na vista.Ctrl + HOME

Reproduz a animação selecionada.Ctrl + Seta para baixo

Reprodução reversa da animação selecionada.Ctrl + Seta para esquerda

Define a vista atual como Home.Ctrl + Shift + HOME

Define a vista atual como Front.Ctrl + Shift + END

Leva você para o identificador de linha de marcação anterior.Ctrl + Shift + Seta para esquerda

Leva você para o próximo identificador de linha de marcação.Ctrl + Shift + Seta para direita.

Leva você para o primeiro identificador de linha de marcação.Ctrl + Shift + Seta para cima

Leva você para o último identificador de linha de marcação.Ctrl + Shift + Seta para baixo

Abre o sistema de Help.F1

Renomeia o item selecionado quando apropriado.F2

Repete a pesquisa de execução anterior Quick Find.F3

Alterna o modo Full Screen.F11
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DescriçãoAtalho de teclado padrão

Abre o Options Editor.F12

Abre o SteeringWheel utilizado por último.Shift + W

Permite obter a ajuda sensível ao contexto.Shift + F1

Ativa a janela Comments.Shift + F6

Ativa a janela Properties.Shift + F7

Abre um menu de atalho.Shift + F10

Abre a caixa de diálogo File Options.Shift + F11

Navegação com o botão de rolagem
Se você possui um mouse com rolagem, é possível usar o botão do meio do
mouse para aplicar zoom, pan e orbit.

Faça isto...Para

role o botão de rolagem para frente.Aumentar o zoom

role o botão de rolagem para trás.Diminuir o zoom

mantenha o botão do meio do mouse
pressionado, e em seguida mova o mouse
para efetuar a panorâmica.

Efetuar panorâmica

mantenha pressionado Shift e pressione o
botão do meio do mouse, em seguida mova

Orbitar

o mouse para orbitar ao redor do ponto de
giro definido atualmente. Essa função não
está disponível em um espaço de trabalho
2D.
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Faça isto...Para

mantenha pressionadas as teclas SHIFT e
CTRL e pressione o botão do meio do

Alterar o ponto de giro

mouse, em seguida arraste para o ponto no
modelo que deseja usar como ponto de
giro. Essa função não está disponível em
um espaço de trabalho 2D.

OBSERVAÇÃO O acima citado não se aplica quando se está usando Walk, Fly, ou
qualquer outro modo de navegação clássico, que possuem os seus próprios
comportamentos de botão de rolagem/botão do meio.

Navegação com a roda / botão do meio do mouse

OBSERVAÇÃO Em um espaço de trabalho 2D só é possível efetuar o pan e zoom.
Além disso, a função Shift + botão do meio está disponível somente em um espaço
de trabalho 3D.

Shift + Botão do
meio

Botão do
meio

Roda

Ferramentas de não-navegação

OrbitPanZoom In/OutSelect

Modos de navegação clássicos

Glide Camera (Faster)Glide CameraLook Up/DownWalk

OrbitPanZoom In/OutLook Around

-Zoom (Drag)Zoom (Roll)Zoom

-Zoom (Drag)Zoom (Roll)Zoom Box

-Zoom (Drag)Zoom (Roll)Pan

-Glide CameraZoom (Roll)Orbit
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Shift + Botão do
meio

Botão do
meio

Roda

-PanZoom (Roll)Examine

-Roll-Fly

-PanTilt Up/DownTurntable

Modos de navegação padrão

OrbitPanZoom In/OutPan

OrbitPanZoom In/OutZoom Window

OrbitPanZoom In/OutZoom

OrbitPanZoom In/OutOrbit

OrbitPanZoom In/OutFree Orbit

OrbitPanZoom In/OutConstrained Orbit

OrbitPanZoom In/OutLook At

OrbitPanZoom In/OutSteeringWheels

Opções do Autodesk Navisworks
Há dois tipos de opções: File Options e Global Options.

File Options

Em cada arquivo do Autodesk Navisworks (NWF e NWD), é possível ajustar a
aparência do modelo e a velocidade de navegação do mesmo. As opções de
exibição são armazenadas com os arquivos do Autodesk Navisworks (NWF ou
NWD) e recarregadas cada vez que estes arquivos forem abertos.
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A caixa de diálogo File Options é usada para personalizar várias opções de
arquivo e pode ser acessada clicando na guia Home ➤ painel Project ➤ File
Options  .

Global Options

Por outro lado, as opções globais são definidas para todas as sessões do Autodesk
Navisworks. O Options Editor pode ser acessado ao clicar no botão do

aplicativo  ➤ Options ou pode ser lançado como um aplicativo separado.
Para fazer isso, clique em Iniciar ➤ Todos os
programas ➤ Autodesk ➤ Navisworks Freedom 2012 ➤ Options Editor.
As opções são agrupadas e apresentadas na estrutura em árvore, tornando mais
rápido encontrá-las e alterá-las.
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As opções globais podem ser exportadas e importadas, tornando mais rápido
e fácil para que os gerentes de projeto ou os administradores de sistemas
assegurem que as configurações do Autodesk Navisworks sejam idênticas em
todas as máquinas.

Para configurar as opções de arquivo

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Utilize a caixa de diálogo File Options para personalizar diversas
configurações de arquivo.

3 Clique em OK para salvar as alterações.

Menu:  Interface de usuário clássica: Tools ➤ File Options

Consulte também:

Caixa de diálogo File Options na página 288

Para configurar opções globais

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor expanda o nó desejado, e clique na opção que deseja
configurar.

3 Clique em OK para salvar as alterações.
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Menu:  Interface de usuário: Classic: Tools ➤ Global Options

Consulte também:

Caixa de diálogo Options Editor  na página 295

Para exportar opções globais

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor clique no botão Export.

3 Na caixa de diálogo Select Options to Export, selecione as caixas de
verificação para todas as opções que deseja exportar (ou "serializar"). Se
uma opção não puder ser exportada ela é acinzentada.

DICA Para selecionar/cancelar a seleção rapidamente de todas as opções
para uma determinada categoria, utilize as caixas de seleção do nível superior.
Por exemplo, a seleção da caixa de seleção General , seleciona
instantaneamente todas as opções sob este nó.

4 Clique em OK para exportar as configurações selecionadas.

5 Na caixa de diálogo Save As insira um nome para o arquivo de
configurações. Você também pode selecionar o nome de um arquivo de
configurações existente para sobrescrevê-lo com sua configuração
modificada.
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6 Clique em Save.

7 Clique em OK para fechar o Options Editor.

Menu:  Interface de usuário Classic: Tools ➤ Global Options

Para importar opções globais

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor clique no botão Import.

3 Na caixa de diálogo Open procure pela pasta que contém o arquivo de
configurações, selecione-o, e clique em Open.
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4 Clique em OK para fechar o Options Editor.

Menu:  Interface de usuário Classic: Tools ➤ Global Options

Opções de localização
Estas opções permitem o compartilhamento centralizado de configurações
globais do Autodesk Navisworks, espaços de trabalho, ferramentas de dados,
avatars, regras do Clash Detective, arquivos do Presenter, testes personalizados
do Clash Detective, scripts de animação de objeto, e assim por diante, com
outros usuários.

Estas configurações podem ser compartilhadas através de todo um local de
projeto, ou através de um grupo de projetos específico, dependendo no nível
de granularidade requerido.

Consulte também:

Como compartilho as configurações do Autodesk Navisworks com base
no projeto e terreno? na página 38
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Para configurar opções de localização

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó General no Options Editor, e clique na opção
Locations.

3 Na caixa Project Directory, navegue até o diretório que contém as
configurações do Autodesk Navisworks específicas de seu grupo de
projetos.

4 Na caixa Site Directory, navegue até o diretório que contém as
configurações padrão do Autodesk Navisworks através de todo o local
do projeto.

5 Clique em OK.

Menu:  Interface de usuário: Classic: Tools ➤ Global Options

OBSERVAÇÃO Quando você executa o Autodesk Navisworks pela primeira vez,
as configurações são obtidas no diretório de instalação. Subsequentemente, o
Autodesk Navisworks examina o perfil do usuário atual e os perfis de todos os
usuários na máquina local e, a seguir, verifica as configurações no Project
Directory e no Site Directory. Os arquivos no Project Directory tem
prioridade.
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Unidades de exibição
As unidades de exibição determinam a escala do modelo no Autodesk
Navisworks.

As unidades de exibição são utilizadas para medir a geometria em sua cena.
alinhar modelos anexados, definir tolerâncias para a detecção de interferência,
definir tamanhos de textura, e assim por diante.

Quando você abre arquivos CAD e de digitalização a laser, o Autodesk
Navisworks lê as unidades do arquivo diretamente dos arquivos. Se isso não
for possível (por exemplo, o arquivo não tem unidade), o Autodesk Navisworks
usa as unidades padrão para aquele tipo de arquivo no Options Editor,
sempre que for possível. Os arquivos carregados são dimensionados de forma
apropriada para as unidades de exibição configuradas.

É possível redimensionar as unidades do arquivo, se for determinado que estão
incorretas para a cena.

Para personalizar as unidades de exibição

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó Interface no Options Editor, e clique na opção Display
Units.

3 Selecione Linear Units na lista suspensa. Assegure ter escolhido o
formato exato requerido.
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4 Selecione Angular Units na lista suspensa.

5 Insira o número de casas decimais que deseja ver na interface para suas
unidades na caixa Decimal Places. Se a unidade escolhida for fracional
ao invés de decimal, então você tem a escolha de qual nível de fração
para exibir as unidades da lista Fractional Display Precision.

6 Clique em OK.

Menu:  Interface de usuário: Classic: Tools ➤ Global Options

Perfis
O Autodesk Navisworks pode ser ajustado para seu nível de conhecimento
técnico de CAD.

Por padrão, um perfil padrão é utilizado. Se necessário, você pode utilizar um
perfil de desenvolvedor para exibir propriedades adicionais do objeto.

Para utilizar um perfil de desenvolvedor

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó Interface , e clique na opção Developer.

3 Selecione a caixa de verificação Show Internal Properties para
adicionar propriedades de objeto adicionais à janela Properties.

4 Clique em OK.
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Menu:  Interface de usuário: Classic: Tools ➤ Global Options

Pesquisar diretórios
O Autodesk Navisworks busca diversos arquivos de configuração em
subdiretórios de três diretórios padrão.

Estes arquivos podem ser sobrepostos com base em usuário, todos os usuários
ou por instalação. As pesquisas de diretórios são:
■ Application Data\Autodesk Navisworks Freedom 2012 no perfil do usuário

atual. Por exemplo, C:\Documents and Settings\user\Application
Data\Autodesk Navisworks Freedom 2012 onde user é o nome do usuário
atual.

■ Application Data\Autodesk Navisworks Freedom 2012 dentro do perfil padrão
de todos os usuários. Por exemplo, C:\Documents and Settings\All
Users\Application Data\Autodesk Navisworks Freedom 2012.

■ No diretório de instalação do Autodesk Navisworks. Por exemplo,
C:\Arquivos de Programas\Autodesk Navisworks Freedom 2012.

OBSERVAÇÃO Se você estiver usando o Windows 7, então os caminhos do
diretório de pesquisa serão diferentes. Em vez de \Users\Application Data\Autodesk
Navisworks Freedom 2012, o caminho será \Users\AppData\Roaming\Autodesk
Navisworks Freedom 2012.

Dois diretórios adicionais, Site e Project, podem ser usados para compartilhar
várias definições de configuração com outros usuários. Quando você executa
o Autodesk Navisworks pela primeira vez, as configurações são obtidas no
diretório de instalação. Subsequentemente, o Autodesk Navisworks examina
o perfil do usuário atual e todos os perfis de usuário na máquina local e, em
seguida·verifica as configurações em Project Directory e em Site Directory. Os
arquivos no diretório Project têm precedência.

Consulte também:

Opções de localização na página 94

98 | Capítulo 3   Início rápido



Meta-alça
O Autodesk Navisworks fornece ferramentas com base em meta-alças para
interagir com objetos 3D. Os seguintes tipos de meta-alças são usados:
■ Transforme as meta-alças. Manipule globalmente a transformação dos

objetos (translação, rotação e escala) (como se tivessem sido alterados no
modelo original do CAD).

■ Meta-alça de animação. Manipule temporariamente a transformação dos
objetos para fins de animação.

■ Meta-alça de seccionamento. Manipule os planos de corte e a caixa de
seção.

Cada meta-alça exibe três eixos coloridos nos ângulos corretos relevantes a
posição atual da câmera. As meta-alças agem como objetos 3D pelo fato de
que o eixo rotaciona com o ponto de vista. No entanto, elas são colocadas
como subjacências no topo da cena 3D e podem ser obscurecidas pro outros
objetos. Ao passar o mouse sobre uma peça segurável da meta-alça, o cursor
é alterado para um ícone de mão  .

Meta-alça de escalaMeta-alça de rotaçãoMeta-alça de movimentação

Ao usar as meta-alças, é possível ajustar o snap para controlar a precisão das

operações (clique no botão do aplicativo de página  ➤ Options ➤ nó
Interface ➤ Snapping.
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Trabalhar com
arquivos

Utilizar leitores de arquivos

Arquivos NWD

Um arquivo NWD é um arquivo criado com a ferramenta de publicação do
Autodesk Navisworks e contém toda a geometria do modelo junto com as
marcações de revisão. Você pode considerar que um arquivo NWD é um
instantâneo do estado atual do modelo.

Os arquivos NWD são bem pequenos, já que eles comprimem os dados de CAD
em até 80% de seu tamanho original.

Arquivos DWF/DWFx

O DWF da Autodesk foi especificamente desenvolvido pela Autodesk como um
formato de arquivo para arquitetos, engenheiros e profissionais GIS, para
compartilhar dados de projeto 2D e 3D. Os arquivos DWF são altamente
compactados e retêm informações detalhadas de projeto e de escala. A versão
mais nova do formato de arquivo DWF, o DWFX, tem base na XML Paper
Specification (XPS) da Microsoft. Os arquivos DWFx podem ser abertos e
impressos instantaneamente com o uso do Microsoft XPS Viewer grátis, que
vem pré-instalado nos computadores que usam o sistema operacional Microsoft
Windows Vista®. (Para o sistema operacional Windows XP, o Microsoft XPS
Viewer pode ser baixado diretamente da Microsoft). Diferente dos arquivos
DWF, os arquivos DWFx incluem informações adicionais para exibir dados do

4
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projeto no Microsoft XPS Viewer. Como tal, os arquivos DWFx são maiores
do que os arquivos DWF correspondentes.

Entidades suportadas

■ Toda a geometria 3D

■ Mapas de textura

■ Coordenadas de textura

■ Cores (por vértice, por face)

■ Campos de propriedades

■ Categories

■ Linhas 2D/cortes de plotagem

■ Miniaturas (para arquivos de 2012 ou posteriores)

■ Propriedade da folha (para arquivos de 2012 ou posteriores)

■ Mais de um corte 3D por arquivo (suporte a arquivo de múltiplas folhas)

Entidades não suportadas

■ Croquis com revisões

■ Superfícies NURBS

■ Câmeras

Consulte também:

Opções do leitor de arquivos DWF

Gerenciar arquivos

Abrir arquivos

Para abrir arquivos no Autodesk Navisworks, você pode utilizar uma caixa de
diálogo padrão Open ou arrastar e soltar os arquivos diretamente na janela
Selection Tree.
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OBSERVAÇÃO Se o arquivo escolhido for um arquivo CAD ou de digitalização a
laser, o Autodesk Navisworks utilizará automaticamente um leitor de arquivo
apropriado para abrir o arquivo, desde que este formato de arquivo seja suportado.

O Autodesk Navisworks mantém uma lista dos arquivos abertos recentemente
(por padrão, até 4 arquivos são mostrados). É possível abrir qualquer um destes

arquivos clicando no botão do aplicativo  . Se deseja alterar o tamanho
desta lista, utilize Options Editor (nó General ➤ , página Environment).

Você pode utilizar as teclas Shift e Ctrl para abrir diversos arquivos ao mesmo
tempo. Isso cria automaticamente um novo arquivo “Untitled” do Autodesk
Navisworks com os arquivos anexados selecionados juntos.

Para arquivos NWD, é possível publicá-los em um servidor da Web, e a seguir
abrir os arquivos diretamente do Autodesk Navisworks. Você pode começar a
navegar no modelo, mesmo antes de todo o arquivo ter sido baixado. Para tal,
10 - 50% costuma ser suficiente. Quanto maior a hierarquia do modelo, mais
perto de 50% de download é necessário. De forma similar, quanto menor a
estrutura de hierarquia do modelo, mais cedo é possível iniciar a navegação.

OBSERVAÇÃO Arquivos criptografados DWF, como arquivos com senha e arquivos
protegidos contra impressão/medição não são suportados.

Para abrir um arquivo

1 Clique no botão do aplicativo  ➤  Open  ➤ Open  .

2 Na caixa de diálogo Open , utilize a caixa Files of Type , para selecionar
o tipo de arquivo apropriado, e navegue para a pasta onde está localizado
seu arquivo.

3 Selecione o arquivo e clique em Open.

Barra de ferramentas: Classic user interface: Standard ➤ Open
Entrada do comando: Ctrl+O

Para abrir arquivos NWD localizados em um servidor da web

1 Clique no botão do aplicativo  ➤ Open URL  .

2 Insira o endereço do arquivo e clique em OK.
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Criar arquivos

Ao iniciar o Autodesk Navisworks, um novo arquivo “Untitled” do Autodesk
Navisworks é criado automaticamente. O novo arquivo utiliza as configurações
padrão definidas no Options Editor, e na caixa de diálogo File Options.
Você pode personalizar estas configurações, se necessário.

Se um arquivo do Autodesk Navisworks já estiver aberto e desejar fechá-lo
para criar outro arquivo, clique em New  na barra de ferramentas Quick
Access.

Barra de ferramentas: Classic user interface: Standard ➤ New

Arquivos de múltiplas folhas e 2D

Agora é possível trabalhar com arquivos 2D e arquivos contendo múltiplos
modelos ou folhas.

Enquanto modelos multidisciplinares fornecem uma aparência real de como
um projeto acabado ficaria, diversos interessados no projeto e profissionais
de campo estão mais familiarizados com plantas e elevações 2D. O Autodesk
Navisworks Freedom 2012 suporta arquivos de múltiplas folhas e 2D que
podem ser revisados ou combinados com modelos para fornecer múltiplas
representações de dados do projeto.

Os formatos de arquivo de múltiplas folhas e 2D suportados são: DWF, DWF(x)
e NWD.

Quando você abre um arquivo suportado, que contém múltiplas
folhas/modelos, a folha/modelo padrão é exibida em Scene View e todas as
folhas/modelos do arquivo são listadas na janela Project Browser. Se o
arquivo contém modelos 3D e folhas 2D, o modelo 3D é carregado e exibido
em Scene View por padrão. Se não precisar de recursos 2D, apenas feche a
janela Project Browser e continue trabalhando em um espaço de trabalho
3D.

Janela do navegador de projeto

O Project Browser é uma janela encaixável que lista todos os modelos/folhas
no arquivo aberto atualmente.
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A paleta Sheets/Models lista todas as folhas e os modelos no arquivo de
múltiplas folhas. A legenda na parte superior da paleta indica o arquivo aberto
no momento no Autodesk Navisworks. As folhas ou os modelos podem ser
representados como uma visualização de lista ou uma visualização de
miniaturas. Por padrão, a ordem de exibição é a mesma do arquivo original.
O modelo/folha selecionado no momento é indicado com um plano de fundo
sombreado e o modelo/folha aberto atualmente na Scene View é indicado
em preto com uma borda gráfica preta. Quando você abre um arquivo de
múltiplas folhas, nem todos os modelos/folhas podem ter sido preparados
para serem utilizados no Autodesk Navisworks. Os modelos/folhas que
requerem preparação são indicados com o ícone Prepare  .

É possível selecionar vários modelos/folhas ao mesmo tempo com as teclas
SHIFT e CTRL, mas não é possível abrir mais de um modelo/folha na Scene
View.

A paleta Properties é utilizada para examinar as propriedades do modelo/folha
selecionado na paleta Sheets/Models. Você também pode visualizar as
propriedades do arquivo aberto atualmente ao clicar em seu nome. As
propriedades são agrupadas por categoria, são de somente leitura e podem ser
expandidas/retraídas.
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OBSERVAÇÃO  Se mais de uma folha ou um modelo estiver selecionado, a paleta
Properties somente mostra o número de itens selecionados e não mostra
nenhuma informação da propriedade.

Para alternar a janela do navegador de projeto

■ Clique na guia View painel  ➤ Workspace menu suspenso  ➤ Windows
e selecione ou desmarque a caixa de seleção Project Browser.

Dispositivo apontador: Barra de status  ➤ Project Browser

Para visualizar folhas/modelos como uma lista

■ Clique no botão List View  situado no canto superior direito da janela
Project Browser.

Para visualizar modelos/folhas como miniaturas

■ Clique no botão Thumbnail View  no canto superior direito da janela
Project Browser.

Para examinar propriedades da falha/do modelo

1 Abra um arquivo de múltiplas folhas.

2 Clique na folha 2D ou no modelo 3D no Project Browser. A paleta
Properties mostra as informações disponíveis.

OBSERVAÇÃO Se mais de uma folha/um modelo for selecionado, a paleta
Properties somente mostra o número de folhas/modelos selecionados e
não mostra nenhuma informação da propriedade.

Para abrir uma folha ou um modelo na Scene View

1 Abra a janela Project Browser.

2 Clique duas vezes na folha ou no modelo que deseja abrir.

DICA Você também pode usar os controles de navegação de múltiplas folhas na
barra de status para abrir as folhas/os modelos rapidamente.

Para preparar uma folha/um modelo para uso

1 Abra a janela Project Browser.
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2 Clique com o botão direito do mouse na folha ou no modelo que deseja
preparar e clique em Prepare Sheet/Model no menu de atalho.

Para preparar todos os modelos/folhas para uso

1 Abra a janela Project Browser.

2 Clique com o botão direito do mouse na folha ou no modelo que deseja
preparar e clique em Prepare All Sheets/Models no menu de atalho.

Para imprimir uma folha ou um modelo

OBSERVAÇÃO Somente é possível imprimir o ponto de vista atual.

1 Abra a janela Project Browser.

2 Clique duas vezes na folha ou no modelo que deseja imprimir para
torná-lo atual (isto é, aberto na Scene View).

3 Clique na guia Output painel  ➤ Print ➤ Print  .

4 Verifique as configurações necessárias da impressora e clique em OK.

OBSERVAÇÃO O tamanho máximo da imagem é de 2048x2048 pixels.

O botão Properties controla as configurações de tinta e papel específicas
da impressora.

Menu de atalho da paleta de folhas/modelos

Abrir Abre a folha/o modelo selecionado na Scene View.

Prepare Sheet/Model Prepara todos os modelos/folhas selecionados na lista
para uso no Autodesk Navisworks. Para selecionar múltiplos modelos/folhas,
utilize as teclas SHIFT e CTRL. Se os modelos/folhas estiverem prontos, esta
opção não estará disponível.

Prepare All Sheets/Models Prepara todoa os modelos/folhas selecionados no
arquivo de múltiplas folhas para uso no Autodesk Navisworks. Se os
modelos/folhas estiverem prontos para uso, esta opção não estará disponível.

Imprimir Imprime a folha ou o modelo aberto atualmente na Scene View.

Botões

Thumbnail View Exibe folhas/modelos como imagens em miniatura na
paleta Sheets/Models.
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List View Exibe folhas/modelos como itens da lista na paleta Sheets/Models.
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Explorar seu modelo

Navegar em uma cena
No Autodesk Navisworks, você tem um variedade de opções para navegar na
cena.

Você pode manipular sua posição diretamente na Scene View com as
ferramentas de navegação da barra de navegação, como o Pan e o Zoom. Também
é possível usar os StreeringWheels® que acompanham o cursor e economizar
tempo ao combinar muitas das ferramentas de navegação comuns em uma única
interface.

É possível usar o ViewCube®, uma ferramenta de navegação 3D que permite
reorientar a vista de um modelo ao clicar em áreas predefinidas no cubo. Por
exemplo, ao clicar na frente do ViewCube gira a vista até que a câmera esteja
faceando a frente da cena. Você também pode clicar no ViewCube e arrastá-lo
para rotacionar livremente a vista. O ViewCube não está disponível em um
espaço de trabalho 2D.

DICA Utilize um mouse 3D 3Dconnexion como alternativa ao mouse para navegar
e alterar a orientação de seu modelo em um espaço de trabalho 3D. Há um modo
2D que você pode usar para navegar em um espaço de trabalho 2D.

Quando você navega em um modelo 3D, é possível utilizar as ferramentas de
realismo na guia Viewpoint painel  ➤ Navigate para controlar a velocidade
e o realismo de sua navegação. Portanto, por exemplo, você pode descer as
escadas ou seguir o terreno, agachar sob os objetos, utilizar um avatar para
representar a si próprio no modelo 3D. As ferramentas de realismo não estão
disponíveis em uma área de trabalho 2D.
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Efetuar a animação da navegação

Quando você navega no Autodesk Navisworks, poderá gravar animações de
pontos de vista e a seguir reproduzi-las. Para mais informações, consulte Play
Back Animations na página 259.

orientação no espaço de trabalho 3D

Embora o Autodesk Navisworks utilize o sistema de coordenadas X, Y, Z, não
há nenhuma regra direta e rápida mostrando para qual direção esses eixos
estão realmente “apontando”.

O Autodesk Navisworks lê os dados necessários para mapear qual a direção é
"para cima" e qual é "norte", diretamente dos arquivos carregados na cena.
Caso isto não seja possível, por padrão, Z é entendido como "para cima" e Y
como "norte".

É possível alterar as direções "para cima" e "norte" no modelo inteiro (orientação
mundial), e a direção "para cima" para o ponto de vista atual (vetor para cima
do ponto de vista).

OBSERVAÇÃO A alteração do vetor para cima do ponto de visão afeta os modos
de navegação que dependem da direção "para cima" do ponto de visão atual, tais
como Walk, Constrained Orbit e Orbit. Isto também tem impacto nas vistas
de corte.

Para alinhar o vetor acima do ponto de vista na vista atual

■ Em Scene View, pressione com o botão direito do mouse e clique em
Viewpoint ➤ Set Viewpoint Up ➤ Set Up no menu de atalho.

Para alinhar o vetor acima do ponto de vista para um dos eixos predefinidos

1 EmScene View, pressione com o botão direito do mouse e clique em
Viewpoint ➤  Set Viewpoint Up.

2 Clique em um dos eixos predefinidos. Escolha entre:
■ Set Up + X

■ Set Up - X

■ Set Up + Y

■ Set Up - Y

■ Set Up + Z
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■ Set Up -Z

Para alterar a orientação universal

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Orientation , insira os valores
necessários para ajustar a orientação do modelo.

3 Clique em OK.

Ferramentas de navegação específicas do
produto

A barra de navegação e os·SteeringWheels fornecem acesso a um conjunto de
ferramentas de navegação específicas do produto em espaços de trabalho 2D
e 3D.
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No Autodesk Navisworks Freedom 2012, algumas ferramentas de navegação
clássicas foram substituídas por novas ferramentas de navegação. Consulte a
tabela abaixo para obter mais detalhes.

Pode ser
substituída de
volta para a
clássica?

2D?Substituída porFerramenta clássica

NãoSimPanPan

NãoSimZoomZoom

NãoSimZoom AllView All

NãoSimZoom SelectedView Selected

NãoSimZoom WindowZoom Box

SimNãoOrbitOrbit

SimNãoFree OrbitExamine

SimNãoConstrained OrbitTurntable

NãoNãoLookLook Around

---Focus

SimNãoWalkWalk

-Não-Fly

Personalizando o comportamento das ferramentas

Para a barra de navegação, pode-se usar Options Editor para alternar entre
os modos padrão e clássico para as ferramentas Órbita e Navegar.
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Controlar o realismo da navegação

É possível utilizar Collision na página 187, Gravity na página 186, Crouch na
página 187 e Third Person View na página 189 para aprimorar sua experiência
de navegação em um espaço de trabalho 3D.

DICA Use a combinação de Collision, Gravity, e Crouch com a ferramenta
Navegar. Isto permite, por exemplo, subir e descer escadas e andar sob objetos
baixos.

Ferramentas da barra de navegação

A barra de navegação contém um conjunto de ferramentas de navegação
específicas do produto.

Ferramenta Pan

A ferramenta de panorâmica move a vista paralela à tela.

A ferramenta é ativada ao clicar em Pan  na barra de navegação. A
ferramenta Pan se comporta da mesma forma que a ferramenta pan disponível
nos SteeringWheels.

Ferramentas de Zoom

Conjunto de ferramentas de navegação para aumentar ou diminuir a ampliação
da vista atual do modelo.

As seguintes ferramentas de zoom estão disponíveis:

■ Janela de Zoom  . Permite desenhar uma caixa e ampliar o zoom
para aquela área.

■ Zoom  . Zoom de clicar/arrastar padrão.

■ Zoom Selected  . Amplia/afasta o zoom para mostrar a geometria
selecionada.

■ Zoom All  . Afasta o zoom para mostrar toda a cena.
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Zoom Window

A ferramenta é ativada ao clicar na opção Janela de zoom no menu suspenso
Zoom na barra de navegação. Esta se comporta da mesma forma que o modo
clássico Zoom Box.

Zoom

A ferramenta é ativada ao clicar em Zoom no menu suspenso Zoom na barra
de navegação. Esta se comporta da mesma forma que a ferramenta Zoom
disponível nos SteeringWheels.

Zoom Selected

A ferramenta é ativada ao clicar em Zoom Selected no menu suspenso Zoom
na barra de navegação. Outra alternativa é clicar na guia Item Tools ➤ painel

Look At ➤ Zoom  na faixa de opções. Esta se comporta da mesma forma
que a ferramenta clássica View Selected.

Zoom All

A ferramenta é ativada ao clicar em Zoom All no menu suspenso Zoom na
barra de navegação. Esta se comporta da mesma forma que a ferramenta clássica
View All.

Ferramentas Orbit

Conjunto de ferramentas de navegação para rotacionar o modelo em torno
de um ponto de giro enquanto a vista permanece fixa. Essas ferramentas não
estão disponíveis em um espaço de trabalho 2D.

As seguintes ferramentas de órbita estão disponíveis:

■ Órbita  . Move a câmera ao redor do ponto focal do modelo. A direção
em pé é sempre mantida, e nenhuma rolagem de câmera é possível.

■ Órbita livre  . Rotaciona o modelo ao redor do ponto focal em
qualquer direção.

■ Órbita restringida  . Gira o modelo ao redor do vetor vertical, como
se o modelo estivesse em um prato giratório. A direção vertical é sempre
mantida.
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Orbit

A ferramenta é ativada ao clicar em Órbita no menu suspenso Órbita na
barra de navegação. Esta se comporta da mesma forma que a ferramenta Órbita
disponível nos SteeringWheels. É possível usar o comando Options Editor
para voltar ao modo clássico Órbita.

Free Orbit

A ferramenta é ativada ao clicar em Órbita livre no menu suspenso Órbita
na barra de navegação. Esta se comporta de forma similar ao modo clássico
Examine. É possível usar o comando Options Editor para voltar ao modo
clássico Examine.

Constrained Orbit

A ferramenta é ativada ao clicar em Órbita restringida no menu suspenso
Órbita na barra de navegação. Esta se comporta de maneira similar ao modo
clássico Turntable. É possível usar o comando Options Editor para voltar
ao modo clássico Turntable.

Para usar a ferramenta clássica Órbita com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.

2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Orbit na área Orbit Tools.

3 Clique em OK.

Para usar a ferramenta clássica Examine com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.

2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Free Orbit (Examine) na área
Orbit Tools.

3 Clique em OK.

Para usar a ferramenta clássica Turntable com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.
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2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Constrained Orbit
(Turntable) na área the Orbit Tools.

3 Clique em OK.

Ferramentas Look

Conjunto de ferramentas para rotacionar a vista atual verticalmente e
horizontalmente. Essas ferramentas não estão disponíveis em uma área de
trabalho 2D.

As seguintes ferramentas de olhar estão disponíveis:

■ Look Around  . Olha ao redor da cena da localização atual da câmera.

■ Look At  . Olha para um ponto em particular na cena. A câmera move
para se alinha com aquele ponto.

■ Focus  . Olha para um ponto em particular na cena. A câmera
permanece onde está.

Look Around

A ferramenta é ativada ao clicar em Vista panorâmica no menu suspenso
Olhar na barra de navegação. Esta se comporta da mesma forma que a
ferramenta Olhar disponível nos SteeringWheels.

Examinar em

A ferramenta é ativada ao clicar em Examinar no menu suspenso Olhar na
barra de navegação. Esta se comporta da mesma forma que a ferramenta do
SteeringWheels Olhar ao manter pressionada a tecla SHIFT.

Focus

A ferramenta é ativada ao clicar em Focus no menu suspenso Look na barra
de navegação. Consulte Foco na página 185 para obter mais detalhes.
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Ferramentas Walk e Fly

Conjunto de ferramentas de navegação para mover ao redor do modelo e
controlar as configurações de realismo. Essas ferramentas não estão disponíveis
em uma área de trabalho 2D.

As seguintes ferramentas estão disponíveis:

■ Navegar  . Move através de um modelo como se você estivesse andando
por ele.

■ Fly  . Move através de um modelo como em um simulador de vôo.

Walk

A ferramenta é ativada ao clicar em Navegar no menu suspenso Olhar/Fly
na barra de navegação. Por padrão, a ferramenta se comporta como a
ferramenta Navegar no SteeringWheels. É possível personalizar as opções de
ferramentas no Options Editor. Também é possível voltar para o modo
clássico Walk.

Fly

A ferramenta é ativada ao clicar em Fly no menu suspenso Navegar/Fly na
barra de navegação. Esta se comporta da mesma forma que o modo clássico
Fly.

Consulte também:

Controlar o realismo de sua navegação na página 186

Para usar a ferramenta Walk clássica com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.

2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Walk na área Walk Tool.

3 Clique em OK.
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Ferramentas SteeringWheels

Cada círculo é dividido em diferentes seções. Cada setor contém uma
ferramenta de navegação que pode ser usada para reorientar a vista atual de
um modelo. Quais ferramentas de navegação que estão disponíveis depende
de qual círculo está ativo.

Ferramenta Centro

Com a ferramenta Centro é possível definir o centro da vista atual de um
modelo. Para definir o centro, arraste o cursor sobre seu modelo. Uma esfera
(ponto de giro) é exibida além do cursor. A esfera indica que o ponto abaixo
do cursor no modelo será o centro da vista atual quando você soltar o botão
do mouse. O modelo é centralizado na esfera.

OBSERVAÇÃO Se o cursor não está sobre o modelo, o centro não pode ser definido
e um cursor de proibição é exibido.

O ponto definido pela ferramenta Centro fornece um ponto focal para a
ferramenta Zoom e um ponto de giro para a ferramenta Órbita

OBSERVAÇÃO Se você deseja efetuar o zoom a partir dos círculos de navegação
completa de seu ponto central definido, mantenha pressionado Ctrl antes de
efetuar o zoom.

Para especificar um ponto em um modelo como o centro de uma vista

1 Exiba um dos círculos Navegação completa ou o círculo grande
Visualização de objetos.

2 Clique e arraste para baixo o setor Centro.
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3 Arraste o cursor para a localização desejada do modelo.

4 Solte o botão no seu dispositivo apontador quando a esfera for exibida.

É efetuada a panorâmica no modelo até que a esfera esteja centralizada.

Para especificar o ponto alvo para as ferramentas Zoom e Órbita.

1 Exiba um dos círculos Navegação completa ou o círculo grande
Visualização de objetos.

2 Clique e arraste para baixo o setor Centro.

3 Arraste o cursor sobre a localização desejada do modelo.

4 Solte o botão no seu dispositivo apontador quando a esfera for exibida.

É efetuada a panorâmica no modelo até que a esfera esteja centralizada.

5 Utilize as ferramentas Zoom ou Órbita para reorientar a vista do modelo.

Se estiver utilizando um dos círculos Navegação completa, pressione a
tecla Ctrl antes de utilizar a ferramenta Zoom.

Ferramenta Avançar

A ferramenta Avançar é utilizada para alterar a ampliação do modelo ao
aumentar ou diminuir a distância entre o ponto atual da vista e o ponto de
giro. A distância na qual é possível mover adiante ou para atrás é limitada pela
posição do ponto de giro.

OBSERVAÇÃO Em vistas ortogonais, a ferramenta Adiante está limitada à distância
entre a posição atual e o ponto de giro. Em vistas em perspectiva, ela não está
limitada. Sendo assim, é possível mover o cursor através do ponto de giro.
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Para ajustar a distância entre o ponto atual da vista e o ponto de giro, utilize
o indicador Distância de arraste. O indicador Distância de arraste possui duas
marcas que mostram a distância inicial e de destino do ponto atual da vista.
A distância percorrida atual é exibida pelo indicador de posição laranja. Deslize
o indicador para frente ou para trás para diminuir ou aumentar a distância do
ponto de giro.

Para reorientar uma vista ao avançar ou retroceder de um modelo

1 Exiba o círculo grande Tour do edifício.

2 Clique e arraste para baixo o setor Avançar.

O indicador Distância de arraste é exibido.

OBSERVAÇÃO Se clicar um vez no setor Avançar, o modelo move adiante
50% da distância entre a localização atual e o ponto de giro.

3 Arraste o cursor para cima ou para baixo para alterar a distância da qual
se observa o modelo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Olhar

Com a ferramenta Olhar, é possível rotacionar a vista atual na vertical e na
horizontal. Ao rotacionar a vista, a sua linha de visão gira em torno da posição
atual do olho, como se virasse a sua cabeça. A ferramenta Olhar pode ser
comparada a você parado em uma posição fixa, olhando para cima ou para
baixo enquanto vira a sua cabeça para esquerda ou direita.

Ao usar a ferramenta Olhar, a vista do modelo é ajustada ao se arrastar o cursor.
Quando você arrasta, o cursor muda para o cursor Olhar e o modelo gira em
torno da localização da vista atual.
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Além de usar a ferramenta Olhar para olhar ao redor de um modelo, também
é possível utilizar a ferramenta para fazer a panorâmica na vista atual para
uma face especifica no modelo. Mantenha pressionada a tecla Shift antes de
selecionar a ferramenta Olhar em um dos círculos Navegação completa.

Navegar através de um modelo

Ao usar a ferramenta Olhara partir do grande círculoNavegação completa,
é possível andar pelo modelo usando as teclas de setas no teclado. Para ajustar
a velocidade de navegação, utilize o Options Editor.

Inverter eixo vertical

Quando se arrasta o cursor para cima, o ponto alvo da vista se eleva; arrastando
o cursor para baixo abaixa o ponto alvo da vista. Para inverter o eixo vertical
para a ferramenta Olhar use o Options Editor.

Para olhar ao redor de uma vista com a ferramenta Olhar

1 Exiba um dos círculos de navegação completa ou o minicírculo de tour
do edifício.

2 Clique e arraste para baixo o setor Olhar.

O cursor muda para o cursor Olhar.

3 Arraste o dispositivo apontador para alterar a direção na qual você está
olhando.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para olhar para uma face no modelo com a ferramenta Olhar

1 Exiba um dos círculos Navegação completa.

2 Pressione segure a tecla Shift.

3 Clique e arraste para baixo o setor Olhar.

O cursor muda para o cursor Olhar para.

4 Arraste sobre os objetos no modelo até que a face realçada seja a que
você deseja olhar.

5 Solte o botão do dispositivo apontador para retornar para o círculo.

Para olhar ao redor e navegar através de um modelo com a ferramenta Olhar.

1 Exiba a círculo grande Navegação completa.

2 Clique e arraste para baixo o setor Olhar.
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O cursor muda para o cursor Olhar.

3 Arraste para alterar a direção na qual você está olhando.

4 Mantendo pressionado o botão no dispositivo apontador, pressione as
teclas de seta para navegar no modelo.

5 Solte o botão do dispositivo apontador para retornar para o círculo.

6 Clique em Fechar para sair do círculo.

Para inverter o eixo vertical para a ferramenta Look

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Invert Vertical Axis na área Look Tool.

Arrastando para baixo ou para cima, abaixa ou aumenta o ponto alvo
da vista atual.

4 Clique em OK.

Ferramenta Órbita

É possível usar a ferramenta Órbita para alterar a orientação de um modelo.
O cursor muda para o cursor Órbita. Quando o cursor é arrastado, o modelo
rotaciona em torno do ponto de pivô enquanto a vista permanece fixa.
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Especificar o ponto de pivô

O ponto de pivô é o ponto base usado ao rotacionar o modelo com a
ferramenta Órbita. É possível especificar o ponto de pivô nas seguintes formas:

■ Ponto de pivô padrão. Ao abrir o modelo pela primeira vez, o ponto
alvo da vista atual é usado como o ponto de pivô para orbitar no modelo.

■ Selecionar objetos. É possível selecionar objetos antes da ferramenta
Órbita ser utilizada para calcular o ponto de giro. O ponto de pivô é
calculado com base no centro das extensões dos objetos selecionados.

■ Ferramenta Centralizar. É possível especificar um ponto no modelo
para ser usado como o ponto de pivô ao orbitar com a ferramenta
Centralizar na página 118.

■ CTRL+Clique e arraste. Mantenha pressionada a tecla Ctrl antes de
clicar no setor Órbita ou enquanto a ferramenta Órbita está ativa, e arraste
para o ponto do modelo que você deseja como o ponto de giro. Esta opção
somente está disponível ao utilizar os círculos de navegação completa
grande e mini ou o minicírculo de visualização de objeto.

OBSERVAÇÃO Enquanto a ferramenta Órbita está ativa, é possível manter
pressionada a tecla Ctrl a qualquer momento para mover o ponto de giro
utilizado pela ferramenta Órbita. Este ponto de giro é usado para a navegação
subsequente até ele ser movido.

Manter a direção para cima

Pode-se controlar como o modelo orbita em torno do ponto de giro ao escolher
manter a direção do modelo para cima. Quando a direção para cima é mantida,
a órbita é restrita ao longo dos eixos XY e na direção Z. Se você arrastar na
horizontal, a câmera se moverá em paralelo ao plano XY. Se arrastar na vertical,
a câmera se moverá ao longo do eixo Z.

Se a direção para cima não for mantida, é possível rolar o modelo utilizando
a anel de rolagem que está centralizado em torno do ponto de giro. Utilize a
caixa de diálogo Propriedades dos SteeringWheels para controlar se a direção
para cima é mantida ou não para a ferramenta Órbita.
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Para orbitar um modelo com a ferramenta Órbita

1 Exiba um dos círculos Visualização de objetos ou Navegação completa.

2 Clique e pressione o setor Órbita.

O cursor muda para o cursor Órbita.

3 Arraste para girar o modelo.

OBSERVAÇÃO Utilize a ferramenta Centro para recentralizar o modelo na
vista atual, se você está utilizando um dos círculos Navegação completa ou
Visualização de objetos.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para orbitar em volta de um objeto com a ferramenta Órbita.

1 Pressione Esc para assegurar-se de que nenhum comando esteja ativo e
para limpar quaisquer objetos previamente selecionados.

2 Selecione os objetos no modelo para os quais deseja definir o ponto de
giro.

3 Exiba um dos círculos Visualização de objetos ou Navegação completa.

4 Clique e pressione o setor Órbita.

O cursor muda para o cursor Órbita.

5 Arraste para girar o modelo.

6 Solte o botão do dispositivo apontador para retornar para o círculo.
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Para ativar a sensibilidade da ferramenta Orbit

1 Mostre um dos círculos Visualizar objeto ou Navegação completa.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Center Pivot on Selection na seção Orbit
Tool.

4 Clique em OK.

As extensões de quaisquer objetos que estão selecionados antes do círculo
ser exibido são usados para definir o ponto de giro para a ferramenta
Orbit. Se nenhum objeto está selecionado, o ponto de giro usado pela
ferramenta Orbit é o definido pela ferramenta Center.

Para manter a direção acima para a ferramenta Orbit

1 Mostre o mini círculo Visualizar objeto ou um dos círculos Navegação
completa.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Keep Scene Upright na área Orbit Tool.

4 Clique em OK.

A órbita no modelo é restrita ao longo do plano XY e a direção Z.

Para rolar o modelo ao redor do ponto de giro com a ferramenta Orbit.

1 Mostre o mini círculo Visualizar objeto ou um dos círculos Navegação
completa.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, na página SteeringWheels sob o nó Interface
, desmarque a caixa de seleção Keep Scene Upright.

4 Clique em OK.

5 Clique e pressione o setor Órbita.

O cursor muda para o cursor Órbita.

6 Mantenha pressionada a tecla Shift para exibir o anel de rolagem.
Arraste para rolar o modelo.

7 Solte o botão do dispositivo apontador para retornar para o círculo.
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Para iniciar a ferramenta Órbita com o botão do meio do mouse

1 Exiba um dos círculos diferente do círculos grandes Visualização de
objetos ou Tour do edifício.

2 Mantenha pressionada a tecla Shift.

3 Mantenha pressionada a roda de rolagem ou o botão do meio em seu
dispositivo apontador a arraste para orbitar o modelo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Pan

Quando a ferramenta Pan está ativa, o cursor Pan (uma seta com quatro pontas)
é exibido. Arrastar o dispositivo apontador move o modelo na mesma direção.
Por exemplo, arrastar para acima move o modelo para cima, enquanto arrastar
para baixo move o modelo para baixo.

DICA Se o cursor alcançar a borda da tela, pode-se continuar a efetuar a
panorâmica ao arrastar o cursor para forçá-lo a envolver a tela.

Para efetuar uma panorâmica na vista com a ferramenta Pan

1 Mostre um dos círculos Navegação completa, ou o mini círculo
Visualizar objeto.

2 Mantenha pressionado o setor Pan.

O cursor é alterado para o cursor Pan.

3 Arraste para reposicionar o modelo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.
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Para iniciar a ferramenta Pan com o botão do meio do mouse

1 Mostre um dos círculos Navegação completa, ou o mini círculo
Visualizar objeto.

2 Mantenha pressionada a roda de rolagem ou o botão do meio do mouse.

O cursor é alterado para o cursor Pan.

3 Arraste para reposicionar o modelo.

4 Libere a roda ou botão no dispositivo apontador para retornar para o
círculo.

Ferramenta Rebobinar

Conforme as ferramentas de navegação são utilizadas para reorientar a vista
de um modelo, a vista anterior é salva para o histórico de navegação. O
histórico de navegação armazena uma representação das vistas anteriores do
modelo junto com uma miniatura. Um histórico de navegação separado é
mantido para cada janela, mas não é mantido após a janela ser fechada. O
histórico de navegação de Rebobinar é específico da vista.

Com a ferramenta Rebobinar, é possível recuperar as vistas anteriores do
histórico de navegação. A partir do histórico de navegação é possível restaurar
uma vista anterior ou navegar através de todas as vistas salvas.

OBSERVAÇÃO  Quando você rebobina e grava um novo histórico de navegação,
as vistas rebobinadas são substituídas por novas vistas. O histórico de navegação
não é salvo entre sessões.
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Para restaurar a vista anterior

1 Exiba um círculo.

2 Clique no setor Rebobinar.

Para restaurar uma vista anterior com o painel Rebobinar histórico

1 Exiba um círculo.

2 Clique e pressione o setor Rebobinar.

O painel Rebobinar histórico é exibido.

3 Mantendo pressionado o botão do dispositivo apontador, arraste para a
esquerda ou para a direita para restaurar uma vista anterior.

Arrastando para a esquerda restaura-se uma vista anterior mais antiga.
Arrastando para a direita restaura a vista que seja mais nova do que a
que você está no momento visualizando É preciso ter utilizado
anteriormente a ferramenta Rebobinar para visualizar as vistas que estão
disponíveis na direita. A posição atual do histórico de navegação é
indicada pela caixa laranja que é arrastada ao longo do painel Histórico
rebobinar.

Ferramenta Para cima/Para baixo

Diferente da ferramenta Pan, a ferramenta Acima/Abaixo é usada para ajustar
a altura do ponto de vista atual ao longo do eixo Z do modelo. Para ajustar a
elevação vertical da vista atual, arraste para cima ou para baixo. Quando se
arrasta, a elevação atual e a faixa permitida do movimento são exibidas em
um elemento gráfico de indicador denominado como Distância vertical.

O indicador Distância vertical tem duas marcas que mostram a elevação mais
alta (Superior) e mais baixa (Inferior) que a vista pode ter. Ao alterar a elevação
com o indicador Distância vertical, a elevação atual é mostrada pelo indicador
laranja brilhante, enquanto a elevação anterior é mostrada pelo indicador
laranja esmaecido.
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Para alterar a elevação de uma vista

1 Exiba um dos círculos Navegação completa ou Tour do edifício.

2 Clique e pressione o setor Acima/Abaixo.

O indicador Distância vertical é exibido.

3 Arraste para cima ou para baixo para alterar a elevação da vista.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Navegar

Com a ferramenta Navegar é possível navegar através de um modelo como se
estivesse andando nele. Iniciada a ferramenta Navegar, o ícone Círculo central
é exibido perto da base da vista e o cursor muda para exibir uma série de setas.
Para navegar através do modelo, arraste na direção que deseja mover.
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Constrain the Walk Angle

Ao navegar através de uma modelo, pode-se restringir o ângulo do movimento
para o vetor acima. Se a opção Constrain Walk Angle estiver ativada, é
possível navegar livremente, enquanto mantém uma elevação de ponto de
vista da câmera constante. Se o ângulo de navegação não for restrito, você irá
"voar" na direção em que está olhando. Use o Options Editorpara restringir
o ângulo de movimento ao vetor mundial para cima para a ferramenta
Navegar.

Usar velocidade linear do ponto de visão

Por padrão, a velocidade de navegação linear nos pontos de visão está
diretamente relacionada ao tamanho do seu modelo. Você pode definir uma
velocidade de movimento específica para todos os pontos de vista (Options
Editor ➤ Interface ➤ Viewpoint Defaults) ou para o ponto de vista atual
(guia Viewpoint ➤ painel Save, Load & Playback ➤ Edit Current
Viewpoint). Use oOptions Editor para fazer as configurações Usar
velocidade linear do ponto de visão da ferramentaNavegar.

Velocidade do movimento

Quando você "voa" através de um modelo pode controlar a velocidade do
movimento. A velocidade do movimento é controlada pela distância na qual
o cursor é movido do ícone Center Circle e pela configuração de velocidade
de movimento atual. É possível ajustar a velocidade do movimento definindo-a
como permanente ou temporária, conforme for utilizando a ferramenta
Navegar. Para ajustar permanentemente a velocidade do movimento, use o
Options Editor ou as teclas < e > quando a ferramenta Navegar estiver
ativa. Para aumentar permanentemente a velocidade do movimento, mantenha
pressionada a tecla + (mais) enquanto estiver usando a ferramenta Navegar.

Alterar a elevação

Quando a ferramenta Navegar é usada, pode-se ajustar a elevação da vista ao
manter pressionada a tecla Shift . Isto ativa temporariamente a ferramenta
Acima/Abaixo. Com a ferramenta Acima/Abaixo ativa, arraste para cima ou
para baixo para ajustar a elevação da câmera. Também é possível utilizar as
teclas Para cima e Para baixo enquanto se navega para ajustar a altura da
vista.
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Para usar a ferramenta Navegar para mover através do modelo

1 Exiba um dos círculos Navegação completa ou o minicírculo Tour do
edifício.

2 Clique e pressione o setor (Rebobinar).

O cursor é alterado para o cursor Navegar e o ícone Círculo central é
exibido.

3 Arraste na direção que deseja navegar.

OBSERVAÇÃO Enquanto navega, pressione e segure a tecla + (mais) para
aumentar temporariamente a sua velocidade de movimento.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para alterar a velocidade do movimento para a ferramenta Walk

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface, use
o deslizador Walk Speed na área Walk Tool.

Arrastar o deslizador para a esquerda diminui a velocidade da navegação.
arrastar para a direita aumenta a velocidade de navegação.

4 Clique em OK.

Para restringir a ferramenta Walk para o vetor acima

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Constrain Walk Angle na área Walk
Tool.

4 Clique em OK.

O movimento ao navegar é feito em paralelo ao universo acima do
modelo.

Para fazer com que a ferramenta Walk use a velocidade linear do ponto de
vista

1 Exiba um círculo.
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2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Usar velocidade linear para o ponto
de visão na área ferramenta Navegar.

4 Clique em OK.

Para ajustar a altura da vista atual da ferramenta Navegar

1 Exiba um dos círculos Navegação completa ou o minicírculo Tour do
edifício.

2 Clique e pressione o setor (Rebobinar).

O cursor é alterado para o cursor Navegar e o ícone Círculo central é
exibido.

3 Efetue um dos seguintes procedimentos:
■ Mantenha pressionada a tecla Shift para ativar a ferramenta Para

cima/Para baixo e arraste para cima ou para baixo.

■ Mantenha pressionada a tecla Para cima ou Para baixo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Zoom

É possível utilizar a ferramenta Zoom para alterar a ampliação do zoom de
um modelo.

OBSERVAÇÃO Ao iniciar a ferramenta Zoom do círculo Navegação completa,
o aumento incremental do zoom deve estar ativado no Options Editor para que
seja possível usar o comandoCTRL + clique e SHIFT + clique.
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Restrições do zoom

Ao alterar a ampliação de um modelo com a ferramenta Zoom, não é possível
aumentar o zoom além do ponto de foco ou além das extensões do modelo.
A direção na qual se poderá aproximar ou afastar o zoom é controlada pelo
ponto central definido pela ferramenta Centro.

OBSERVAÇÃO Diferente da ferramenta Zoom no círculo grande Visualização de
objetos, a ferramenta Zoom no minicírculo Visualização de objetos e nos círculos
Navegação completa não é restrita.

Para efetuar o zoom na vista com um único clique

Observação: É necessário que o aumento incremental do zoom esteja ativado
ao usar os círculos Full Navigation ou um minicírculo View Object. Para
o grande círculo Visualizar objeto, o aumento incremental do zoom está
sempre ativado.

1 Faça o seguinte para assegurar que a opção Enable Single-Click
Incremental Zoom-In seja selecionada:

1 Mostre o círculo Navegação completa.

2 Clique com o botão direito do mouse no círculo e clique em Opções
do SteeringWheel.

3 No Options Editor, página SteeringWheelssob o nó Interface,
selecione a caixa de seleção Enable Single-Click Incremental
Zoom-In na área Zoom Tool.

4 Clique em OK.

2 Mostre um círculo que tenha a ferramenta Zoom.

3 Clique no círculo Zoom.

A ampliação do modelo é aumentada quando se aproxima o zoom do
modelo. Se você mantiver pressionada a tecla Shift enquanto clica o setor
Zoom, o modelo terá o zoom diminuído; também é possível manter
pressionada a tecla Ctrl para aumentar o zoom.

Para aproximar e afastar o zoom ao arrastar

1 Mostre um dos círculos Navegação completa, ou um dos círculos
Visualizar objeto.

2 Clique e pressione o setor Zoom.

O cursor muda para o cursor Zoom.
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3 Arraste na vertical para aproximar ou afastar o zoom.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para ampliar o zoom em uma área do modelo ao especificar uma janela

1 Exiba um dos círculos de navegação completa ou o minicírculo de
visualização de objeto.

2 Mantenha pressionada a tecla Shift.

3 Clique e pressione o setor Zoom.

O cursor muda para o cursor Zoom.

4 Arraste o dispositivo apontador para definir o canto oposto da janela
que define a área na qual deseja aplicar o zoom.

OBSERVAÇÃO Ao manter pressionada a tecla Ctrl enquanto define o
segundo ponto da janela, determina se o primeiro ponto da janela é usado
como o canto ou centro da janela sendo arrastada. Quando a tecla Ctrl é
mantida pressionada, o primeiro ponto define o centro da janela.

5 Solte o botão do dispositivo apontador para retornar para o círculo.

Para aumentar ou diminuir o zoom ao rolar a roda do mouse quando os
SteeringWheels são exibidos

1 Exiba um dos círculos que não seja o círculo Tour do edifício.

2 Mova a roda do mouse para aproximar e afastar o zoom.

3 Solte o botão do dispositivo apontador para retornar para o círculo.

É possível usar a ferramenta Zoom para alterar a ampliação de um modelo. As
seguintes combinações de clique e tecla estão disponíveis para controlar como
a ferramenta Zoom se comporta:
■ Clique. Se clicar na ferramenta Zoom no círculo, a vista atual é ampliada

por um fator de 25 por cento. Se estiver usando o círculo Navegação
completa, o aumento incremental do zoom deve estar ativado no Options
Editor.

■ SHIFT+clique. Se mantiver pressionada a tecla SHIFT antes de clicar na
ferramenta Zoom em um círculo, a vista atual tem o zoom reduzido por
um fator de 25%. O zoom é aplicado na localização do cursor, e não do
ponto de giro atual.

■ Ctrl + clique. Se a tecla Ctrl for mantida pressionada antes de clicar na
ferramenta Zoom em um círculo, a vista atual tem o zoom aumentado por
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um fator de 25 por cento. O zoom é aplicado na localização do cursor, e
não do ponto de giro atual.

■ Clique e arraste. Se você clicar na ferramenta Zoom e manter pressionado
o botão no seu dispositivo apontador, é possível ajustar a ampliação do
modelo ao arrastar para cima ou para baixo.

■ Ctrl+ clique e arraste.  Ao utilizar os círculos Navegação completa ou
o minicírculo Visualização de objetos, é possível controlar o ponto alvo
utilizado pela ferramenta Zoom. Ao manter pressionada a tecla Ctrl, a
ferramenta Zoom irá utilizar a localização do ponto de giro anterior definido
pela ferramenta Zoom, Órbita ou Centro.

■ Shift+ clique e arraste Ao utilizar os círculos Navegação completa ou
o minicírculo Visualização de objetos, é possível aumentar o zoom em uma
área do modelo ao arrastar uma janela retangular em volta da área que
deseja ajustar a tela. Mantenha pressionada a tecla Shift e a seguir clique
e arraste uma janela ao redor da área na qual deseja aplicar zoom.

OBSERVAÇÃO Se a tecla Ctrl for mantida pressionada junto com a tecla
Shift, é possível aproximar o zoom em uma área do modelo utilizando uma
janela com base no centro, em vez de definida por cantos opostos.

■ Roda do mouse. Quando um círculo é exibido, role a roda do mouse
para cima ou para baixo para aumentar ou diminuir o zoom na vista do
modelo.

OBSERVAÇÃO Quando a ferramenta Zoom é utilizada a partir dos círculos de
navegação completa ou visualização de objetos, o ponto na vista no qual se clica
para aplicar o zoom se torna o ponto central para operações futuras de órbita, até
que se utilize a ferramenta Zoom novamente ou a ferramenta Centro. Se pressionar
CTRL antes de clicar na seção Zoom, o ponto Central não mudará.

Modos e ferramentas de navegação clássicos

Na interface do usuário Classic, há nove modos de navegação disponíveis na
barra de ferramentas Navigation Mode para controlar o movimento pela
Scene View: seis modos de câmera cêntrica e três modos de modelos cêntricos.
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DICA É possível usar alguns dos modos de navegação clássicos com a interface
de usuário clássica (faixa de opções). O Options Editor permite selecionar entre
os modos novos e antigos.

Em um modo centralizado na câmera, a câmera move na cena, e no modo
centralizado no modelo, o modelo move na cena. Por exemplo, os modos de
examinar e órbita essencialmente fazem a mesma coisa, exceto que o modo
de órbita move a câmera em torno do ponto focal e o modo examinar move
o modelo em torno do ponto focal.

OBSERVAÇÃO Os modos de navegação e SteeringWheels na página 161 são
mutuamente exclusivos, portanto, a ativação do modo de navegação desativa o
menu atual do SteeringWheel.

O movimento em cada modo tem base nas teclas de seta do teclado, as teclas
SHIFT e CTRL e no arraste do mouse. A roda do mouse também é suportada,
permitindo o rápido e fácil zoom ou lado-a-lado, dependendo do modo de
navegação atual.

DICA Arrastar com o mouse esquerdo enquanto mantém pressionado a tecla
CTRL executa a mesma ação que arrastar com o botão do meio do mouse, o qual
é útil caso só possua um mouse de dois botões.

As teclas SHIFT e CONTROL modificam o movimento, por exemplo, pressionar
a tecla SHIFT no modo navegar, acelera o movimento, e pressionar a tecla
CTRL também neste modo, desliza a câmera para a esquerda/direita e para
cima/para baixo.

OBSERVAÇÃO O movimento da câmera é o oposto de efetuar o pan no modelo.
O movimento da câmera é um movimento centralizado na câmera e o pan é um
movimento centralizado no modelo.

DescriçãoModo

Navegar. Permite navegar através do
modelo em um plano horizontal
assegurando que 'acima' sempre seja
'acima'.

Look Around . Permite olhar em torno do
modelo da posição atual da câmera e
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DescriçãoModo

fornece o efeito de estar movendo sua
cabeça em torno.

Zoom. Permite aproximar e afastar o zoom
do modelo. O curso para cima aproxima o
zoom e o cursor para baixo afasta o zoom.

Zoom to a Box. Permite arrastar uma
caixa para que o conteúdo da caixa
preencha a vista.

Pan. Permite efetuar o pan no modelo ao
invés da câmera.

Órbita. Permite orbitar a câmera em torno
do modelo assegurando que 'acima' seja
sempre 'acima'. A câmera sempre efetua a
órbita em torno de um ponto focal do
modelo.

Examine Permite rotacionar o modelo.

Fly. Permite voar em torno do modelo
como em um simulador de vôo.

Turntable. Permite girar o modelo em
trono do vetor acima. Este modo de
navegação se comporta como se o modelo
estivesse sentado em uma mesa giratória
assegurando que 'acima' seja sempre
'acima'.

Modo Walk

No modo Walk, é possível navegar por um modelo como se estivesse andando
por ele. Neste modo, a direção acima é sempre mantida.
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Após você iniciar o modo de navegação, o cursor muda para o cursor de
navegação. Para navegar através do modelo, você arrasta na direção na qual
deseja mover para.

Para utilizar o modo de navegação para mover através do modelo

1 Clique em Walk  na barra de ferramentas Navigation Mode.

2 Para mover, mantenha pressionado o botão esquerdo do mouse ao
arrastar na direção em que deseja navegar ou utilize as teclas de cursor.
A câmera gira para a esquerda e para a direita e move adiante e para atrás,

OBSERVAÇÃO Manter pressionada a tecla SHIFT acelera este movimento.

3 Para movimentar, mantenha pressionada tecla CTRL ao arrastar o mouse.
A câmera se movimenta para a esquerda e para a direita e para cima e
para baixo.

Quando o modo de navegação é centralizado na câmera, este modo difere
do modo normal de pan, pelo fato de que a câmera é movida e não o
modelo.

4 Para inclinar a câmera para cima e para baixo, gire a roda do mouse.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Walk

Entrada do comando: Ctrl+2

Modo Look Around

No modo Look Around, é possível girar a vista atual verticalmente e
horizontalmente. Ao rotacionar a vista, sua linha de visão rotaciona em torno
da posição do olho, como se estivesse virando sua cabeça.
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Para olhar em torno de uma vista

1 Clique em Look Around  na barra de ferramentas Navigation
Mode.

2 Para olhar em torno, arraste o botão esquerdo do mouse ou utilize as
teclas do cursor. A câmera olha para a esquerda, para a direita, para cima
ou para baixo.

OBSERVAÇÃO Manter pressionada a tecla SHIFT acelera este movimento.

3 Para rotacionar a câmera em torno de seu eixo de visualização, mantenha
pressionada a tecla CTRL.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Look Around

Entrada do comando: Ctrl+3

Modo Zoom

No modo Zoom, é possível efetuar o zoom dentro e fora do modelo.

Para efetuar o zoom na vista

1 Clique em Zoom  na barra de ferramentas Navigation Mode.
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2 Arraste o botão esquerdo do mouse para cima e para baixo ou utilize as
teclas do cursor para cima e para baixo para aproximar e afastar o zoom
respectivamente.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Zoom

Entrada do comando: Ctrl+4

Modo Zoom Box

No modo Zoom Box, é possível efetuar o zoom dentro de uma área de um
modelo ao arrastar uma caixa retangular pela área que deseja enquadrar na
Vista da cena.

Para aproximar o zoom em uma área do modelo ao especificar uma caixa

1 Clique em Zoom Box  na barra de ferramentas Navigation Mode.

2 Arraste uma caixa com o botão esquerdo do mouse sobre a Vista da
cena para preencher a vista com o conteúdo da caixa.

OBSERVAÇÃO Manter pressionada as teclas SHIFT ou CTRL, ou girar a roda
do mouse, ativa temporariamente o modo Zoom.

Menu:  Interface de usuárioClassic: Viewpoint ➤ Navigation
Mode ➤ Zoom Window

Entrada do comando: CTRL + 5
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Modo Pan

No modo Pan, é possível mover o modelo, em vez da câmera. Por exemplo,
arrastar para cima move o modelo acima e arrastar para baixo move o modelo
abaixo.

Para efetuar o pan de um modelo

1 Clique em Pan  na barra de ferramentas Navigation Mode.

2 Arraste o botão esquerdo do mouse para efetuar o pan do modelo acima,
abaixo, esquerda e direita.

OBSERVAÇÃO Manter pressionada as teclas SHIFT ou CTRL, ou girar a roda
do mouse, ativa temporariamente o modo Zoom.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Pan

Entrada do comando: Ctrl+6

Modo Orbit

No modo Orbit, a câmera é movida pelo ponto focal do modelo. Neste modo,
a direção acima é sempre mantida.
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Para efetuar a órbita de um modelo

1 Clique em Orbit  na barra de ferramentas Navigation Mode.

2 Para rotacionar a câmera em torno do modelo, arraste o botão esquerdo
do mouse ou as teclas do cursor.

OBSERVAÇÃO Pressionar a tecla SHIFT, ou girar a roda do mouse, ativa
temporariamente o modo normalZoom.

3 Para movimentar a câmera, mantenha pressionada a tecla CTRL ao
arrastar o mouse. A câmera se movimenta para a esquerda e para a direita
e para cima e para baixo.

Como o modo de órbita é centralizado na câmera, este modo difere do
modo normal de pan pelo fato de que a câmera é movida ao invés do
modelo.

Menu:  Interface de usuárioClassic: Viewpoint ➤ Navigation
Mode ➤ Orbit

Entrada do comando: Ctrl+7

Modo Examine

No modoFree Orbit, é possível girar o modelo pelo ponto focal.
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Para examinar o modelo

1 Clique em Examine  na barra de ferramentas Navigation Mode.

2 Para rotacionar o modelo em torno do ponto focal, arraste o botão
esquerdo do mouse ou as teclas do cursor. Se mouse estiver se movendo
quando você solta o botão, o modelo continua a girar. Clicando no
modelo para o giro.

OBSERVAÇÃO Pressionar a tecla SHIFT, ou girar a roda do mouse, ativa
temporariamente o modo normalZoom. Mantendo pressionada a tecla
CTRL, habilita temporariamente o modo normal Pan.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Examine

Entrada do comando: Ctrl+8

Modo Fly

No modo Fly, é possível mover pelo modelo como se estivesse num simulador
de vôo.

Para usar o modo Fly para mover pelo modelo

1 Clique em Fly  na barra de ferramentas Navigation Mode.

2 Mantenha pressionado o botão esquerdo do mouse para mover a câmera
adiante. Com em um simulador de vôo, o botão esquerdo do mouse vira
na esquerda/direita quando arrastado para a esquerda ou direita e inclina
acima/abaixo quando arrastado para cima ou para baixo.

OBSERVAÇÃO Manter pressionada a tecla SHIFT acelera este movimento.
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3 Utilize as teclas do cursor acima e baixo para aproximar ou afastar o
zoom da câmera respectivamente; utilize as teclas do cursor esquerda e
direita para girar a câmera na esquerda e direita respectivamente.

OBSERVAÇÃO Manter pressionada a tecla CTRL rotaciona a câmera em
torno de seu eixo de visualização, enquanto ainda move adiante.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Fly

Entrada do comando: Ctrl+9

Modo Turntable

No modo Turntable, é possível girar o modelo pelo vetor para cima como
se o modelo estivesse em uma mesa giratória. Neste modo, a direção acima é
sempre mantida.

Para girar o modelo em uma mesa giratória

1 Na barra de navegação, clique em Turntable  na barra de ferramentas
Navigation Mode.

2 Arraste o botão esquerdo do mouse para a esquerda e para a direita ou
utilize as teclas do cursor para a esquerda e para a direita para girar a
mesa giratória para a esquerda e para a direita respectivamente.

OBSERVAÇÃO Pressionar a tecla SHIFT, ou girar a roda do mouse, ativa
temporariamente o modo normalZoom. Mantendo pressionada a tecla
CTRL, habilita temporariamente o modo normal Pan.

3 Para inclinar a mesa giratória para cima e para baixo, gire a roda do
mouse, ou use as teclas do cursor para cima e para baixo.
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Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Turntable

Entrada do comando: Ctrl+0

Ferramenta View All

Faz com que o modelo completo caiba na Vista da cena.

A utilização desta função efetua a elevação e pan da câmera para que todo o
modelo seja mostrado na vista atual, o que é muito útil caso você se perca
dentro de um modelo ou o perde por completo.

Ocasionalmente, você pode obter uma vista em branco. Isto normalmente se
dá porque há itens que são muito pequenos em comparação ao modelo
principal ou itens que estão localizados longe do modelo principal. Nestes
casos, clique com o botão direito num item na Árvore de seleção e clique
em Zoom Selected para voltar ao modelo antes de tentar descobrir quais os
itens "perdidos".

Para visualizar tudo

1 Clique em View All  na barra de ferramentas Navigation Tools.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ View All
Menu de atalho: Scene ➤ View All

Ferramenta Zoom selecionado

Amplia o zoom da câmera para que os itens selecionados preencham a Vista
da cena.

Para visualizar itens selecionados

1 Clique em Zoom Selected  na barra de ferramentas Navigation
Tools.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Zoom Selected
Menu de atalho: Scene ➤ Zoom Selected
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ViewCube

A ferramenta de navegação ® ViewCube® da Autodesk fornece o feedback
visual sobre a orientação atual de um modelo. É possível utilizar a ferramenta
ViewCube para ajustar o ponto de vista de seu modelo. O ViewCube não está
disponível em um espaço de trabalho 2D.

Visão geral do ViewCube

A ferramenta ViewCube é uma interface persistente e clicável, que pode ser
arrastada e permite alternar entre vistas de seu modelo.

Ao exibir a ferramenta ViewCube, por padrão, esta é mostrada no canto superior
direito da Vista da cena sobre o modelo em uma estado inativo. A ferramenta
ViewCube fornece feedback visual sobre o ponto de vista atual do modelo
quando ocorrem alterações na vista. Quando o cursor é posicionado sobre a
ferramenta ViewCube, ela se torna ativa. É possível arrastar ou clicar no
ViewCube, alternar para uma das vistas predefinidas disponíveis, rolar a vista
atual ou alterar para a vista Inicial do modelo.

DICA Quando a barra de navegação está vinculada à ViewCube, ambas podem
ser movidas pela Vista da cena. Consulte  Reposicionando e reorientando a barra
de navegação na página 158 para obter mais informações.

Controlar a aparência do ViewCube

A ferramenta ViewCube é exibida em um dos dois estados: inativo ou ativo.
Quando a ferramenta ViewCube está inativa, ela aparece parcialmente
transparente por padrão, para que não obscureça a vista do modelo. Quando
está ativa, ela aparece opaca e pode obscurecer a vista dos objetos na vista
atual do modelo.

Além de controlar o nível de opacidade do ViewCube quando ele está inativo,
também é possível controlar seu tamanho e exibição da bússola. As
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configurações usadas para controlar a aparência do ViewCube estão localizadas
no Options Editor.

Utilizar a bússola

A bússola é exibida abaixo da ferramenta ViewCube e indica em qual direção
o Norte está definido para o modelo. É possível clicar em uma letra de direção
cardeal na bússola para rotacionar o modelo, ou arrastar uma das letras de
direção cardeal ou o anel da bússola para rotacionar interativamente o modelo
ao redor do ponto de giro.

Arraste ou clique no ViewCube

Quando você arrasta ou clica na ferramenta ViewCube, a vista do modelo é
reorientada em torno de um ponto de giro. O ponto de giro é exibido no
centro do objeto que foi por último selecionado antes de usar a ferramenta
ViewCube.

Para exibir ou ocultar o ViewCube

■ Clique na guia View painel  ➤ Navigation Aids ➤ ViewCube  .

Para controlar o tamanho do ViewCube

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione uma opção na lista suspensa Size.

Navegar em uma cena | 147



3 Clique em OK.

Para controlar a opacidade de inatividade do ViewCube

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione uma opção na lista suspensa Inactive Opacity.

3 Clique em OK.
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Para exibir a bússola para o ViewCube

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione Show Compass Below the ViewCube.

3 Clique em OK.

A bússola é exibida abaixo da ferramenta ViewCube e indica a direção
norte para o modelo.

Menu do ViewCube

Utilize o menu do ViewCube para restaurar e definir a vista Inicial de um
modelo, alternar entre os modos de projeção, e alterar o comportamento
interativo e a aparência da ferramenta ViewCube.

Para exibir o menu do ViewCube

Para exibir o menu do ViewCube, siga uma das seguintes opções:
■ Clique com o botão direito na bússola, ícone Início, ou na área principal

da ferramenta ViewCube.

■ Clique no botão do menu de contexto localizado abaixo da ferramenta
ViewCube.

O menu do ViewCube possui as seguintes opções:
■ Início. Restaura a vista Início salva com o modelo. Esta vista está

sincronizada com a opção Ir para a vista inicial no menu do SteeringWheels.

■ Perspectiva.Alterna a vista atual para a projeção em perspectiva.

■ Ortogonal. Alterna a vista atual para a projeção ortogonal.

■ Bloquear na seleção. Utiliza os objetos selecionados para definir o centro
da vista quando uma alteração de orientação de vista ocorre com a
ferramenta ViewCube.

OBSERVAÇÃO Se clicar em Início na ferramenta ViewCube, a vista retornará
para a vista Início, mesmo se Bloquear na seleção estiver selecionada.

■ Definir a vista atual como a principal. Define a vista Principal do
modelo com base na vista atual.

■ Definir a vista atual como a frontal. Define a vista "Front" (Frontal)
do modelo.
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■ Reinicializar frontal. Reinicializa a vista Frontal do modelo para sua
orientação-padrão.

■ ViewCube Options.Exibe o Options Editor onde é possível ajustar a
aparência e o comportamento da ferramenta ViewCube.

■ Help. Inicia o sistema de ajuda on-line e exibe o tópico para a ferramenta
ViewCube.

Reorientar a vista de um modelo com o ViewCube

O ViewCube é utilizado para reorientar a vista atual de um modelo. É possível
reorientar a vista de um modelo com a ferramenta ViewCube ao clicar em
áreas predefinidas para definir um pré-ajuste da vista atual, clicar e arrastar
para modificar livremente o ângulo da vista do modelo, e definir e restaurar
a vista Início.

Reorientar a vista atual

A ferramenta ViewCube fornece 26 áreas definidas, onde é possível clicar para
alterar a vista atual de um modelo. As 26 áreas definidas são categorizadas em
três grupos: canto, aresta e face. Das 26 áreas definidas, 6 áreas representam
vistas ortogonais-padrão de um modelo: superior, inferior, frontal, posterior,
esquerda e direita. As vistas ortogonais são definidas ao clicar em uma das
faces na ferramenta ViewCube.

OBSERVAÇÃO Quando o cursor está sobre um das áreas clicáveis da ferramenta
ViewCube, o cursor muda para uma seta com um pequeno cubo para indicar que
ele está sobre a ferramenta ViewCube. Uma dica de ferramenta também é exibida.
A dica de ferramenta descreve a ação que pode ser executada com base na
localização do cursor sobre a ferramenta ViewCube.

As outras 20 áreas definidas são usadas para acessar vistas angulares de um
modelo. Clicar em um dos cantos da ferramenta ViewCube reorienta a vista
atual do modelo para vista de 3/4, com base em um ponto de vista definido
por três lados do modelo. Clicar em uma das extremidades reorienta a vista
do modelo para uma 1/2 vista com base em dois lados do modelo.
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Também é possível clicar e arrastar a ferramenta ViewCube para reorientar a
vista de um modelo para um ponto de vista personalizado diferente dos outros
26 pontos de vista predefinidos. Conforme você arrasta, o cursor é alterado
para indicar que você está reorientando a vista atual do modelo. Se você arrastar
a ferramenta ViewCube perto das orientações predefinidas e ele estiver definido
para alinhar à vista mais próxima, a ferramenta ViewCube vai rotacionar para
a orientação predefinida mais próxima.

O contorno da ferramenta ViewCube auxilia a identificar a forma da orientação
na qual ela se encontra: padrão ou fixa. Quando a ferramenta ViewCube está
na orientação padrão, não orientada para uma das 26 vistas predefinidas, o
seu contorno é exibido como tracejado. A ferramenta ViewCube tem o
contorno em um linha contínua sólida quando é restrita a uma das vistas
predefinidas.

Rotacionar uma face da vista

Quando você exibe um modelo a partir de uma das vistas de face, dois botões
de seta de rolagem são exibidos próximos a ferramenta ViewCube. Utilize as
setas de rolagem para rotacionar a vista atual 90º graus no sentido horário ou
anti-horário em volta do centro da vista.
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Alternar para uma face adjacente

Quando a ferramenta ViewCube está ativa durante a exibição de um modelo
a partir de uma das vistas de face, quatro triângulos ortogonais são exibidos
perto do ViewCube. Utilize estes triângulos para alternar para uma das vistas
de face adjacentes.

Vista frontal

É possível definir a vista Frontal de um modelo para definir a direção das vistas
de face na ferramenta ViewCube. Junto com a vista Frontal, a direção para
cima de um modelo também é usada para definir a direção das vistas de face
na ferramenta ViewCube.

OBSERVAÇÃO A vista frontal é uma configuração global e sempre será mesma
para pontos de visão .

Para reorientar a vista atual para uma orientação predefinida

■ Clique em uma das faces, arestas ou cantos na ferramenta ViewCube.

Para visualizar uma face adjacente

Observação: Assegure-se de que uma vista de face é atual.
■ Clique em um dos triângulos exibidos próximos da extremidade da

ferramenta ViewCube.
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Para reorientar de forma interativa a vista

■ Clique na ferramenta ViewCube, mantenha pressionado o botão esquerdo
do mouse, e arraste na direção em que deseja orbitar o modelo.

Para utilizar transições animadas ao reorientar a vista para uma orientação
predefinida

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione Use Animated Transitions When Switching Views.

Quando marcado, as transições de uma vista para outra aparecem
animadas ao clicar em uma área predefinida na ferramenta ViewCube.

3 Clique em OK.
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Para ajustar automaticamente o modelo após uma reorientação da vista

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione Fit-to-View on Change.

3 Clique em OK.

Para rolar uma vista de face

Observação: Assegure-se de que uma vista de face é exibida.
■ Clique em uma da setas de rotação exibidas acima e à direita da ferramenta

ViewCube.

A seta de rotação esquerda rotaciona a vista em 90 graus no sentido
anti-horário e a seta de rotação direita rotaciona a vista 90 graus no sentido
horário.

Para definir a vista frontal

■ Clique com o botão direito na ferramenta ViewCube e clique em Definir
a vista atual como frontal.

Para restaurar a vista frontal

■ Clique com o botão direito na ferramenta ViewCube e clique em Redefinir
o lado frontal.

Definir o modo de projeção da vista

A ferramenta ViewCube possui dois modos de projeção de vista (Perspectiva
e Ortogonal). A projeção Ortogonal é também referida como projeção
paralela. As vistas projetadas em Perspectiva são calculadas com base na
distância da câmera teórica e o ponto alvo. Quanto menor a distância entre
a câmera e o ponto alvo, mais distorcido aparece o efeito de perspectiva; a
distância maior produz menos efeitos distorcidos que afetam o modelo. As
vistas projetadas Ortogonais exibem todos os pontos de um modelo sendo
projetado paralelamente à tela.

O modo de projeção ortogonal torna mais fácil trabalhar com um modelo, já
que todas as arestas do modelo aparecem com o mesmo tamanho,
independentemente da distância da câmera. No entanto, o modo de projeção
ortogonal não é como normalmente você visualiza os objetos no mundo real.
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Os objetos no mundo real são visualizados na projeção em perspectiva.
Portanto, quando você deseja gerar uma renderização ou uma vista de linha
oculta de um modelo, a utilização da projeção em perspectiva dará ao modelo
uma aparência mais realista.

A ilustração a seguir mostra o mesmo modelo visto da mesma direção de
visualização, mas com diferentes projeções da vista.

PerspectiveOrthographic

Para alterar o modo de projeção da vista

■ Clique com o botão direito na ferramenta ViewCube e clique em uma
das opções a seguir:
■ Ortogonal

■ Perspectiva

Vista inicial

A vista Início é uma vista especial armazenada com um modelo que torna fácil
para retornar para uma vista conhecida e familiar. É possível definir qualquer
vista do modelo como a vista Início. A vista Início salva pode ser aplicada à
vista atual ao clicar no botão Início acima da ferramenta ViewCube ou no
menu ViewCube.

Para definir a vista Home

■ Clique com o botão direito do mouse na ferramenta ViewCube e clique
em Set Current View as Home.

Entrada do comando: CTRL+SHIFT+Home
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Para reorientar o modelo para a vista Início

■ Clique no botão Home (  ) localizado próximo à ferramenta ViewCube.

■ Clique com o botão direito na ferramenta ViewCube e clique em Início.

Examinar objetos individuais com o ViewCube

É possível bloquear a ferramenta ViewCube para um conjunto de objetos
selecionados. Bloquear uma seleção de objetos para a ferramenta ViewCube
define o centro da vista atual e a distância da vista com base nos objetos
selecionados. Para desativar Lock to Selection, é possível clicar no botão
Lock to Selection  ao lado do botão de visualização Home.

A seleção e o cancelamento da seleção de objetos após a ativação de Bloquear
para a seleção não afeta o centro ou a distância da vista quando ocorre uma
alteração da orientação da vista. Não é possível aplicar o zoom nas extensões
para visualizar um modelo quando Bloquear na seleção estiver ativada, mesmo
que a ferramenta ViewCube seja definida para aplicar zoom nas extensões
após cada alteração de orientação de vista.

Para bloquear a seleção atual

■ Clique com o botão direito na ferramenta ViewCube e clique Bloquear
para a seleção.

Se a opção Bloquear para a seleção estiver marcada quando ocorrer uma
alteração de orientação de vista, os objetos selecionados serão utilizados
para calcular o centro da vista e será efetuado zoom nas extensões dos
objetos selecionados. Quando desmarcada, os objetos selecionados são
utilizados para calcular o centro da vista e o zoom nas extensões do modelo.

Para examinar um objeto individual com o ViewCube

1 No modelo, selecione um ou mais objetos para definir o ponto central
da vista.

2 Clique em uma das localizações predefinidas na ferramenta ViewCube
ou clique e arraste a ferramenta ViewCube para reorientar a vista do
modelo.

A ferramenta ViewCube reorienta a vista do modelo com base no ponto
central dos objetos selecionados.
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Barra de navegação

Ferramentas de navegação unificadas e especificas do produto podem ser
acessadas da barra de navegação.

Visão geral da Barra de navegação

A barra de navegação é um elemento da interface do usuário que permite
acessar ferramentas de navegação unificadas e especificas do produto.

As ferramentas de navegação unificadas (como ® ViewCube ®, 3Dconnexion®

e SteeringWheels®da Autodesk) são as que podem ser encontradas em muitos
produtos da Autodesk. As ferramentas de navegação especificas do produto
são exclusivas daquele produto. A barra de navegação flutua sobre e por um
dos lados da Vista da cena.

As ferramentas de navegação são iniciadas ao clicar em um dos botões na barra
de navegação ou ao selecionar uma das ferramentas de uma lista que é exibida
quando a menor porção de um botão de divisão é clicada.

5. Ferramentas Orbit na página 114.
Conjunto de ferramentas de navegação para

1. ViewCube na página 146 Indica a
orientação atual de um modelo e é utilizada

rotacionar o modelo ao redor de um ponto
de giro enquanto a vista permanece fixa.

para reorientar a vista atual de um modelo.
Clicar neste botão exibe o ViewCube na
Vista da cena quando ele não está visível.

6. Ferramentas Look na página 116.
Conjunto de ferramentas para rotacionar a
vista atual verticalmente e horizontalmente.

2. SteeringWheels na página 161 Coleção
de círculos que oferece a rápida alternância
entre as ferramentas de navegação
especializadas.

7. Ferramentas Walk e Fly na página 117.
Conjunto de ferramentas de navegação para

3. ferramenta Pan na página 113. Ativa a
ferramenta pan e move a vista
paralelamente à tela.
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mover ao redor do modelo e controlar as
configurações de realismo.

3Dconnexion na página 173 Conjunto de
ferramentas de navegação usado para

4. Ferramentas de Zoom na página 113.
Conjunto de ferramentas de navegação para

reorientar a vista atual de um modelo com
um mouse 3D 3Dconnexion.

aumentar ou diminuir a ampliação da vista
atual do modelo.

OBSERVAÇÃO Em uma área de trabalho 2D, somente as ferramentas de navegação
2D (como o SteeringWheels 2D, Pan, Zoom e 3Dconnexion Modo 2D) estão
disponíveis.

Para exibir ou ocultar a barra de navegação

■ Clique na guia View ➤ painel Navigation Aids ➤ Navigation Bar

 .

Reposicionando e reorientando a barra de
navegação

A posição e orientação da barra de navegação podem ser ajustadas ao vinculá-la
à ferramenta ViewCube, encaixá-la quando a ferramenta ViewCube não é
exibida ou posicionando-a livremente em uma das extremidades da janela
atual.

Quando vinculada à ferramenta ViewCube, a barra de navegação é posicionada
abaixo da ferramenta ViewCube em uma orientação vertical. Quando não está
vinculada ou encaixada, a barra de navegação pode ser alinhada livremente
por uma das arestas da Vista da cena.

É possível especificar como a barra de navegação pode ser reposicionada no
menu Personalizar. Quando a barra de navegação não está vinculada com
à ferramenta ViewCube ou encaixada, uma alça de manipulação é exibida.
Arraste o manipulador de controle na barra de navegação para reposicioná-lo
ao longo de um dos lados da Vista da cena.

Caso o lado da Vista da cena no qual a barra de navegação estiver alinhada
não for longo o suficiente para mostrar toda a barra de navegação, esta será

158 | Capítulo 5   Explorar seu modelo



cortada para caber no mesmo. Quando truncada, o botão More Controls
é exibido e substitui o botão Customize  . Ao clicar no botão Mais
controles, é exibido um menu que contém as ferramentas de navegação que
não estão sendo exibidas no momento.

Para reposicionar a barra de navegação e o ViewCube

1 Na barra de navegação, clique em Personalizar.

2 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  e selecione
Vincular ao ViewCube.

Quando Vincular ao ViewCube está marcado, a barra de navegação e o
ViewCube são reposicionados juntos na tela atual. Quando o ViewCube
não é exibido, a barra de navegação é encaixada na mesma localização
na qual o ViewCube estaria.

3 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  , e a seguir em
uma posição de encaixe disponível.

A barra de navegação e o ViewCube são reposicionados.

Para vincular a posição da barra de navegação ao ViewCube

1 Na barra de navegação, clique em Personalizar.

2 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  e selecione
Vincular ao ViewCube.

Quando Vincular ao ViewCube está marcado, a barra de navegação e o
ViewCube são reposicionados juntos na tela atual.

Para reposicionar livremente a barra de navegação ao longo da extremidade
da janela atual

DICA Em uma área de trabalho 2D, clique na alça de manipulação e arraste a
barra de navegação para reposicioná-la.

1 Na barra de navegação, clique em Personalizar.

2 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  e desmarque
Vincular ao ViewCube.

A alça de manipulação para a barra de navegação é exibida no topo da
barra de navegação.

3 Clique na alça de manipulação e arraste a barra de navegação ao longo
da aresta da janela na qual ele deve ser exibida. Solte o botão no
dispositivo apontador para orientar a barra de navegação ao longo da
borda da janela.
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4 Arraste a barra de navegação ao longo da borda da janela para ajustar
sua posição ao longo da borda da janela.

Controlar a exibição das ferramentas de navegação
na barra de navegação

É possível controlar quais ferramentas de navegação unificadas e específicas
do produto são exibidas na barra de navegação com o menu Customize
(Personalizar).

O menu Personalizar é exibido ao clicar no botão Personalizar no canto inferior
esquerdo da barra de navegação. No menu Personalizar clique nas ferramentas
de navegação que deseja exibir na barra de navegação. A posição das
ferramentas de navegação na barra de navegação é predefinida e não pode ser
alterada.

OBSERVAÇÃO Em um espaço de trabalho 3D, o botão ViewCube será exibido
na barra de navegação somente quando a ferramenta ViewCube estiver oculta na
Scene View. Em uma área de trabalho 2D, o botão ViewCube não está disponível.

Para personalizar a barra de navegação

1 Na barra de navegação, clique em Personalizar.

2 No menu Personalizar clique na ferramenta de navegação que deseja
exibir na barra de navegação.

Uma marca de seleção próxima ao nome da ferramenta de navegação
indica que ela já está exibida na barra de navegação. Desmarque a
ferramenta de navegação para removê-la da barra de navegação.

É possível exibir um menu de atalho para ferramentas na barra de navegação
ao clicar com o botão direito nelas. Os seguintes comandos estão disponíveis
no menu de atalho sempre que forem aplicáveis.

FinalidadeComando

Remove a ferramenta da barra de
navegação. Este é o equivalente à desmarcar

Remover da Barra de navegação

a caixa de seleção relevante no menu
Customize.

Oculta a barra de navegação.Fechar a Barra de navegação
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SteeringWheels

Os SteeringWheels™ são menus de rastreamento que seguem seu cursor, dos
quais é possível acessar diferentes ferramentas de navegação 2D e 3D a partir
de uma única ferramenta.

Visão geral dos SteeringWheels

Os SteeringWheels, também conhecido como círculos, podem economizar
tempo ao combinar muitas das ferramentas de navegação em uma única
interface. Os círculos são específicos ao contexto que um modelo está sendo
visualizado.
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As ilustrações a seguir mostram os diferentes círculos disponíveis:

Círculo de navegação 2D

Círculo de tour do edifício (Círculo
básico)

Círculo de visualização de objetos
(Círculo básico)

Círculo de navegação completa

Minicírculo de tour da construçãoMinicírculo de objeto de vistaMinicírculo de navegação completa

OBSERVAÇÃO SteeringWheels e classic navigation modes na página 135 são
mutuamente exclusivos, de maneira que ao ativar um SteeringWheel desativa o
modo de navegação Classic selecionado.

Exibir e usar os círculos

Pressionar e arrastar em um setor de um círculo é o modo principal de
interação. Após um círculo ser exibido, clique em um dos setores e pressione
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o botão no dispositivo apontador para ativar a ferramenta de navegação.
Arraste para reorientar a vista atual. Ao liberar o botão, retorna-se ao círculo.

Controlar a aparência dos círculos

É possível controlar a aparência dos círculos ao alternar entre os diferentes
estilos de círculos disponíveis, ou ao ajustar o tamanho e opacidade. Os círculos
estão disponíveis em dois tamanhos: grande e mini. O círculo grande é maior
do que o cursor e legendas são exibidas nos setores do círculo. O mini círculo
tem um tamanho similar ao cursor e legendas não são exibidas nos setores do
círculo.

Minicírculo Full Navigation

Círculo grande Full Navigation

O tamanho de um círculo controla o tamanho das seções e das legendas que
aparecem no círculo; o nível de opacidade controla a visibilidade dos objetos
no modelo atrás do círculo.

Controlar dicas de ferramentas para os círculos e as mensagens para
as ferramentas

São exibidas dicas de ferramenta para cada botão do círculo conforme o cursor
passa sobre eles. As dicas de ferramentas aparecem abaixo do círculo e
identificam qual ação será executada se o setor ou botão for clicado.

Similar às dicas de ferramentas, as mensagens de ferramenta e texto do cursor
são exibidos quando se utiliza uma das ferramentas de navegação de um
círculo. As mensagens da ferramenta são exibidas quando uma ferramenta de
navegação está ativa. Elas fornecem instruções básicas sobre como utilizar a
ferramenta. O texto do cursor da ferramenta exibe o nome da ferramenta de
navegação ativa próximo ao cursor. Desativar as mensagens de ferramenta e
texto do cursor somente afeta as mensagens que são exibidas ao utilizar os
minicírculos ou o círculo de navegação grande completo.

Para exibir um círculo

1 Na barra de navegação, clique na seta abaixo do botão SteeringWheels.
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2 Clique no círculo que deseja exibir, por exemplo Full Navigation
Wheel.

Faixa de opções: Guia Viewpoint ➤ painel

Navigate ➤ SteeringWheels
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  SteeringWheels 

Para fechar um círculo

■ Pressione SHIFT+W

Para alterar o tamanho de um círculo

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, na página SteeringWheels sob o nó Interface,
selecione uma opção na lista suspensa Size na área Big Wheels ou Mini
Wheels.

4 Clique em OK.

Para alterar a opacidade de um círculo

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, na página SteeringWheels sob o nó Interface,
selecione uma opção na lista suspensa Opacity na área Big Wheels ou
Mini Wheels.

4 Clique em OK.

Para ativar dicas de ferramentas para círculos

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Show Tooltips na área On-Screen
Messages.
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As dicas de ferramentas são exibidas para os setores e botões em um
círculo quando o cursor passa sobre o círculo.

4 Clique em OK.

Para ativar mensagens de ferramentas para círculos

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Show Tool Messages na área On-Screen
Messages.

As mensagens são exibidas quando ferramentas de navegação são usadas.

4 Clique em OK.

Para ativar o texto do cursor da ferramenta para círculos

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Show Tool Cursor Text na área On-Screen
Messages.

O nome da ferramenta ativa é exibido próximo ao cursor quando a
ferramenta está em uso.

4 Clique em OK.

Menu Wheel

No menu Wheel, é possível alternar entre diferentes círculos e alterar o
comportamento de algumas ferramentas de navegação no círculo atual.

Utilize o menu Círculo para alternar entre os círculos grande e mini que estão
disponíveis, ir para a vista Início, alterar as preferências do círculo atual e
controlar o comportamento das ferramentas de navegação Órbita 3D, Olhar
e Navegar. Os itens do menu disponíveis no menu Círculo são dependentes
do círculo atual e do programa.
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Para exibir o menu Círculo

■ Clique na seta para baixo, no canto inferior direito do círculo, ou clique
com o botão direito do mouse no círculo.

O menu Círculo tem as seguintes opções:
■ Basic View Object Wheel. Exibe o círculo grande View Object.

■ Basic Tour Building Wheel. Exibe o círculo grande Tour Building.

■ Círculo de navegação completa. Exibe o círculo grande Navegação
completa.

■ Advanced Wheels. Exibe o minicírculo View Object, Tour Building ou
Full Navigation wheel.

■ Início. Vai para a vista Inicial salva com o modelo.

OBSERVAÇÃO Esta é a vista Inicial definida utilizando o ViewCube.

■ Fit to Window. Redimensiona e centraliza a vista atual para exibir todos

os objetos na Vista da cena. Isso é o mesmo que clicar em View All
na barra de ferramentas Navigation Tools na interface de usuário Classic.

■ Restaurar o centro original.Restaura o ponto central da vista para as
extensões do modelo.

■ Level Camera. Rotaciona a vista atual para que seja relativa ao plano de
chão XY.

■ SteeringWheels Options. Exibe o Options Editor onde é possível
ajustar a aparência de o comportamento do SteeringWheels.

■ Help. Inicia o sistema de ajuda on-line e exibe o tópico para o
SteeringWheels.

■ Close Wheel. Fecha o círculo.

Círculos Visualização de objetos

Com os círculos (mini e grande) Visualização de objetos, é possível visualizar
objetos individuais ou recursos em um modelo. O círculo grande Visualização
de objetos é otimizado para novos usuários 3D, enquanto que o minicírculo
Visualização de objetos é otimizado para usuários 3D experientes.
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Círculo grande Visualização de objetos

Os setores do círculo grande de visualização de objeto têm as seguintes opções:

■ Centro na página 118. Especifica um ponto no modelo para ajustar o
centro da vista atual, ou para alterar o ponto alvo usado por algumas
ferramentas de navegação.

■ Zoom na página 132. Ajusta a ampliação da vista atual.

■ Rebobinar na página 127. Restaura a orientação mais recente da vista.
É possível mover para trás ou para frente ao clicar e arrastar para esquerda
ou direita.

■ Órbita na página 122. Rotaciona a vista atual em torno de um ponto de
giro fixo.

Minicírculo de visualização de objetos

Os setores do minicírculo de visualização de objeto têm as seguintes opções:

■ Zoom (Círculo superior) na página 132. Ajusta a ampliação da vista
atual.

■ Rebobinar (Círculo direito) na página 127. Restaura a vista mais
recente. É possível mover para trás ou para frente ao clicar e arrastar para
esquerda ou direita.

■ Pan (Círculo inferior) na página 113. Reposiciona a vista atual ao
efetuar o pan.

■ Órbita (Círculo esquerdo) na página 122. Rotaciona a vista atual em
torno de um ponto de pivô fixo.
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OBSERVAÇÃO Quando o minicírculo é exibido, é possível pressionar e segurar o
botão do meio do mouse para efetuar a panorâmica, rolar o botão de rolagem
para aumentar ou diminuir o zoom, e manter pressionada a tecla Shift enquanto
pressiona e segura o botão do meio do mouse para orbitar o modelo.

Para alternar para o minicírculo View Object

■ Clique com o botão direito do mouse no círculo, e clique em Advanced
Wheels ➤ Mini View Object Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Mini View
Object Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsMini View Object
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Mini

View Object Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Mini View Object Wheel 

Para alternar para o círculo grande View Object

■ Clique com o botão direito no círculo, e clique em Basic View Object
Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Basic View
Object Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsBasic View Object
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  View

Object Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  View Object Wheel 

Círculos Tour do edifício

Com os círculos (grande e mini) Tour o edifício, é possível mover através de
um modelo, como um edifício, uma linha de montagem, navio ou plataforma
de petróleo. Você pode também andar e navegar em torno de um modelo. O
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círculo grande Tour do edifício é otimizado para novos usuários 3D, enquanto
que o minicírculo Tour do edifício é otimizado para usuários 3D experientes.

Círculo grande Tour do edifício

Os setores do círculo grande de tour do edifício têm as seguintes opções:

■ Adiante na página 119. Ajusta a distância entre o ponto atual da vista e
o ponto de pivô definido do modelo. Clicar uma vez move para frente a
meia distância do objeto clicado.

■ Olhar.  Gira a vista atual.

■ Rebobinar. Restaura a vista mais recente. É possível mover para trás ou
para frente ao clicar e arrastar para esquerda ou direita.

■ Ferramenta para cima/para baixo. Desliza a vista atual de um modelo
ao longo do eixo Z de um modelo.

Minicírculo Tour do edifício

Os setores do minicírculo de tour do edifício têm as seguintes opções:

■ Navegar (Círculo superior). Simula a navegação no modelo.

■ Rebobinar (Círculo direito). Restaura a vista mais recente. É possível
mover para trás ou para frente ao clicar e arrastar para esquerda ou direita.

■ Acima/Acima (Círculo inferior). Desliza a vista atual de um modelo
ao longo do eixo Z de um modelo.

■ Olhar (Círculo esquerdo).  Gira a vista atual.

OBSERVAÇÃO Quando o minicírculo é exibido, é possível pressionar e segurar o
botão do meio do mouse para efetuar a panorâmica, rolar o botão de rolagem
para aumentar ou diminuir o zoom, e segurar a tecla Shift enquanto pressiona e
segura o botão do meio do mouse para orbitar o modelo.
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Para alternar para o minicírculo Tour do edifício

■ Clique com o botão direito do mouse no círculo e clique em Advanced
Wheels  ➤ Mini Tour Building Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Mini Tour
Building Wheel
Faixa de opções: Guia Viewpoint painel

Navigate ➤  ➤ SteeringWheelsMini Tour Building
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Mini

Tour Building Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Mini Tour Building Wheel 

Para alternar para o círculo grande Tour Building

■ Clique com o botão direito no círculo, e clique em Basic Tour Building
Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Basic Tour
Building Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsBasic Tour Building
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Tour

Building Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Tour Building Wheel 

Círculos Navegação completa

Os círculos Navegação completa (grande e mini) combinam as ferramentas de
navegação 3D comuns encontradas nos círculos Visualização de objetos e Tour
do edifício. Os círculos Navegação completa grande e mini são otimizados
para usuários 3D experientes.
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OBSERVAÇÃO Quando um dos círculos Navegação completa é exibido, é possível
pressionar e segurar o botão do meio do mouse para efetuar pan, rolar o botão
de rolagem para aumentar ou diminuir o zoom, e segurar a tecla Shift enquanto
segura o botão do meio do mouse para orbitar o modelo.

Círculo grande Navegação completa

Os setores do círculo grande de navegação completa têm as seguintes opções:

■ Zoom. Ajusta a ampliação da vista atual.

■ Rebobinar. Restaura a vista mais recente. É possível mover para trás ou
para frente ao clicar e arrastar para esquerda ou direita.

■ Pan. Reposiciona a vista atual ao efetuar o pan.

■ Órbita. Rotaciona a vista atual em torno de um ponto de pivô fixo.

■ Centro. Especifica um ponto no modelo para ajustar o centro da vista
atual, ou para alterar o ponto alvo usado por algumas ferramentas de
navegação.

■ Navegar. Simula a navegação no modelo.

■ Olhar.  Gira a vista atual.

■ Acima/Abaixo. Desliza a vista atual de um modelo ao longo do eixo Z
do modelo.

Minicírculo Navegação completa

Os setores do minicírculo de navegação completa têm as seguintes opções:

■ Zoom (Círculo superior). Ajusta a ampliação da vista atual.

■ Navegar (Círculo superior direito). Simula a navegação no modelo.

■ Rebobinar (Círculo direito). Restaura a vista mais recente. É possível
mover para trás ou para frente ao clicar e arrastar para esquerda ou direita.
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■ Acima/Abaixo (Círculo inferior direito). Desliza a vista atual de um
modelo ao longo do eixo Z do modelo.

■ Pan (Círculo inferior). Reposiciona a vista atual ao efetuar o pan.

■ Olhar (Círculo inferior esquerdo).  Gira a vista atual.

■ Órbita (Círculo esquerdo). Rotaciona a vista atual em torno de um
ponto de pivô fixo.

■ Centro (Circulo superior esquerdo). Especifica um ponto no modelo
para ajustar o centro da vista atual, ou para alterar o ponto alvo usado por
algumas ferramentas de navegação.

Para alternar para o minicírculo Navegação completa

■ Clique com o botão direito do mouse no círculo e clique em Advanced
Wheels ➤ Mini Full Navigation Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Mini Full
Navigation Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsMini Full Navigation
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Mini Full

Navigation Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Mini Full Navigation Wheel 

Para alternar para o círculo grande Full Navigation

■ Clique com o botão direito do mouse no círculo e clique no círculo Full
Navigation Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Full
Navigation Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsFull Navigation
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Full

Navigation Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Full Navigation Wheel 
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Círculo de navegação 2D

Com este círculo é possível acessar ferramentas de navegação 2D básicas. É
particularmente útil quando você não tem um dispositivo apontador com um
roda de rolagem.

Os setores do círculo de navegação 2D têm as seguintes opções:
■ Pan. Reposiciona a vista atual ao efetuar o pan.

■ Zoom. Ajusta a ampliação da vista atual.

■ Rebobinar. Restaura a orientação mais recente da vista. É possível mover
para trás ou para frente ao clicar e arrastar para esquerda ou direita.

Mouse 3D 3Dconnexion

Um mouse 3D 3Dconnexion pode ser usado como uma alternativa ao mouse
para mover ao redor da Scene View.

O dispositivo tem uma cápsula de controle sensível à pressão projetada para
flexionar em todas as direções. Puxe, empurre, gire ou incline a cápsula para
efetuar o pan, zoom e rotacionar a vista atual. A velocidade de navegação é
sensível ao montante de força aplicada no dispositivo 3Dconnexion. É possível
ajustar as configurações do dispositivo ao utilizar o Painel de controle para o
dispositivo que é fornecido pelo fabricante com a instalação.

Navegar em uma cena | 173



Quando ocorre uma alteração na vista com o mouse 3D 3Dconnexion, a
ferramenta ViewCube é reorientada para refletir a vista atual. Você pode alterar
o comportamento do mouse 3D 3Dconnexion a partir da barra de navegação.

Opções do 3Dconnexion na barra de navegação

ExemploDescriçãoOpção

Mova a cápsula de controle para a direita
para efetuar o pan da vista para a direita.

Navega e reorienta a vista na
direção da cápsula de
controle.

Modo de
objeto

Mova a cápsula de controle adiante para
navegar em direção do modelo.

Simula a navegação através
do modelo. A vista do modelo
é movida na direção oposta

Modo de
navegação

da cápsula de controle. A
orientação e a altura da vista
atual são mantidas.

Mova a cápsula de controle para elevar
a vista. Isso faz parecer que o modelo
está se movendo para baixo.

Simula o voo através do
modelo. A vista do modelo é
movida na direção oposta da
cápsula de controle. A

Modo de voo

orientação e altura da vista
atual não é mantida.
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Opções do 3Dconnexion na barra de navegação

ExemploDescriçãoOpção

Mova a cápsula de controle para efetuar
o pan e zoom na vista.

Navega na vista usando
somente as opções de
navegação 2D. A vista move

Modo 2D

na direção da cápsula de
controle.

Clique no modelo. A vista é centralizada
no modelo com base no ponto
especificado.

Especifica um ponto para
definir o ponto de giro e o
centraliza o modelo naquele
ponto. Este ponto de giro é

Ferramenta
Centro

usado por ferramentas
subsequentes de navegação
até ser movida.

Ajuste a velocidade de translação e
rotação.

Controla o modo de
navegação padrão e a
velocidade de conversão e

Configurações
3Dconnexion

rotação do mouse 3D
3Dconnexion no Options
Editor na página 308

Se você estiver usando a interface do usuário Classic, o comportamento do
dispositivo 3Dconnexion corresponde à ferramenta da barra de navegação na
página 113 ou ao modo de navegação na página 135. Isso permite navegar com
o dispositivo 3Dconnexion enquanto executa outras operações com o mouse.
Se nenhuma ferramenta ou modo de navegação for selecionado ou se a
ferramenta ou modo selecionado não for um modo válido para o dispositivo
3Dconnexion, então o modo de navegação padrão será usado.

Usar Chaves de gerenciamento da vista no mouse 3D 3Dconnexion

Você pode acessar as diferentes vistas (como Superior, Frontal, Esquerda, Direita
ou Inicial) com os botões disponíveis em alguns modelos de mouse 3D
3Dconnexion. Use o Editor de configuração de botão para personalizar as
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operações destes botões. Quando você clica em qualquer destes botões no
dispositivo, poderá
■ Ajustar a vista nas extensões do modelo. Rotaciona a vista do objeto

em torno do centro da cena e afasta o zoom para que a cena caiba na
viewport.

■ Reorientar a vista atual para uma orientação predefinida. Retorna
a vista do objeto para uma vista predeterminada.

■ Manter a sensibilidade da seleção. Reorienta o modelo em torno de
um ponto de giro definido com base na seleção atual.

■ Manter bloqueado na seleção. Quando a opção Bloquear na seleção
estiver ativada na ferramenta ViewCube, a vista do objeto é reorientada
em torno do centro predefinido do objeto selecionado.

Câmera

O Autodesk Navisworks oferece diversas opções prefixadas para controlar a
projeção, posição e orientação da câmera durante a navegação.

Definir a projeção da câmera

Você pode utilizar uma câmera em perspectiva ou uma câmera ortogonal
durante a navegação, somente em um espaço de trabalho 3D. Em um espaço
de trabalho 2D, a câmera ortogonal sempre é utilizada.

OBSERVAÇÃO Câmaras ortogonais não estão disponíveis com as ferramentas de
navegação Walk e Fly.

Para utilizar uma câmera em perspectiva

■ Clique na guia Viewpoint ➤ painel Camera ➤ Perspective  .

Menu:  Interface do usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Perspective

Para utilizar uma câmera ortogonal

■ Clique na guia Viewpoint ➤ painel Camera ➤ Orthographic  .
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Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Orthographic

Controlar o campo de visão

É possível definir a área da cena que pode ser visualizada através da câmera
somente em um espaço de trabalho 3D.

Para o ponto de vista atual, é possível mover o deslizador FOV na faixa de
opções para ajustar o Horizontal Field of View. Para pontos de visão
anteriormente salvos, você pode usar a caixa de diálogo Editar ponto de visão
na página 287 para ajustar os valores dos ângulos de visão vertical e horizontal.

OBSERVAÇÃO Quando você modifica o Horizontal Field of View, o Vertical Field
of View é automaticamente ajustado, e vice-versa, para coincidir com a relação
de aspecto no Autodesk Navisworks.

Para controlar o campo de visão horizontal

■ Clique na guia Viewpoint painel  ➤ Camera e mova o controle deslizante
FOV para controlar o ângulo de vista da câmera.

Mover o deslizador para a direita produz um ângulo de visão mais amplo,
e mover o deslizador para a esquerda produz um ângulo de visão mais
estreito, ou mais focado.

Posição e foco da câmera

É possível ajustar a posição e a orientação da câmera na cena.

Mover a câmera

Para o ponto de vista atual, você pode usar as caixas de entrada Position na
faixa de opções para mover a posição da câmera. Para pontos de visão salvos
anteriormente, você pode usar a caixa de diálogo Editar ponto de visão na
página 287 para ajustar os valores da câmera.

OBSERVAÇÃO Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.
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Para mover a câmera numericamente

1 Clique na guia Ponto de visão, e deslize o painel Câmera.

2 Digite os valores numéricos nas caixas de entrada Position para mover
a câmera pelo valor inserido.

Rotacionar a câmera

É possível ajustar o ângulo da câmera durante a navegação somente em um
espaço de trabalho 3D.

Para o ponto de visão atual, use a janela Inclinar para rotacionar a câmera
acima e abaixo e caixa de entrada Roll na faixa de opções para rotacionar a
câmera para a direita/esquerda. Para pontos de visão salvos, você pode usar a
caixa de diálogo Editar ponto de visão na página 287 para ajustar os valores da
câmera.

janela Inclinar

O ângulo de inclinação nas unidades da cena abaixo (negativo) ou acima
(positivo) de horizontal (0) na base da janela.

É possível usar a janela Inclinarcom a ferramenta Navegarna barra de
navegação, para olhar para cima e para baixo. Se houver uma roda de rolagem
no mouse, você poderá utilizá-la para ajustar o ângulo de inclinação.
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Para alternar a janela Inclinar

■ Clique na guia Viewpoint ➤ painel Camera ➤ Show Tilt Bar  .

Entrada do comando: CTRL + F7

Para rolar a câmera para cima/para baixo

■ Arraste o controle deslizante acima e abaixo na janela Inclinar para rolar
a câmera.

Também é possível digitar valores diretamente na caixa de entrada na base
da janela Inclinar. Um valor positivo rotaciona a câmera no sentido para
cima, e um valor negativo rotaciona para baixo. Digitar 0 nivela a câmera.

Para rolar a câmera para esquerda/direita

■ Clique na guia Ponto de visão, e deslize o painel Camera.

■ Digite um valor na caixa de entrada Roll para rotacionar a câmera ao redor
do eixo frontal-traseiro.

Um valor positivo rotaciona a câmera no sentido anti-horário e um valor
negativo rotaciona no sentido horário.

OBSERVAÇÃO Este valor não é editável quando o vetor superior do ponto de
vista permanece em pé (isto é, quando você usa as ferramentas de navegação
Walk, Orbit e Constrained Orbit).

Mover o ponto focal

É possível alterar o ponto focal da câmera. Para o ponto de vista atual, use as
caixas de entrada Look At na faixa de opções. Para pontos de visão salvos,
você pode usar a caixa de diálogo Editar ponto de visão na página 287 para
ajustar os valores da câmera.

OBSERVAÇÃO Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.

Em um espaço de trabalho 3D, também é possível colocar a Scene View no
modo de foco, o qual gira eficazmente a câmera, de maneira que o ponto
clicado esteja no centro da vista. Consulte Foco na página 185.
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Para mover o ponto focal da câmera

1 Clique na guia Ponto de visão, e deslize o painel Camera.

2 Digite os valores numéricos nas caixas de entrada Look At para mover
o ponto focal da câmera pela quantidade inserida.

Colocar a câmera reta

É possível colocar a câmera reta para alinhar com o vetor acima do ponto de
vista, somente em um espaço de trabalho 3D.

Quando a câmera está próxima do vetor acima do ponto de vista (dentro de
13 graus), você pode utilizar esta função para efetuar o snap da câmera no
eixo apropriado.

DICA O mesmo efeito pode ser alcançado ao digitar 0 na base da janela Inclinar.

Para colocar a câmera reta

■ Clique na guia Viewpoint ➤ painel Camera ➤ menu suspenso Align
Camera ➤ Straighten  .

Vistas de câmera predefinidas

No Autodesk Navisworks, é possível alinhar a câmera a um dos eixos ou
selecionar uma das seis vistas de face predefinidas para alterar instantaneamente
a posição da câmera e a orientação da cena. Esta função está disponível somente
em um espaço de trabalho 3D.

Quando você alinha a posição da câmera ao longo de um dos eixos:
■ Alinhar com o eixo X alterna entre as vistas de face frontais e traseiras.

■ Alinhar com o eixo Y alterna entre as vistas de face esquerda e direita.

■ Alinhar com o eixo Z alterna entre as vistas de face superiores e inferiores.

OBSERVAÇÃO É possível personalizar a localização da face frontal usando a
ferramenta ViewCube. Esta alteração é global e afeta todos os pontos de visão .
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Para alinhar com o eixo X

■ Clique na guia Viewpoint ➤ painel Camera ➤ menu suspenso Align
Camera ➤ Align X  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Align X

Para alinhar com o eixo Y

■ Clique na guia Viewpoint painel  ➤ Camera ➤  menu suspenso Align
Camera ➤ Align Y  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Align Y

Para alinhar com o eixo Z

■ Clique na guia Viewpoint ➤ painel Camera ➤ menu suspenso Align
Camera ➤ Align Z  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Align Z

Para olhar de uma vista de face predefinida

■ Clique com o botão direito do mouse em Scene View e clique em
Viewpoint ➤ Look From.

■ Clique em uma das vistas de face. Escolha entre:
■ Top

■ Bottom

■ Front

■ Back

■ Left

■ Right
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Auxílios de navegação

Head-Up Display

Os elementos de exibição instantânea (HUD)são exibições na tela que fornecem
informações sobre sua localização e orientação no espaço de trabalho 3D. Essa
função não está disponível em um espaço de trabalho 2D.

No Autodesk Navisworks, é possível utilizar os seguintes elementos de exibição
instantânea (HUD):
■ Eixos X Y Z. Mostra a orientação X, Y, Z da câmera (ou o olho de avatar

se o avatar estiver visível). O indicador dos Eixos XYZ está localizado na
parte inferior esquerda da Vista da cena.

■ Position Readout Mostra a posição absoluta X, Y, Z da câmera (ou a
posição do olho de avatar se o avatar estiver visível). O indicador Position
Readout está localizado na parte inferior esquerda da Vista da cena.

Para alternar os eixos XYZ

1 Clique na guia View painel  ➤ Navigation Aids menu suspenso
 ➤ HUD.

2 Selecione ou desmarque a caixa de seleção XYZ Axes.

Para alternar a leitura da posição

1 Clique na guia View painel  ➤ Navigation Aids menu suspenso
 ➤ HUD.

2 Selecione ou desmarque a caixa de seleção Position Readout.
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Vistas de referência

As vistas de referência são úteis para obter uma visão geral de onde você está
em toda a cena e para mover com rapidez a câmera para uma localização em
um modelo grande. Esta função está disponível em um espaço de trabalho
3D.

Há dois tipos de vistas de referência disponíveis no Autodesk Navisworks:
■ Section View

■ Plan View

As vistas de referência mostram uma vista fixa do modelo. Por padrão, a vista
de corte mostra a vista de frente do modelo e a vista de planta mostra uma
vista superior do modelo.

As vistas de referências são exibidas dentro das janelas encaixáveis. Um
marcador triangular representa seu ponto de vista atual. Este marcador move
quando você navega, mostrando a direção de sua vista. O marcador também
pode ser arrastado ao manter pressionado o botão esquerdo do mouse sobre
ele e arrastando para mover a câmera na Vista da cena.

OBSERVAÇÃO O marcador muda para um ponto pequeno quando a vista de
referência está no mesmo plano da vista da câmera.

Para usar a Plan View

1 Clique na guia View ➤ painel Navigation Aids ➤ menu suspenso
Reference Views ➤ caixa de seleção Plan View.

A janela Plan View é aberta com a vista de referência do modelo.
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2 Arraste o marcador triangular na vista de referência para uma nova
localização. A câmera na Vista da cena muda sua posição para coincidir
com a posição do marcador na vista.

Alternativamente, navegue para um localização diferente na Vista da
cena. O marcador triangular na vista de referência muda sua posição
para coincidir com a posição da câmera na Vista da cena.

3 Para manipular uma vista de referência, clique com o botão direito do
mouse em qualquer lugar da janela Plan View. Utilize o menu de atalho
para ajustar a vista como desejado.

Entrada do comando: CTRL + F9

Para usar a Section View

1 Clique na guia View ➤ painel Navigation Aids ➤ menu suspenso
Reference Views ➤ caixa de seleção Section View.

A janela Section View é aberta com a vista de referência do modelo.

2 Arraste o marcador triangular na vista de referência para uma nova
localização. A câmera na Vista da cena muda sua posição para coincidir
com a posição do marcador na vista.

Alternativamente, navegue para um localização diferente na Vista da
cena. O marcador triangular na vista de referência muda sua posição
para coincidir com a posição da câmera na Vista da cena.

3 Para manipular uma vista de referência, clique com o botão direito em
qualquer lugar da janela Section View. Utilize o menu de atalho para
ajustar a vista como desejado.

Entrada do comando: CTRL + F10
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Foco

É possível colocar a Vista da cena no modo de foco até o próximo clique.

Quando você estiver no modo de foco, clicar em um item gira a câmera para
que o ponto clicado esteja no centro da vista. Esse ponto se torna o ponto
focal para as ferramentas Órbita (SteeringWheels e barra de navegação) somente
em um espaço de trabalho 3D.

Na interface de usuário Classic, espaço de trabalho 3D, esse ponto se torna
o ponto focal para os modos de navegação clássicos na página 135 examinar,
órbita e mesa giratória.

Em uma área de trabalho 2D, a câmera é movida para o centro da caixa do
item em foco enquanto o valor de Z permanece o mesmo.

Para focar em um item

■ Clique na guia Item Tools ➤ painel Look At ➤ Focus on Item 
.

Barra de ferramentas: Navigation bar  ➤  ferramentas Look  ➤  Focus
Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Focus
Menu de atalho: Scene  ➤  Focus

Armazenar

Ao navegar por um modelo no Autodesk Navisworks, é possível "pegar" ou
segurar itens selecionados e movimentar com eles pelo modelo.

Por exemplo, você pode estar visualizando uma planta para uma fábrica e
gostaria de ver diferentes configurações de layouts de máquina.

Para armazenar e liberar objetos

1 Selecione os objetos que você deseja armazenar na Vista da cena ou
na Selection Tree.

2 Clique na guia Item Tools painel  ➤ Hold ➤ Hold  .
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Os objetos selecionados agora estão seguros e serão movidos com você
pelo modelo quando usar as ferramentas de navegação, tais como
Navegar, Pan e assim por diante.

3 Para liberar objetos armazenados, clique novamente em Hold  na
faixa de opções.

4 Se desejar redefinir os objetos às suas posições originais, clique na guia

Item Tools ➤ painel Transform ➤ Reset Transform  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Hold

Controlar o realismo de sua navegação
Quando você navega em um modelo 3D, é possível utilizar as ferramentas de
realismo na guia Viewpoint painel  ➤ Navigate para controlar a velocidade
e o realismo de sua navegação. As ferramentas de realismo não estão disponíveis
em uma área de trabalho 2D.

Gravity

OBSERVAÇÃO Esta função somente funciona em conexão a uma colisão.

A colisão lhe fornece massa e a gravidade lhe fornece peso. Com tal, você
(como o volume de colisão) será puxado para baixo ao navegar através da
cena.

OBSERVAÇÃO A gravidade só pode ser usada com a ferramenta de navegação
Walk.

Isto permite descer as escadas, por exemplo, ou seguir o terreno.

Para alternar a gravidade

■ Ao usar a ferramenta Walk, clique na guia Viewpoint ➤ painel

Navigate ➤ menu suspenso Realism  ➤ caixa de seleção
Gravity.
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Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Gravity
Entrada do comando: Ctrl+G

Crouching

OBSERVAÇÃO Esta função somente funciona em conexão a uma colisão.

Ao navegar ou voar em torno de um modelo com a colisão ativada, você pode
encontrar objetos que estão muito baixos para navegar abaixo dos mesmos,
uma tubulação baixa por exemplo. Esta função permite agachar sob quaisquer
destes tipos de objetos.

Com agachar ativado, você irá automaticamente se agachar sob qualquer
objeto que não pode ser navegado sob o mesmo com sua altura especificada,
portanto, não impedindo sua navegação em torno do modelo.

DICA Para se agachar temporariamente sob um objeto baixo, mantenha
pressionada a barra de espaço para permitir que a navegação prossiga.

Para alternar agachar-se

1 Ao usar a ferramenta Walk ou Fly, clique na guia Viewpoint ➤ painel

Navigate ➤ menu suspenso Realism  ➤ caixa de seleção
Crouch.

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Crouch

Collision

Esta função lhe define como um volume de colisão - um objeto 3D que pode
navegar e interagir com o modelo, obedecendo determinadas regras físicas
que lhe confinam dentro do próprio modelo. Em outras palavras, você tem
uma massa e como tal não pode passar através de outros objetos, pontos ou
linhas na cena.

Você pode navegar por cima ou subir nos objetos na cena que estejam a meia
altura do volume de colisão, portanto, permitindo subir escadas, por exemplo.
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O volume de colisão, em sua forma básica, é uma esfera (com um raio = r),
que pode receber a extrusão para lhe fornecer altura (com altura = h >= 2r).
Veja o diagrama abaixo:

As cotas do volume de colisão podem ser personalizadas para o ponto de vista
atual ou como uma opção global.

OBSERVAÇÃO A colisão somente pode ser usada com as ferramentas de navegação
Walk e Fly.

Quando a colisão está ativada, a priorização da renderização é mudada, para
que os objetos em torno da câmera ou avatar sejam exibidos com muito mais
detalhes do que o normal. O tamanho da região de alto detalhe tem base no
raio do volume de colisão e na velocidade do movimento (sendo necessário
ver para o que se deve navegar).

Para alternar a colisão

1 Ao usar a ferramenta Walk ou Fly, clique na guia Viewpoint painel

 ➤ Navigate menu suspenso  ➤ Realism caixa de seleção 
 ➤ Collision.

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Collision
Entrada do comando: Ctrl+D
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Third Person View

Esta função permite navegar na cena de uma perspectiva de uma terceira
pessoa.

Quando a terceira pessoa está ativada, você será capaz de ver um avatar que
é uma representação de si próprio dentro do modelo 3D. Ao navegar você
estará controlando a interação do avatar com a cena atual.

Utilizar a terceira pessoa em conexão com a colisão e gravidade torna esta uma
poderosa função, permitindo-lhe visualizar exatamente como uma pessoa iria
interagir com o projeto intencionado.

Você pode personalizar as configurações, como a seleção do avatar, cota e
posicionamento, para o ponto de vista atual ou como uma opção global.

Quando a vista de terceira pessoa está ativada, a priorização da renderização
muda, para que os objetos em torno da câmera ou do avatar, sejam exibidos
com muito mais detalhes do que o normal. O tamanho da região de alto
detalhe tem base no raio do volume de colisão e na velocidade do movimento
(sendo necessário ver para o que se deve navegar), e a distância da câmera
atrás do avatar (para poder ver como que o avatar está interagindo).

Para alternar a vista da terceira pessoa

1 Clique na guia Viewpoint ➤ painel Navigate ➤ menu suspenso

Realism  ➤ caixa de seleção Third Person.
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Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Third Person

Entrada do comando: Ctrl+T

Para alterar o avatar padrão

1 No Autodesk Navisworks, clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface e clique na opção
Viewpoint Defaults.

3 Clique no botão Configurações na área Colisão.

4 Na caixa de diálogo Colisão padrão, selecione a caixa de seleção Ativar
na área Terceira pessoa.

5 Clique em OK para retornar ao Editor de opções.

6 Clique em OK.

7 Reinicie o Autodesk Navisworks.

Para ativar ou desativar um avatar para o ponto de vista atual

1 No Autodesk Navisworks, clique na guia Viewpoint ➤ painel Save,

Load & Playback ➤ Edit Current Viewpoint  na faixa de opções.

2 Na caixa de diálogo Editar ponto de vista , clique no botão
Configurações na área Colisão.

3 Na caixa de diálogo Colisão, selecione a caixa de seleção Ativar na área
Terceira pessoa.

4 Selecione seu novo avatar na lista suspensa Avatar.

5 Clique em OK para retornar para a caixa de diálogo Editar ponto de
vista .

6 Clique em OK.
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Controlar a aparência
do modelo e a
qualidade de
renderização

Controlar a aparência do modelo
Você pode usar as ferramentas no painel Render Style na guia Viewpoint
para controlar como o seu modelo é exibido na Scene View.

As opções de iluminação interativa a seguir podem ser selecionadas (Full Lights,
Scene Lights, Head Light, ou No Lights), quatro modos de renderização
(Full Render, Shaded, Wireframe, or Hidden Line) e é possível ativar ou
desativar cada um dos cinco tipos primitivos (Surfaces, Lines, Points, Snap
Points e Text).

OBSERVAÇÃO Os modos Render (Renderização) e Lighting (Iluminação) não estão
disponíveis em uma área de trabalho 2D.

Selecionar o modo de renderização

A renderização atribui sombras à geometria da cena utilizando a iluminação
que foi definida e as configurações dos materiais e do ambiente selecionadas
(como o fundo).

No Autodesk Navisworks, é possível utilizar quatro modos de renderização para
controlar como os itens são renderizados na Scene View. As esferas abaixo
demonstram o efeito que os modos de renderização têm na aparência do modelo.
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A partir da esquerda, a ordem é Full Render, Shaded, Wireframe e Hidden
Line.

Renderização completa

No modo Full Render o modelo é renderizado com um sombreado suave,
incluindo materiais aplicados utilizando a ferramenta Presenter, ou que
foram convertidos pelo arquivo CAD nativo.

Para selecionar o modo Full Render

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Mode e clique em Full Render  .

Menu: Interface de usuário Classic: Viewpoint ➤ Rendering ➤ Full
Render

Sombreado

No modo Shaded, o modelo é renderizado com um sombreado suave sem
texturas.

Para selecionar o modo Shaded

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Mode e clique em Shaded  .

Menu: Interface de usuário Classic: Viewpoint ➤ Rendering ➤ Shaded
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Estrutura de arame

No modo Wireframe o modelo é renderizado numa estrutura de arame.
Como o Autodesk Navisworks utiliza triângulos para representar superfícies e
sólidos, todas as arestas triangulares são visíveis neste modo.

Para selecionar o modo Wireframe

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Mode e clique em Wireframe  .

Menu: Classic user interface: Viewpoint ➤ Rendering ➤ Wireframe

Linha oculta

No modo Hidden Line, o modelo é renderizado na estrutura de arame, mas
apenas o contorno e as arestas da faceta das superfícies visíveis para a câmera
são exibidas.

OBSERVAÇÃO Diferente do modo de estrutura de arame, onde as superfícies são
renderizadas como transparentes, o modo de linha oculta renderiza as superfícies
como opacas.

Para selecionar o modo Hidden Line

■ Clique na guia Viewpoint painel  ➤ Render Style lista suspensa

 ➤ Mode e clique em Hidden Line  .

Menu: Interface de usuário clássica: Viewpoint ➤ Rendering ➤ Hidden
Line

Adicionar iluminação

No Autodesk Navisworks, é possível utilizar quatro modos de iluminação para
controlar como a cena 3D será iluminada.

As esferas abaixo demonstram o efeito que os estilos de iluminação têm nelas.
Da esquerda para a direita, a ordem é: Full Lights, Scene Lights, Head
Light e No Lights.
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Luzes completas

Este modo utiliza luzes que foram definidas com a ferramenta Presenter.

Para utilizar luzes definidas pela ferramenta Presenter

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Lighting e clique em Full Lights  .

Menu: Classic user interface: Viewpoint ➤ Lighting ➤ Full Lights

Luzes de cena

Este modo utiliza as luzes que foram trazidas através do arquivo CAD nativo.
Se nenhuma luz estiver disponível, serão utilizadas duas luzes padrão opostas.

Você pode personalizar a intensidade das luzes de cena na caixa de diálogo
File Options.

Para utilizar as luzes definidas com o modelo

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Lighting e clique em Scene Lights  .

Menu: Classic user interface: Viewpoint ➤ Lighting ➤ Scene Lights

Para ajustar a intensidades das luzes da cena

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Scene Lights.

3 Mova o deslizador Ambient para ajustar o brilho da cena.
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DICA Ativar o modo de luzes de cena antes de seguir este procedimento
permite ver instantaneamente o efeito que suas alterações têm sobre a
renderização da cena.

4 Clique em OK.

Luz frontal

Este modo utiliza uma única luz direcional localizada na câmera que sempre
aponta na mesma direção da câmera.

É possível personalizar as propriedades de Head Light (Luz frontal) na caixa
de diálogo File Options, (guia Home painel  ➤ Project).

Para utilizar o modo Head Light

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Lighting e clique em Head Light  .

Menu: Interface de usuário Classic: Viewpoint ➤ Lighting ➤ Head
Light

Para ajustar a intensidade da Head Light

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Headlight.
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3 Mova o deslizador Ambient para ajustar o brilho da cena, e o deslizador
Headlight para ajustar o brilho da luz direcional.

DICA Ativar o modo Head Light antes de seguir este procedimento permite
ver instantaneamente o efeito que suas alterações têm sobre a renderização
da cena.

4 Clique em OK.

Nenhuma luz

Este modo desliga todas as luzes. A cena é renderizada com uma renderização
plana.

Para desligar todas as luzes

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Lighting e clique em No Lights  .

Menu: Interface de usuário Classic: Viewpoint ➤ Lighting ➤ No Lights
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Selecionar o efeito do segundo plano

No Autodesk Navisworks, você pode escolher um efeito de segundo plano para
usar na Scene View.

No momento, as seguintes opções estão disponíveis:
■ Plain - o segundo plano da cena 3D é preenchido com a cor selecionada.

Este é o estilo padrão de segundo plano. Ele pode ser usado para modelos
3D e folhas 2D.

Segundo plano simples

■ Graduated - o segundo plano da cena é preenchido com um gradiente
suave entre as duas cores selecionadas. Este segundo plano pode ser utilizado
para modelos 3D e folhas 2D.

Segundo plano graduado

■ Horizon - o segundo plano da cena 3D é dividido no plano horizontal
dando o efeito de céu e terra. O horizonte artificial resultante lhe fornece
uma indicação de sua orientação no universo 3D. Por padrão, o
horizonte artificial respeita o vetor para cima, como definido
em File Options  ➤  Orientation.. Este segundo plano não é suportado
para folhas 2D.
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OBSERVAÇÃO O horizonte artificial é um efeito no segundo plano e não inclui
um plano de chão físico. Por exemplo, se navegar "abaixo do solo" e olhar
para cima, não irá visualizar o fundo de um plano de chão, ao invés disso terá
uma vista de baixo do modelo, preenchida com a cor do céu.

Segundo plano de horizonte

Para definir um segundo plano simples

1 Clique na guia View  ➤  Scene View  ➤  Background  .

2 Na caixa de diálogo Background Settings , selecione Plain na lista
suspensa Mode.

3 Selecione a cor requerida na paleta Color.

4 Reveja o novo efeito de fundo na caixa anterior e clique em OK.

Para definir um segundo plano graduado

1 Clique na guia View ➤ Scene View ➤ Background  .

2 Na caixa de diálogo Background Settings , selecione Graduated na
lista suspensa Mode.

3 Selecione a primeira cor na paleta Top Color.

4 Selecione a segunda cor na paleta Bottom Color.

5 Reveja o novo efeito de fundo na caixa anterior e clique em OK.

Para definir um segundo plano de horizonte artificial para um modelo 3D

1 Clique na guia View ➤ Scene View ➤ Background  .

2 Na caixa de diálogo Background Settings , selecione Horizon na
lista suspensa Mode.
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3 Para definir uma cor de céu graduada, utilize as paletas Sky Color e
Horizon Sky Color.

4 Para definir uma cor de chão graduada utilize as paletas Horizon
Ground Color e Ground Color.

5 Reveja o novo efeito de fundo na caixa anterior e clique em OK.

Ajustar a exibição de primitivos

É possível habilitar ou desabilitar o desenho de Surfaces, Lines, Points,
Snap Pointse 3D Text na Scene View.

Points são pontos reais no modelo, enquanto Snap Points marcam
localizações em outros primitivos, por exemplo o centro de um círculo, e são
úteis para o snap durante a medição.

Superfícies

Superfícies são os triângulos que compõem os itens 2D e 3D na cena. Você
pode alternar a renderização de superfícies no modelo.

Para alternar a renderização de superfícies

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Mode e clique em Surfaces  .

Menu: Interface de usuário Classic: Viewpoint ➤ Display ➤ Surfaces

Linhas

Você pode alterar a renderização de linhas no modelo. Você também pode
alterar a largura de linhas desenhadas utilizando o Options Editor.

Para alternar a renderização de linhas

■ Clique na guia Viewpoint ➤ painel Render Style ➤ Lines  .

Menu: Classic user interface: Viewpoint ➤ Display ➤ Lines
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Para alterar a largura da linha

1 Clique no botão do aplicativo  ➤  Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display.

3 Na página Display , área Primitives , insira um número entre 1 e 9
na caixa Line Size.

Isto define a largura em pixels para linhas desenhadas na Scene View.

4 Clique em OK.

Pontos

Pontos são pontos reais no modelo como, por exemplo, os pontos em uma
nuvem de pontos em um arquivo de digitalização a laser. Você pode alternar
a renderização de pontos no modelo. Você também pode alterar o tamanho
de pontos desenhados utilizando o Options Editor.

Para alternar a renderização de pontos

■ Clique na guia Viewpoint ➤ painel Render Style ➤ Points  .

Menu: Interface de usuário Classic: Viewpoint ➤ Display ➤ Points

Para alterar o tamanho dos pontos

1 Clique no botão do aplicativo  ➤  Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Primitives , insira um número entre 1 e 9
na caixa Point Size.

Isto define o tamanho em pixels para pontos desenhados na Scene
View.

4 Clique em OK.
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Pontos de snap

Os pontos de snap são pontos implícitos no modelo, por exemplo, o ponto
central de uma esfera ou pontos finais de um tubo. Você pode alternar a
renderização do ponto de snap no modelo 3D. Você também pode alterar o
tamanho dos pontos de snap desenhados utilizando o Options Editor.

OBSERVAÇÃO Você pode alternar a renderização de pontos de snap para folhas
2D.

Para alternar a renderização de pontos de snap

■ Clique na guia Viewpoint painel  ➤ Render Style ➤ Snap Points
.

Para alterar o tamanho dos pontos de snap

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Primitives , insira um número entre 1 e 9
na caixa Snap Size.

Isto define o tamanho em pixels de pontos de snap desenhados na Scene
View.

4 Clique em OK.

Texto

Você pode alternar a renderização de texto em modelos 3D. Esta função não
é suportada para folhas 2D.

Para alternar a renderização de texto 3D

■ Clique na guia Viewpoint ➤ painel Render Style ➤ Text  .

Menu: Classic user interface: Viewpoint ➤ Display ➤ Text
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Controlar a qualidade da renderização

Utilizar a seleção

A seleção permite navegar e manipular cenas grandes e complexas em taxas
interativas ao ocultar de forma inteligente objetos menos importantes enquanto
você trabalha.

No Autodesk Navisworks, você pode utilizar os seguintes métodos para
selecionar objetos:
■ Area - o tamanho do objeto em pixels determina se os objetos são ou não

renderizados. Por padrão, quaisquer objetos menores do que 1x1 pixels de
tamanho são descartados.

■ Backface - por padrão, somente a face frontal de cada polígono é
desenhada no Autodesk Navisworks. Algumas vezes, durante o processo
de conversão, a face frontal e traseira de polígonos se misturam, em cujo
caso é necessário ajustar a opção Backface.

■ Near and Far Clipping Planes (seleção de tronco) - objetos mais perto
da câmera do que o plano de recorte próximo ao além do plano de recorte
afastado, não são desenhados. Você pode deixar que o Autodesk Navisworks
restrinja automaticamente a localização dos planos de recorte ou pode
restringir manualmente sua localização.

OBSERVAÇÃO As opções Backface e Clipping Planes não são utilizadas em
um espaço de trabalho 2D.

Para definir a seleção da área

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione a caixa de
seleção Enable na seção Area.

3 Insira uma valor para a área de tela em pixels abaixo do qual os objetos
de geometria são selecionados. Por exemplo, definir este valor como 100
pixels significa que qualquer objeto dentro do modelo que seria
desenhado com um tamanho menor do que 10x10 pixels será descartado.

4 Clique em OK.
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Para ativar a seleção da face traseira para todos os objetos em uma área de
trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione On na área
Backface.

3 Clique em OK.

Para desativar a seleção da face traseira para todos os objetos em um espaço
de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione Off na área
Backface.

3 Clique em OK.

Para ativar a seleção da face traseira somente para os objetos sólidos em uma
área de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione Solid na
área Backface.

3 Clique em OK.

Para restringir automaticamente a posição dos planos de recorte em um
espaço de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Culling.

3 Selecione Automatic para o plano de recorte Near.

4 Selecione Automatic para o plano de recorte Far.

5 Clique em OK.

O Autodesk Navisworks controla automaticamente a posição dos planos
de recorte próximos e afastados para oferecer a melhor vista do modelo.

Para restringir manualmente a posição dos planos de recorte em um espaço
de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Culling.
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3 Selecione Constrained para o plano de recorte Near , e insira o valor
desejado na caixa Distance.

4 Selecione Constrained para o plano de recorte Far , e insira o valor
desejado na caixa Distance.

5 Clique em OK.

O Autodesk Navisworks utiliza os valores fornecidos, a não ser que isto
afete o desempenho do sistema (por exemplo, torna todo o modelo
invisível), em qual caso ele ajusta a posição dos planos de recorte como
necessário.

Para fixar a posição dos planos de recorte em um espaço de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Culling.

3 Selecione Fixed para o plano de recorte  Near , e insira o valor desejado
na caixa Distance.

4 Selecione Fixed para o plano de recorte Far , e insira o valor desejado
na caixa Distance.

5 Clique em OK.

IMPORTANTE O Autodesk Navisworks utiliza os valores fornecidos, a não
ser que isto afete o desempenho do sistema (por exemplo, torne todo o
modelo invisível).

Tornar objetos como necessários

Embora o Autodesk Navisworks prioriza de forma inteligente os objetos para
a seleção na cena, algumas vezes ele descarta geometria que precisa permanecer
visível ao navegar.

Você pode assegurar que os objetos sempre são renderizados durante a
navegação interativa tornando-os necessários.

Para tornar os objetos como necessários

1 Selecione os itens de geometria que deseja que permaneçam visíveis
durante a navegação na Selection Tree.

2 Clique na guia Home painel  ➤ Visibility ➤ Require  .
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Na Selection Tree, o objeto aparece em vermelho quando ele for
necessário.

DICA Clicar novamente em Require  torna os objetos selecionados não
necessários.

Menu: Classic user interface: Edit ➤ Required
Entrada do comando: Ctrl+R

Faixa de opções:  Guia Item Tools ➤ painel Visibility ➤ Require

Para tornar todos os objetos desnecessários

■ Clique na guia Home ➤ painel Visibility ➤ lista suspensa Unhide
All ➤ Unrequire All  .

Menu de atalho: Scene ➤ Reset All ➤ Unrequire All

Controlar a renderização de objetos

Ajustar a renderização da cena durante a
navegação

Seus modelos podem variar de tamanho, de pequenos modelos a supermodelos
complexos. Quando você navega em tempo real na cena, o Autodesk
Navisworks automaticamente calcula quais itens renderizar primeiro, com
base no tamanho dos itens, distância da câmera e a frequência de quadro
especificada. Esta frequência de quadro personalizável é garantida por padrão,
mas pode ser desativada, se necessário. Itens para os quais o Autodesk
Navisworks não tiver tempo para renderizar serão descartados. Estes itens
descartados são renderizados quando a navegação pára.

A quantidade de descarte depende de diversos fatores, como o desempenho
do seu hardware (placa gráfica e driver), o tamanho da Scene View, e o
tamanho do modelo. Ao trabalhar com supermodelos realmente grandes no
Autodesk Navisworks, será necessário tem um montante suficiente de RAM
para carregar e rever os dados.

O Autodesk Navisworks emprega a tecnologia JetStream que otimiza a utilização
da RAM disponível. Antes de ficar sem memória, o Autodesk Navisworks pagina
dados desnecessários para o disco rígido, liberando espaço para que o
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carregamento continue. A tecnologia JetStream também permite iniciar a
navegar no supermodelo, antes que ele seja completamente carregado na
memória. O Autodesk Navisworks está ciente de endereços grandes, e utiliza
qualquer atribuição de memória adicional segundo a chave 3GB disponível
nos sistemas Windows XP.

DICA Você pode reduzir o montante de descarte durante a navegação ao reduzir
a frequência de quadro, ou desativando a opção Guarantee Frame Rate.

Para definir a frequência de quadro alvo

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Speed , selecione o número de
quadros por segundo a ser aplicado na exibição renderizada do modelo.

3 Clique em OK.

Para definir o nível de detalhe

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Detail , selecione a caixa de seleção
Guarantee Frame Rate para manter a frequência de quadro alvo
durante a navegação. Se esta caixa de seleção estiver desmarcada, o
modelo completo é renderizado durante a navegação, não importando
quanto tempo levar.

4 Selecione a caixa de seleção Fill in Detail para renderizar um modelo
completo quando a navegação pára. Se esta caixa de seleção estiver
desmarcada, os itens descartados durante a navegação não são
preenchidos quando a navegação pára.

5 Clique em OK.

Para renderizar itens transparentes

Observação: Se a sua placa de vídeo suporta o OpenGL acelerado por
hardware, você pode ativar a renderização de itens transparentes durante a
navegação interativa. Por padrão, os itens transparentes somente são

206 | Capítulo 6   Controlar a aparência do modelo e a qualidade de renderização



desenhados quando a interação parou de prevenir problemas com o
desempenho de exibição.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Transparency , selecione a caixa de seleção
Interactive Transparency.

4 Clique em OK.

Para renderizar primitivos paramétricos

Observação: a modificação desta opção requer a reinicialização do Autodesk
Navisworks para que tenha efeito.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Primitives , selecione a caixa de seleção
Enable Parametric Primitives. O nível de detalhe muda durante a
navegação dependendo da distância da câmera.

Se você deseja utilizar as representações padrão de primitivos, desmarque
esta caixa de seleção. O nível de detalhe permanece o mesmo durante a
navegação.

Clique em OK.

Acelerar o desempenho de exibição

Se sua placa de vídeo suporta o OpenGL, você pode aprimorar o desempenho
gráfico ao ativar a aceleração por hardware e a seleção de obstrução.

A utilização da aceleração do hardware normalmente fornece um renderização
melhor e mais rápida. No entanto, alguma placas gráficas podem não funcionar
bem neste modo, em qual caso se recomenda desativar esta opção.

A seleção de obstrução pode aprimorar significativamente o desempenho em
situações onde a maior parte do modelo não está visível. Por exemplo, quando
você anda em um corredor em um edifício, as paredes obstruem a maioria da
geometria fora do corredor. Outros ambientes somente são visíveis através de
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aberturas de portas ou janelas. Desativar a seleção de obstrução reduz muito
a carga de renderização nestes casos.

Para utilizar a aceleração por hardware

OBSERVAÇÃO: se sua placa de vídeo não suporta a aceleração por hardware
OpenGL, esta opção não está disponível.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Acceleration , selecione a caixa de seleção
Hardware Acceleration. Isto permite que o Autodesk Navisworks
utilize qualquer aceleração por hardware OpenGL disponível em sua
placa de vídeo.

OBSERVAÇÃO Se os drivers de sua placa de vídeo não funcionam bem com
o Autodesk Navisworks, desmarque esta caixa de seleção.

4 Clique em OK.

Para utilizar a seleção de obstrução

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Acceleration , selecione a caixa de seleção
Occlusion Culling.

4 Clique em OK.

OBSERVAÇÃO A seleção de obstrução somente pode ser utilizada em uma
máquina com uma placa gráfica compatível com o OpenGL. Além disso, a seleção
da oclusão não é utilizada em uma área de trabalho 2D.

Ajustar materiais no Presenter

É possível ajustar a aparência dos materiais do Presenter na Scene View
para melhorar o desempenho da placa de vídeo ao navegar em cenas com
muita textura.
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Consulte também:

Página Presenter

Renderização em estéreo

A visualização estereoscópica no Autodesk Navisworks permite a visualização
do modelo 3D através de hardware estéreo, incluindo lentes de visualização
estéreo ativas e passivas em conjunto com telas CRT e projetores dedicados.

IMPORTANTE A utilização da renderização em estéreo requer que o computador
host tenha uma placa gráfica OpenGL com suporte de estéreo. Adicionalmente,
alguns drivers requerem que o estéreo seja explicitamente ativado no driver e
pode requerer menor configuração de cor ou resolução antes que a renderização
em estéreo esteja disponível.

Quando a saída de vídeo estiver no modo estéreo, a vista parece distorcida
sem as lentes corretas sendo utilizadas. Se a câmera estiver no modo ortogonal,
ela precisa ser definida com em perspectiva para que o efeito funcione
corretamente.

OBSERVAÇÃO Com a visão para cada olho precisa ser renderizada separadamente,
não é possível suportar o preenchimento incremental de detalhe no modo estéreo.
O detalhe aparece quando a renderização for completada. O andamento pode
ser visto utilizando a barra na área de status, e é possível interromper e iniciar
novamente a interação a qualquer momento.

Nos modos de navegação com base no ponto focal (como órbita, órbita livre
e órbita restrita), o modelo é posicionado para que as partes mais perto do que
o ponto focal apareçam na frente da tela com o resto atrás. Em outros modo
de navegação (como navegar e voar), o ponto focal é definido para que
qualquer avatar estará nivelado com a tela. Os objetos entre você o avatar irão
aparecer na frente da tela. Você pode ajustar o efeito fora da tela na caixa de
diálogo Stereo Options.

Para ativar a renderização em estéreo

■ Clique na guia View ➤ painel Stereo ➤ Enable Stereo  .

OBSERVAÇÃO Esta opção somente está disponível se você tiver o hardware
requerido e as configurações corretas do driver e de exibição.
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Para ajustar os efeitos de estéreo

1 Clique na guia View ➤ painel Stereo ➤ iniciador de ferramentas
Stereo Options  .

2 Na caixa de diálogo Stereo Options , mova o deslizador Magnitude
para variar a intensidade do efeito.

3 Para ajustar o efeito fora da tela, selecione a caixa de seleção Enable , e
a seguir mova o deslizador para controlar quanto da cena aparece fora
da tela durante a navegação.

4 Se precisar intercambiar os olhos esquerdo e direito, selecione a caixa de
seleção Swap Eyes. Isto pode ser útil ao mover do CRT para um projeto
de tela grande e de volta.

5 Clique em OK.
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Revisar seu modelo

Selecionar objetos
O Autodesk Navisworks fornece diversos métodos para selecionar interativamente
os itens.

Seleção interativa da geometria

No Autodesk Navisworks, há um conceito de um conjunto de seleção ativo (os
itens atualmente selecionados ou a seleção atual) e de conjuntos de seleção
salvos. Você não pode salvar qualquer conjunto de seleção ou de pesquisa, mas
pode utilizar os conjuntos de seleção e ou de pesquisa salvos no modelo (a guia
Sets na Selection Tree).

A seleção de itens os torna parte da seleção atual, portanto, é possível ocultá-los
ou sobrepor suas cores.

É possível utilizar diversos métodos para selecionar itens interativamente na
seleção atual. É possível usar as guias na Árvore de seleção, selecione os itens
diretamente na Vista da cena com as ferramentas Selecionar e Selecionar
caixa e pode selecionar itens com propriedades similares à seleções existentes
usando os comandos de seleção.

OBSERVAÇÃO Clicar com o botão direito em qualquer item na Selection Tree
ou Vista da cena abre um menu de atalho.

7
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Janela Selection Tree

A Selection Tree é uma janela encaixável que exibe uma variedade de vistas
hierárquicas da estrutura do modelo, como definido pelo aplicativo de CAD
no qual o modelo foi criado.

O Autodesk Navisworks utiliza esta estrutura hierárquica para identificar
caminhos específicos de objeto (do nome do arquivo até um determinado
objeto).

Por padrão há quatro guias:
■ Standard. Exibe a hierarquia da árvore padrão, incluindo todas as

instâncias.

■ Compact. Exibe uma versão simplificada da hierarquia na guia Standard
omitindo vários itens; É possível personalizar o nível de complexidade
desta árvore no Options Editor.

■ Propriedades Exibe a hierarquia com base nas propriedades dos itens.
Isto permite uma pesquisa manual simples no modelo por propriedade de
item.

■ Sets. Exibe uma lista dos conjuntos de seleção e pesquisa. Caso nenhum
conjunto de seleção e pesquisa tiver sido criado, esta guia não é exibida.

O nome dos itens reflete os nomes do aplicativo de CAD original, sempre que
for possível. É possível copiar e colar nomes da Selection Tree. Para fazer
isto, clique com o botão direito na Selection Tree, e clique em Copy Name
no menu de contexto. Alternativamente, é possível clicar em um item na
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Selection Tree, e pressionar CTRL + C. O nome agora foi copiado para a área
de transferência.

Há diferentes ícones de árvore representando os tipos de geometria que
compõem a estrutura do modelo. Cada um destes itens podem ser marcados
como ocultos (cinza), não oculto (azul escuro) ou requerido (vermelho).

OBSERVAÇÃO Se um grupo estiver marcado como oculto ou requerido, então
todas as instâncias daquele grupo são marcadas como oculto ou requerido. Caso
deseje operar em uma única ocorrência de um item, então você deverá marcar o
grupo em instâncias (o nível acima ou o 'principal' na hierarquia) como oculto ou
requerido.

Para alternar a Selection Tree

■ Clique em: guia Home painel  ➤ Select & Search ➤ Selection Tree
.

Menu: Classic user interface: View ➤ Control Bars ➤ Selection Tree
Entrada do comando: CTRL + F12

Para usar a opção Árvore de seleção para selecionar objetos

1 Abra a Selection Tree, e clique na guia Standard.

2 Clique em um objeto na Selection tree para selecionar a geometria
correspondente na Vista da cena.

OBSERVAÇÃO Quando você seleciona um item na árvore, a geometria
individual ou um grupo de geometrias é selecionado na Vista da cena
dependendo da resolução de seleção escolhida.

3 Para selecionar múltiplos itens ao mesmo tempo, utilize as teclas SHIFT
e CTRL. CTRL permite a múltipla seleção de item por item e SHIFT
permite a múltipla seleção entre o primeiro e último item selecionado.

4 Para remover a seleção de um objeto na Selection Tree pressione Esc.

Para personalizar o conteúdo da guia Compact

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Selection.
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3 Na página Selection , selecione o nível de detalhe requerido na caixa
Compact Tree. Escolha entre as seguintes opções:
■ Models - a árvore é restrita para somente exibir arquivos de modelo.

■ Layers - a árvore pode ser expandida para o nível de camada.

■ Objects - pode ser expandida para o nível de objetos, mas sem os
níveis de instâncias mostrados na guia Standard.

4 Clique em OK.

DescriçãoÍcone

Um modelo, como um arquivo de desenho
ou um arquivo de projeto.

Uma camada ou nível.

Um grupo, como uma definição de bloco
do AutoCAD ou uma definição de célula do
MicroStation.

Um grupo em instâncias, como um bloco
inserido do AutoCAD ou de uma célula do
MicroStation. Se no arquivo importado a
instância não estava nomeada, o Autodesk
Navisworks nomeia a instância para
coincidir com o nome de seu secundário.

Um item de geometria, como um polígono.

Um item em instância da geometria, como
uma instância do 3D Studio.

Um objeto composto. Um único objeto de
CAD que é representado no Autodesk
Navisworks por um grupo de itens de
geometria.

O conjunto de seleção salvo.
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DescriçãoÍcone

O conjunto de pesquisa salvo.

Ferramentas de seleção

Existem duas ferramentas de seleção (Select  e Select Box  ) disponíveis
na guia Home ➤ painel Select & Search para controlar o modo de seleção
de geometria.

Normalmente, o uso de ferramentas de seleção é mutuamente exclusivo à
utilização das ferramentas de navegação (consulte Ferramentas de navegação
específicas do produto na página 111; portanto, quando você estiver
selecionando não poderá navegar e vice-versa.

OBSERVAÇÃO Ao utilizar um mouse 3D 3Dconnexion em conjunto com o controle
padrão do mouse, o 3Dconnexion pode ser configurado para a navegação e o
mouse para a seleção. Consulte Mouse 3D 3Dconnexion na página 173 para obter
mais informações.

Selecionar geometria na Vista da cena automaticamente seleciona os objetos
correspondentes na Selection Tree.

Manter pressionada a tecla SHIFT ao selecionar itens na Vista da cena efetua
o ciclo através da resolução de seleção, lhe permitindo ser mais específico com
suas seleções.

É possível utilizar o Options Editor para personalizar a distância que existe
de um item para que ele seja selecionado (raio de seleção). Isto é útil quando
você seleciona linhas e pontos.

Ferramenta Select

A ferramenta Select lhe permite selecionar itens na Vista da cena com um
clique do mouse. A ferramenta é ativada ao clicar na guia Home ➤ painel

Select & Search ➤ menu suspenso Select ➤ Select  . Após um item
único ter sido selecionado, suas propriedades são exibidas na janela
Properties.
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Ferramenta Select Box

No modo de caixa de seleção, você pode selecionar múltiplos itens no modelo
ao arrastar a caixa retangular em torno da área que deseja que seja tornada
sua seleção atual.

Para selecionar geometria com a ferramenta Select

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

Select ➤ Select  .

2 Clique em um item na Vista da cena para selecioná-lo.

3 Para selecionar múltiplas geometrias, mantenha pressionada a tecla CTRL
ao clicar nos itens na cena.

4 Para remover itens da seleção atual, mantenha pressionada a tecla CTRL
ao clicar neles novamente. Outra alternativa é pressionar a tecla ESC
para remover todos os itens da seleção atual.

Menu: Classic user interface: Edit ➤ Select ➤ Select
Entrada do comando: Ctrl+1

Para selecionar geometria com a ferramenta Select Box

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

Select ➤ Select Box  .

2 Arraste a caixa com o botão esquerdo do mouse sobre a Vista da cena
para selecionar todos os itens na caixa.

DICA Manter pressionada a tecla SHIFT ao arrastar a caixa, seleciona todos
os itens dentro e que efetua a intersecção com a caixa.

3 Para selecionar múltiplas geometrias, mantenha pressionada a tecla CTRL
ao arrastar a caixa na cena.

4 Para remover itens da seleção atual, pressione a tecla Esc.

Para definir o raio de seleção

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção
Selection.

216 | Capítulo 7   Revisar seu modelo



3 Na página Selection , insira o raio em pixels no qual o tem de estar para
poder ser selecionado. Os valores válidos são entre 1 e 9.

4 Clique em OK.

Comandos de seleção

Os comandos de seleção permitem alterar com rapidez a seleção atual utilizando
a lógica. É possível selecionar vários itens com base nas propriedades dos itens
selecionados atuais, ou inverter rapidamente o conjunto, selecionar tudo ou
nada.

Para selecionar todos os itens no modelo

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

 ➤ Select All  .

Para anular a seleção de todos os itens

■ Clique na guia Home painel  ➤ Select & Search ➤ menu suspenso

Select All ➤ Select None  .

Para inverter a sua seleção atual

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

Select All ➤ Invert Selection  .

Itens atualmente selecionados são deselecionados, e os itens atualmente
deselecionados são selecionados.

Para selecionar todas as instâncias do grupo de geometria selecionado

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Select Same ➤ Select Multiple Instances  .

Para selecionar todos os itens com o mesmo nome que o item selecionado
atualmente

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Select Same ➤ Same Name  .
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Para selecionar todos os itens com o mesmo tipo que o item selecionado
atualmente

■ Clique na guia Home painel  ➤ Select & Search menu suspenso
 ➤ Select Same ➤  Same Type.

Para selecionar todos os itens com a mesma propriedade que o item
selecionado atualmente

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Select Same ➤ Same <Property>.

Para usar um conjunto de seleção ou pesquisa salvo

■ Abra a janela Selection Tree, e clique na guia Sets.

Os comandos de seleção são os seguintes:
■ Select All. Seleciona todos os itens contidos dentro do modelo.

■ Select None. Anula a seleção de tudo dentro do modelo.

■ Inverter seleção. A seleção dos itens atualmente selecionados é anulada
e vice versa.

■ Select Multiple Instances. Seleciona todas as instâncias (algumas
chamadas inserções do grupo da geometria selecionada atual que ocorre
no modelo.

■ Select Same Name. Seleciona todos os itens no modelo que têm o mesmo
nome que o item atualmente selecionado.

■ Select Same Type. Seleciona todos os itens no modelo que têm o mesmo
tipo que o item atualmente selecionado.

■ <Property>. Select Same. Seleciona todos os itens com a mesma
propriedade que o item selecionado atualmente. Esta propriedade pode ser
qualquer propriedade pesquisável atualmente anexada ao item, por exemplo
material ou link.

OBSERVAÇÃO O uso do comando <Property> Select Same funciona através
da comparação das propriedades dos itens. Caso você tenha múltiplos itens
selecionados ao executar um comando de seleção do mesmo nome e tipo e
assim por diante, todos os tipos, nomes e propriedades dos itens na seleção
atual são comparados com as propriedades de todos os itens na cena. Os itens
com propriedades coincidentes com quaisquer propriedades dos itens no
momento selecionados são selecionados.
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Definir o método de realce

É possível usar o Options Editor para personalizar a cor e método do realce
de geometria selecionado na Vista da cena.

Há três tipos de realces:
■ Shaded

■ Wireframe

■ Tinted
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Para alternar o realce de objetos selecionados

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Selection.

3 Na página Seleção, área Highlight, selecione a caixa de verificação
Habilitar se quiser que os itens selecionados sejam ressaltados na Vista
da cena. Desmarque esta caixa de seleção se não desejar nenhum realce.

4 Clique em OK.

Para personalizar a forma com que os objetos são realçados

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Selection.

3 Assegure que a caixa de seleção Enabled esteja selecionada.

4 Use a lista suspensa Method para selecionar o tipo de realce desejado
(Shaded, Wireframe ou Tinted).

5 Clique na paleta Color para selecionar a cor realçada.

6 Se você selecionou Tinted na caixa Method , utilize o deslizador para
ajustar o Tint Level.

7 Clique em OK.

Ocultar objetos

O Autodesk Navisworks fornece ferramentas que podem ser utilizadas para
ocultar e exibir objetos ou grupos de objetos. Objetos ocultos não são
desenhados na Vista da cena.

Ocultar objetos selecionados

Você pode ocultar objetos na seleção atual para que não sejam desenhados na
Vista da cena. Isso é útil quando você deseja remover partes específicas do
modelo. Por exemplo, ao navegar pelo corredor do edifício, pode desejar ocultar
uma parede que esteja obstruindo a vista do cômodo ao lado.
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Ocultar objetos não selecionados

Você pode ocultar todos os itens com exceção dos atualmente selecionados,
para que eles não sejam desenhados na Vista da cena. Isso é útil quando
você somente deseja ver partes específicas do modelo.

OBSERVAÇÃO Na Selection Tree, os itens aparecem em cinza quando marcados
como ocultos.

Para ocultar objetos selecionados

1 Na Vista da cena, selecione todos os itens que deseja ocultar.

2 Clique na guia Home ➤ painel Visibility ➤ Hide  .

Os objetos selecionados agora estão invisíveis.

DICA Clicando novamente em Hide  são exibidos os objetos invisíveis.

Menu: Classic user interface: Edit ➤ Hidden
Entrada do comando: CTRL+H

Menu de atalho: Hide

Para tornar objetos não selecionados ocultos

1 Na Vista da cena, selecione todos os itens que deseja revisar.

2 Clique na guia Home ➤ painel Visibility ➤ Hide Unselected  .

Somente a geometria selecionada permanece visível.

DICA Clicando novamente em Hide Unselected  são exibidos os objetos
invisíveis.

Menu: Classic user interface: Edit ➤ Hide Unselected
Menu de atalho:  Hide Unselected

Para revelar todos os objetos ocultos

■ Clique na guia Home painel  ➤ Visibility menu suspenso  ➤ Unhide
All ➤ Unhide All  .

Menu de atalho: Scene ➤ Reset All ➤ Unhide All
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Encontrar objetos
Você pode executar uma pesquisa manual simples no modelo por propriedade
de item. Para fazer isso:
■ Na Selection Tree, clique na guia Properties , e clique na pesquisa de

propriedade salva na lista.

A geometria do modelo correspondente é selecionada na Vista da cena.

Quick Find

Para localizar e selecionar rapidamente os objetos, utilize o recurso Quick
Find.

Para encontrar itens rapidamente

1 Clique na guia Home ➤ painel Select & Search.

2 Na caixa de texto Quick Find, digite a sequência de caracteres para
pesquisar por nas propriedades de todos os itens. Esta pode ser uma
palavra ou algumas palavras. A pesquisa não faz distinção entre letras
maiúsculas e minúsculas.

3 Clique em Quick Find  . O Autodesk Navisworks encontra e seleciona
o primeiro item na Selection Tree que coincide com o texto inserido,
seleciona-o na Vista da cena, e para a pesquisa.

4 Para localizar mais itens, clique novamente em Quick Find  . Se houver
quaisquer outros itens que coincidam com o texto inserido, o Autodesk
Navisworks seleciona o próximo na Selection Tree, seleciona-o na
Vista da cena, e para a pesquisa. Cliques subsequentes encontram as
próximas instâncias.

Entrada do comando: Para abrir a caixa de diálogo Quick Find: CTRL
+ F. Para a caixa de diálogo Find Next: F3.

Localizar todas as folhas e os modelos que
contêm o objeto selecionado

É possível pesquisar um objeto em todos os modelos e folhas preparados no
Project Browser.
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Os modelos exportados para o Autodesk Navisworks podem ser integrados às
folhas 2D exportadas do mesmo aplicativo de projeto para formar um arquivo
de múltiplas folhas. Por exemplo, os modelos exportados do Autodesk Revit
para o formato de arquivo NWC, DWF ou DWF(x) podem ser integrados a
qualquer folha 2D exportada para os arquivos DWF/DWF(x) do mesmo projeto
do Revit. Isso permite selecionar um componente do modelo no ambiente 3D
e, a seguir, localizar e revisar o mesmo componente em uma representação
2D (como uma planta baixa ou um corte). De forma similar, é possível
selecionar um item na folha 2D e localizá-lo no modelo 3D e em outras folhas
2D.

Preparação de folhas/modelos a pesquisar

Quando você abre um arquivo de múltiplas folhas, nem todos os
modelos/folhas podem ter sido preparados para serem utilizados no Autodesk
Navisworks. Todos os modelos/folhas que requerem preparação são indicados
com o ícone Prepare  na janela Project Browser. Você pode usar o menu
de atalho Project Browser para preparar uma ou mais folhas ou modelos
(consulte Janela do navegador de projeto na página 104 ou é possível preparar
todos os modelos/folhas diretamente na janela Find Items in Other Sheets
and Models. O Autodesk Navisworks somente pesquisa modelos/folhas
preparados. Portanto, se alguma folha ou modelo em seu arquivo não tiver
sido preparado, ele não será incluído na pesquisa.

Janela Localizar itens em outras folhas e
modelos

A janela Find Items in Other Sheets and Models (Localizar itens em
outras folhas e modelos) é uma janela encaixável que permite pesquisar um
objeto em todas as folhas ou modelos preparados no Project Browser.
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A legenda no topo da janela indica o objeto selecionado no momento na
Scene View. O tipo de geometria é representado por um ícone na página 214
junto ao nome do objeto. Os ícones são os mesmos daqueles utilizados na
janela Selection Tree. Os resultados da pesquisa são exibidos na lista
Sheets/Models e contêm todas as folhas/modelos do arquivo que está aberto
atualmente no qual o objeto selecionado foi encontrado. Você pode classificar
os resultados clicando no cabeçalho da coluna desejada. Isso alterna a ordem
de classificação entre ascendente e descendente.

Para ativar a janela Find Item in Other Sheets and Models

■ Clique na guia View painel  ➤ Workspace menu suspenso  ➤ Windows
e selecione ou desmarque a caixa de seleção Find Item in Other Sheets
and Models.

Para localizar todas as folhas e modelos que contêm o objeto selecionado

1 Clique em  na barra de status para abrir a janela Project Browser.

2 Clique duas vezes na folha ou no modelo com o objeto que deseja
localizar em outras folhas e modelos e selecione a folha ou o modelo na
Scene View.
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3 Clique com o botão direito do mouse no objeto e clique em Find Item
in Other Sheets and Models no menu de atalho.

4 Se você visualizar um ícone de status do aviso  na janela Find Item
in Other Sheets and Models, clique no botão Prepare All. Uma vez
que todos os modelos/folhas tiverem sido preparados, você verá uma
lista de todos os modelos/folhas que contêm o objeto.

5 Selecione o modelo ou a folha na lista e clique em View para abrir. O
Autodesk Navisworks aplica o zoom no objeto selecionado.
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Botões

Prepare All Prepara todas as folhas e os modelos não preparados no arquivo
de múltiplas folhas aberto atualmente.

View Abre a folha ou o modelo selecionado no momento na Scene View.

Ícones de status

Nem todos os modelos/folhas podem ser pesquisados no arquivo de
múltiplas folhas aberto atualmente; ao menos uma folha ou um modelo ainda
não foi preparado.

Todos os modelos/folhas do arquivo de múltiplas folhas abertos
atualmente foram pesquisados e os resultados estão atualizados.
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Utilizar conjuntos de objetos
No Autodesk Navisworks, não é possível salvar nenhum conjunto de seleção
ou de pesquisa, mas é possível utilizar os conjuntos de seleção ou de pesquisa
salvos no modelo.

Os conjuntos de seleção armazenam um grupo de itens para posterior
recuperação. Não há nenhum inteligência por detrás deste conjunto - se o
modelo é modificado, os mesmos itens são selecionados (assumindo que ainda
estejam disponíveis no modelo) ao chamar novamente o conjunto de seleção.

Os conjuntos de seleção trabalham de forma similar, com exceção de que eles
salvam critérios de pesquisa ao invés dos resultados da seleção. Portanto, se
houver quaisquer conjuntos de pesquisa salvo no modelo, então utilize-os no
Autodesk Navisworks para executar a pesquisa e selecionar os objetos
resultantes.

Os conjuntos de seleção e de pesquisa podem ser nomeados e podem conter
comentários. Eles também podem ser realçados com ícones na Vista da cena,
para que quando um for clicado, o conjunto de seleção é restaurado para o
conjunto ativo e todos itens dentro dele são reselecionados.

Para selecionar itens do conjunto de seleção de pesquisa

1 Abra a janela Selection Tree, e clique na guia Sets.

2 Clique no conjunto de seleção ou de pesquisa salvo na lista.

Ao chamar novamente um conjunto de seleção, todos os itens que foram
selecionados quando o conjunto foi salvo, são reselecionados na seleção
atual.

Ao chamar novamente um conjunto de pesquisa, a pesquisa que foi salva
no conjunto é reexecutada, e quaisquer itens que coincidam com a
especificação selecionados na seleção atual.

Propriedades do objeto

Janela Properties

A janela Properties é uma janela encaixável, que possui uma guia dedicada
para categoria de propriedade associada com o objeto selecionado atualmente.
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Propriedades internas do arquivo, como as propriedades de transformação e
geometria, não são exibidas por padrão. O Options Editor permite ativar
isso.

Para alternar a janela Properties

■ Clique na guia View ➤ painel Workspace ➤ menu suspenso
Windows, e selecione ou desmarque a caixa de seleção Properties.

Menu: Classic user interface: View ➤ Control Bars ➤ Properties
Entrada do comando: Shift + F7

Para analisar as propriedades dos objetos

1 Selecione o objeto de interesse na Selection Tree, ou na Vista da
cena.

2 Abra a janela Properties , e utilize as guias para navegar entre as
categorias de propriedades disponíveis.

OBSERVAÇÃO Se mais de um objeto estiver selecionado, a janela
Propertiessomente mostra o número de itens selecionados e não mostra
nenhuma informações da propriedade.

Para adicionar guias com propriedades internas na janela Properties

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Developer.

3 Na página Developer , selecione a caixa de seleção Show Internal
Properties.
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4 Clique em OK.

Redefinir atributos de objeto
No Navisworks Freedom 2012, você tem a opção de redefinir os atributos do
objeto para o estado no qual foram importados dos arquivos CAD originais.
Isso irá remover qualquer cor, transparência e sobreposição de transformação
que possa ter sido aplicada no Navisworks Manage ou no Navisworks Simulate.

Redefinir para os valores originais

No Autodesk Navisworks, é possível redefinir os atributos do objeto de volta
para os valores nos arquivos de CAD originais.

Para restaurar a aparência original de um objeto ou grupo de objetos na sua
cena

Observação: Não é possível restaurar cores separadamente de transparências.

1 Selecione os objetos requeridos na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Appearance  ➤  Reset Appearance

 .

Para redefinir a aparência de todos os objetos na sua cena

Observação: Não é possível restaurar cores separadamente de transparências.
■ Clique na guia Início painel do  ➤  Project,  ➤  suspenso Reset All,  ➤ 

Appearances  .

Para redefinir a transformação para um objeto ou grupo de objetos em sua
cena

1 Selecione os objetos requeridos na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Transform  ➤  Reset Transform 
.
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Para redefinir a transformação para todos os objetos em sua cena

■ Clique na guia Início painel do  ➤  Project,  ➤  suspenso Reset All,  ➤ 

Transforms  .

Ferramentas de medição
As ferramentas de medição permitem medir entre pontos em itens no modelo.
Todas as medições são feitas em unidades de exibição na página 96.

A utilização de ferramentas de medição é mutuamente exclusiva à utilização
das ferramentas de navegação (consulte Ferramentas de navegação específicas
do produto na página 111), portanto, quando você estiver medindo não poderá
navegar e vice-versa.

Janela Measure Tools

A janela Measure Tools é uma janela encaixável, que contém diversos botões
no topo, que permitem selecionar o tipo de medição que deseja efetuar.

Para todas as medições, as coordenadas X, Y e Z do ponto Inicial e do ponto
Final são exibidas nas caixas de texto abaixo dos botões, junto com a
Diferença e a Distância absoluta. Se você utiliza a medição cumulativa,
como Point Line ou Accumulate, Distance mostra a distância acumulada
para todos os pontos registrados na medição.
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OBSERVAÇÃO Os valores da coordenada Z não estão disponíveis para as folhas
2D.

Para alternar a janela Measure Tools

■ Clique na guia Review  ➤  painel Measure  ➤  inicializador de ferramenta
Measure Options  .

Menu: Classic user interface: Tools  ➤  Measure

DescriçãoBotão

Mede a distância entre dois pontos.

Mede a distância entre um ponto base e
diversos outros pontos.

Mede a distância total entre múltiplos
pontos ao longo de uma rota.

Calcula a soma total de diversas medições
ponto-a-ponto.

Calcula um ângulo entre duas linhas.

Calcula uma área em um plano.

Mede a distância mais curta entre dois
objetos selecionados.

Limpa todas as linhas de medição na Vista
da cena.

Permite mover ou rotacionar um objeto.
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Medição

Você pode utilizar as ferramentas de medição para efetuar medições lineares,
angulares e de área, e para medir automaticamente a distância mais curta entre
dois objetos selecionados.

OBSERVAÇÃO Quando você mede, é preciso clicar em um ponto em um item
para registrar um ponto. Clicar no segundo plano não registra nada. É possível
reiniciar um comando de medição a qualquer momento ao clicar com o botão
direito, ao invés de clicar com o botão esquerdo, na Vista da cena. Isso inicia
novamente o comando de medição sem nenhum ponto registrado, como se você
tivesse escolhido um novo tipo de medição.

Os pontos finais de linhas de medição padrão são representados como pequenos
símbolos de cruz na Vista da cena, e todas as linhas sendo medidas como
uma linha simples entre pontos registrados.

Os pontos finais de linhas de medição que recebem o snap as linhas centrais,
são representados como símbolos de cruz com marcadores CL adicionais.

232 | Capítulo 7   Revisar seu modelo



É possível alterar a cor e espessura das linhas de medição, e alternar a exibição
de legendas de cota na Vista da cena.

Legendas de cota

Para medições com base na distância, a legenda da cota é desenhada para cada
segmento de linha. Para medições cumulativas, a legenda da cota mostra os
totais e é desenhada para o último segmento de linha. O texto é posicionado
relativo ao ponto central da linha.

Para medições angulares, um indicador de arco é exibido dentro dos ângulos,
com o centro do texto posicionado na linha invisível de bifurcação do ângulo.
Se um ângulo for muito agudo, a legenda será desenhada fora dele. Esta legenda
é fixa e não é redimensionada quando você aproxima ou afasta o zoom, a não
ser que as linhas de medição se tornem muito curtas na tela para acomodar o
arco, em cujo caso será ajustada.

O Options Editor permite alternar a ativação e a desativação das legendas
de cota.

Para medições de área, a legenda de cota é posicionada no centro da área sendo
medida.

Utilizando ferramentas de medição para transformar objetos

É possível utilizar ferramentas de medição para mover e rotacionar os objetos
selecionados no momento.

Para alterar a espessura e cor das linhas de medição

1 Abra a janelaMeasure Tools e clique em Options .

2 No Options Editor, na página Measure sob o nó Interface , insira
o número desejado na caixaLine Thickness.

3 Selecione a cor requerida na paleta Color. Por padrão, as linhas de
medição são brancas.

4 Clique em OK.

Para alternar as legendas de cota

1 Abra a janelaMeasure Tools e clique em Options .

2 No Options Editor, na página Measure sob o nó Interface , selecione
a caixa de seleção Show Measurement values in Vista da cena.

3 Clique em OK.

Ferramentas de medição | 233



Para medir a distância entre dois pontos

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point to Point  .

2 Clique nos pontos inicial e final da distância a ser medida na Vista da
cena.

A legenda de cota opcional exibe a distância medida.

Menu: Classic user interface: Review  ➤  Measure  ➤  Point to Point

Para manter o mesmo ponto inicial ao medir a distância entre dois pontos

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point to Multiple Points  .

2 Clique no ponto inicial e no primeiro ponto final a ser medido. Uma
linha de medição é exibida entre dois pontos.

3 Clique para registrar o próximo ponto final a ser medido.

4 Repita para medir pontos finais adicionais se necessário. A legenda de
cota opcional sempre exibe a última distância medida. Seus pontos iniciais
permanecem os mesmos durante a medição.

DICA Se deseja alterar o ponto inicial, clique com o botão direito na Vista
da cena, e selecione um novo ponto inicial.

Menu: Classic user interface: Review  ➤  Measure  ➤  Point to Multiple
Points

Para medir a distância total ao longo de uma rota

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point Line  .
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2 Clique no ponto inicial e no segundo ponto a ser medido.

3 Clique no próximo ponto ao longo da rota.

4 Repita para medir toda a rota. A legenda de cota opcional exibe a distância
total ao longo da rota selecionada.

DICA Se deseja alterar o ponto inicial, clique com o botão direito na Vista
da cena, e selecione um novo ponto inicial.

Menu: Classic user interface: Review  ➤  Measure  ➤  Point Line

Para calcular um ângulo entre duas linhas

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Angle  .

2 Clique em um ponto na primeira linha.

3 Clique na primeira linha no ponto onde ele efetua a intersecção com a
segunda linha.

4 Clique em um ponto na segunda linha. A legenda de cota opcional exibe
o ângulo calculado entre as duas linhas.

Menu: Classic user interface: Review  ➤  Measure  ➤  Measure Angle
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Para calcular a soma total de diversas medições ponto-a-ponto

1 Clique na guia Review painel  ➤ Measure menu suspenso

 ➤ Measure ➤ Accumulate  .

2 Clique no ponto inicial e final da primeira distância a ser medida.

3 Clique no ponto inicial e final da próxima distância a ser medida.

4 Repita para medir mais distâncias se necessário. A legenda de cota
opcional exibe a soma de todas as pedidas de ponto-a-ponto.

Menu: Classic user interface: Review ➤ Measure ➤ Accumulate

Para calcular uma área em um plano

1 Clique na guia Review ➤ painel Measure ➤ menu suspenso

Measure ➤ Area  .

2 Clique para registrar uma série de pontos para descrever o perímetro da
área que deseja calcular. A legenda de cota opcional exibe a área do
perímetro descrito desde o primeiro ponto, como projetado no plano do
ponto de vista.

OBSERVAÇÃO Para que seu cálculo seja mais preciso, todos os pontos
adicionados precisam estar no mesmo plano.
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Menu: Interface de usuário Classic: Review ➤ Measure ➤ Measure Area

Para medir a distância mais curta entre dois objetos

1 Mantenha pressionada a tecla CTRL e selecione dois objetos na Scene

View com a ferramenta de seleção  .

2 Clique na guia Review  ➤  painel Measure  ➤  Measure Shortest Distance

 .

A legenda de cota opcional exibe a distância mais curta entre os objetos
selecionados.

Menu: Classic user interface: Review  ➤  Measure  ➤  Measure Shortest
Distance

Para medir a distância mais curta entre dois objetos paramétricos

1 Mantenha pressionada a tecla CTRL e selecione dois objetos paramétricos

na Vista da cena com a ferramenta Select  .

2 Abra a janelaMeasure Tools e clique em Options .

3 No Options Editor, na página Measure sob o nó Interface , selecione
a caixa de seleção Use Center Lines, e clique em OK.

4 Clique na guia Review  ➤  painel Measure  ➤  Measure Shortest Distance

 .

A caixa Distance e a legenda opcional de cota exibem a distância mais
curta entre as linhas centrais dos objetos paramétricos selecionados.

Menu: Classic user interface: Review  ➤  Measure  ➤  Measure Shortest
Distance
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Para limpar linhas de medição

■ Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure  ➤ 

Clear  .

Menu: Classic user interface: Review ➤ Measure ➤ Clear

Para mover um objeto com uma ferramenta de medição

1 Selecione o objeto que você deseja mover.

2 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point Line  .

3 Clique no objeto selecionado para criar o primeiro ponto. Este é o ponto
inicial do qual o reposicionamento será calculado.

4 Clique no segundo ponto na cena. Este é o ponto para onde o objeto
será movido. Agora há uma linha conectando o ponto inicial e o ponto
final na Vista da cena.

5 Se você deseja ser capaz de mover o objeto diversas vezes, crie mais pontos
na cena.

OBSERVAÇÃO Você somente pode selecionar um ponto em outro objeto
na cena. Selecionar um ponto no 'espaço' não é uma opção válida. Para
reposicionar um objeto no 'espaço', é possível utilizar uma meta-alça de
tradução, ou se conhece a distância pela qual o objeto será movido, ao
sobrepor sua transformação.

6 Deslize o painel Measure, e clique em Transform Selected Items
para mover o objeto para o segundo ponto. Caso tenha múltiplos pontos
na cena, cada vez que clicar em Transform Objects, o objeto
selecionado é movido para o próximo ponto.
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Comentários e anotações

Exibir comentários e anotações

Não é possível adicionar comentários, anotações de linhas de marcação ou
identificadores no Autodesk Navisworks, mas é possível visualizar os
comentários, as linhas de marcação e os identificadores anexados ao ponto
de vista.

Janela Comments

A janela Comments é uma janela encaixável que permite visualizar
comentários.
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A janela Comments mostra o nome, hora e data, autor, ID, status e assunto
(ou primeira linha) para cada comentário. Há diferentes ícones que ajudam a
identificar a origem de cada comentário em uma rápida olhada.

Para alternar a janela Comments

■ Clique na guia Review ➤ painel Comments ➤ View Comments
.

Menu: Classic user interface: View  ➤  Control Bars  ➤  Comments

Para visualizar comentários

1 Abra a janela Comments.

2 Siga para a origem de seus comentários. Por exemplo, abra a janela
Pontos de visão salvos.

3 Quando você clica nos pontos de origem, por exemplo, pontos de visão
, os comentários associados são exibidos na janela Comments.

DescriçãoÍcone

Ponto de visão (orthographic camera)

Ponto de visão (perspective camera)

Animação do ponto de visão

Corte da animação do ponto de visão
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DescriçãoÍcone

Tag

Exibir linhas de marcação e Identificadores

Para exibir linhas de marcação e identificadores, é preciso chamar o ponto de
vista no qual eles estão contidos.

Para visualizar linhas de marcação

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback
inicializador de ferramenta  ➤ Saved Viewpoints  .

2 Clique no ponto de vista desejado na janela Pontos de visão salvos.
Todas as linhas de marcação anexadas (se houverem) são exibidas na
Vista da cena.

Para exibir linhas de marcação e identificadores

■ Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Saved Viewpoints, e selecione o ponto de vista que deseja
chamar.

O ponto de vista é exibido na Vista da cena junto com qualquer anotação
de linha de marcação e identificadores.
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Links
Há diversas origens de links no Autodesk Navisworks: links originais que foram
convertidos de arquivos nativos de CAD, links que forma adicionados por
usuários do Autodesk Navisworks, e links que forma automaticamente gerados
pelo programa (por exemplo, links de ponto de vista).

Os links convertidos de arquivos nativos de CAD e os links adicionados por
usuários do Autodesk Navisworks, são tratados como propriedades do objeto.
Isto significa que você pode examiná-los na janela Properties.

Todos os links são salvos com arquivos do Autodesk Navisworks, portanto,
quando o modelo é modificado, os links permanecem aqui para que você e
outros o visualizem.

Categorias de links

Há dois tipos de links: padrão e definidos pelo usuário.

Links padrões são divididos nas seguintes categorias:
■ Hyperlink

■ Label

■ Pontos de visão

■ Redline tags
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Por padrão, todos os links exceto legendas, são desenhados como ícones na
Vista da cena. Legendas são desenhadas como texto.

Se disponíveis, por padrão, os links definidos pelo usuário são desenhados
como ícones na Vista da cena.

Você pode utilizar o Options Editor para alternar a exibição de cada uma
das categorias de links e também para controlar sua aparência.

Exibir links

Você também ativar e desativar links na Vista da cena. Também é possível
alternar a exibição de cada categoria de links. Autodesk Navisworks lembra da
configuração de visibilidade selecionada entre as sessões.

Quando links são ativados, é possível reduzir a ocupação da tela ao restringir
o número de links que podem ser exibidos na Vista da cena, ocultando
ícones que colidem, e usando seleção. Finalmente, como algumas categorias
de link padrão podem ter comentários associados com eles, e você pode decidir
desenhar comente os links com comentários anexados.

Para alternar a exibição dos links

■ Clique na guia Home painel  ➤ Display ➤ Links  .

Menu: Classic user interface: Tools ➤ Links

Para controlar a exibição de links padrão

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção Standard Categories.

3 Na página Standard Categories , selecione a caixa de verificação
Visible para exibir a categoria de link correspondente. Desmarcar a caixa
de verificação oculta a categoria de link correspondente na Vista da
cena.

Por padrão, todas as categorias de link padrão são visíveis.

4 Clique em OK.
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Para controlar a exibição de links definidos pelo usuário

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção User-Defined Categories.

3 Na página User-Defined Categories , selecione a caixa de seleção
Visible para exibir a categoria de link correspondente. Desmarcar a caixa
de verificação oculta a categoria de link correspondente na Vista da
cena.

Por padrão, todas as categorias de links definidas pelo usuário são visíveis.

OBSERVAÇÃO Caso nenhuma categoria definida pelo usuário foi adicionada,
esta página estará vazia.

4 Clique em OK.

Para reduzir a ocupação da tela

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção Links.

3 Na página Links, insira o número de links na caixa Max Icons. Por
padrão, 25 links podem estar visíveis.

4 Para ocultar links que aparecem sobrepostos na Vista da cena, selecione
a caixa de verificação Hide Colliding Icons.

5 Na caixa Cull Radius insira o valor desejado. Somente os links
localizados dentro da distância especificada da câmera são desenhados
na Vista da cena. O valor padrão de 0 significa que todos os links são
desenhados.

6 Clique em OK.

Para ocultar links sem comentários

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção Standard Categories.

3 Na página Standard Categories , selecione a caixa de seleção Hide
Icons Without Comments para todas as categorias de link necessárias.
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Por padrão, os links sem comentários também são exibidos.

4 Clique em OK.

Personalizar links

Você pode personalizar a aparência padrão de links no Autodesk Navisworks.
Em particular, você pode desenhá-los em 3D e pode adicionar linhas de
chamada de detalhe (setas) apontando para o ponto de anexação nos itens.
Você pode escolher como representar cada categoria de link (como um ícone
ou como um texto).

Para desenhar links no modo 3D

Observação: No modo 3D os links podem ser ocultos por outros objetos na
cena quando você estiver navegando.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção Links.

3 Na página Links, selecione a caixa de verificação In 3D.

Os links agora flutuam no espaço 3D justo em frente de seus pontos de
anexação aos itens.

4 Clique em OK.

Para exibir linhas de chamada de detalhe

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção Links.

3 Na página Links, insira as distâncias X- e Y- na Leader Offset para o
número de pixels à direita e acima que estas linhas de chamada irão usar.
O ângulo-padrão é 0. O ângulo recomendado é de 45.

Os links na Vista da cena agora têm linhas de chamada apontando
para o ponto de anexação nos itens.
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4 Clique em OK.

Para personalizar a aparência de links padrão

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção Standard Categories.

3 Na página Standard Categories , utilize a caixa Icon Type para
especificar como deseja que um link seja desenhado para cada uma das
categorias disponíveis. É possível escolher entre um ícone e texto.

Por padrão, links de legenda são exibidos como texto, e o resto das
categorias de links são exibidas como ícones.

4 Clique em OK.

Para personalizar a aparência de links definidos pelo usuário

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção User-Defined Categories.

3 Na página User-Defined Categories , utilize a caixa Icon Type para
especificar como deseja que um link seja desenhado para cada uma das
categorias disponíveis. É possível escolher entre um ícone e texto. Por
padrão, os links com categorias definidas pelo usuário são mostrados
como ícones.

OBSERVAÇÃO Caso nenhuma categoria definida pelo usuário foi adicionada,
esta página estará vazia.
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4 Clique em OK.

A tabela abaixo mostra os ícones que podem ser usados para representar
diferentes categorias de link na Vista da cena.

DescriçãoÍcone

Representa links que possuem hyperlink, legenda, ou qualquer outra categoria
definida por usuário (e aponta para um endereço da web).

Representa links que tenham hyperlink, legenda, ou qualquer categoria definida
pelo usuário (e aponta para um arquivo externo).

Representa links com a categoria de ponto de vista (modo de câmera em
perspectiva).

Representa links com a categoria de ponto de vista (modo de câmera ortogonal).

Representa links com a categoria de identificador.

Encontrar e seguir links

Os links são uma ferramenta de revisão extremamente útil para permitir acessar
informações não gráficas através da interface gráfica do Autodesk Navisworks.

Os links convertidos de arquivos nativos de CAD e os links adicionados por
usuários do Autodesk Navisworks são tratados como propriedades do objeto.
Isto significa que você pode examiná-los na janela Properties.

Para seguir um link

1 Assegure que os links estejam ativados. Clique na guia Home painel

 ➤ Display ➤ Links  .

2 Clique no link desejado na Vista da cena para abrir a origem de dados
anexada.

Menu de atalho: Seguir link
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Reset Links

Você pode definir todos os links em um objeto para os links que foram
originalmente convertidos do arquivo CAD. Você também pode redefinir todos
os links em todos os objetos na cena para seu estado original.

Para redefinir todos os links para um objeto

Atenção: a redefinição de links para um objeto também remove quaisquer
links manualmente adicionados a ele por usuários doAutodesk Navisworks.
Se tiver cometido um erro, use o botão Undo  na barra de ferramentas
Acesso rápido.

1 Na Vista da cena, selecione o objeto com os links que deseja redefinir
para seu estado original.

2 Clique na guia Item Tools ➤ painel Links ➤ Reset Links  .

Para redefinir todos os links em uma cena

Atenção: A redefinição de links em uma cena também remove quaisquer
links manualmente adicionados a ela por usuários do Autodesk Navisworks.
Se tiver cometido um erro, use o botão Undo  na barra de ferramentas
Acesso rápido.
■ Clique na guia Home ➤ painel Project ➤ menu suspenso Reset

All ➤ Links  .

Propriedades rápidas
É possível ativar e desativar as propriedades rápidas na Vista da cena. O
Autodesk Navisworks lembra da configuração de visibilidade selecionada entre
as sessões.

Quando as Propriedades rápidas estão ativadas, é possível visualizar
informações sobre elas numa janela de estilo de dica de ferramentas ao mover
o cursor sobre os objetos na Vista da cena. Não é preciso primeiro selecionar
os objetos. A dica de ferramenta sobre as propriedades rápidas desaparecem
após alguns segundos.
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Por padrão, as propriedades rápidas mostram o nome e o tipo do objeto, mas
é possível utilizar o Options Editor para definir quais propriedades são
mostradas. Cada definição configurada permite exibir uma combinação de
categoria/propriedade adicional nas propriedades rápidas. Você pode decidir
ocultar ou não os nomes de categorias nas propriedades rápidas.

OBSERVAÇÃO Ao mover o mouse sobre um objeto que não possua as
propriedades necessárias, o Autodesk Navisworks procura na árvore de seleção
um objeto pai que contenha essas informações e o exibe em seu lugar,
maximizando dessa maneira as informações úteis para o usuário.

Para alternar a exibição das propriedades rápidas

■ Clique na guia Home ➤ painel Display ➤ Quick Properties  .

Menu: Interface de usuário Classic: Tools ➤ Quick Properties

Para adicionar definições de propriedades rápidas

1 Clique no botão do aplicativo  ➤ Options.

2 No comando Options Editor, amplie o nó Interface , amplie o nó
Propriedades rápidas e clique na opção Definições.

3 Na página Definitions, clique em Grid View  para exibir as
definições de propriedades rápidas como linhas de tabela.

4 Clique em Add Element  . Um nova linha é adicionada no topo
da tabela.
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5 Clique na coluna Category e selecione a categoria de propriedade na
lista suspensa, por exemplo ‘Item’. As opções disponíveis dependem das
categorias de propriedades em seu modelo.

6 Clique na coluna Property , e selecione o nome da propriedade na lista
suspensa, por exemplo, ‘Material’. As opções disponíveis dependem da
categoria de propriedade selecionada.

7 Clique em OK.

OBSERVAÇÃO É possível adicionar tantas definições as suas propriedades rápidas
quanto quiser.

Para excluir definições de propriedades rápidas

1 Clique no botão do aplicativo  ➤ Options.

2 No comando Options Editor, amplie o nó Interface , amplie o nó
Propriedades rápidas e clique na opção Definições.

3 Na página Definitions, clique em Grid View  para exibir as
definições de propriedades rápidas como linhas de tabela.

4 Clique em Category ou Property para a definição que deseja excluir.

5 Clique em Remove Element  .

6 Clique em OK.

Para ocultar nomes de categorias

1 Clique no botão do aplicativo  ➤ Options.

2 No comando Options Editor, amplie o nó Interface e clique na opção
Propriedades rápidas .

3 Selecione a caixa de seleção Hide Category.

4 Clique em OK.
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Utilizar pontos de vista

Os pontos de vista são instantâneos tirados do modelo da forma como ele é exibido
na Scene View. Os pontos de vista podem incluir diversos comentários e
identificadores de linha de marcação, que forma previamente adicionados em um
ponto de vista. Você não pode criar pontos de vista no Autodesk Navisworks, mas
pode utilizar quaisquer um dos pontos de vista e animações de ponto de vista salvos
no modelo. A animação do ponto de vista normalmente contém o movimento
através do modelo e das vistas do modelo.

Modificar pontos de vista

Janela Saved Viewpoints

A janela Saved Viewpoints é uma janela encaixável que permite pular para
pontos de vistas predefinidos sem ter que navegar a cada vez para alcançá-los.
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As animações do ponto de vista também são salvas com os pontos de vista, já
que simplesmente uma lista de pontos de vista tratados como quadros-chave.

Ícones são utilizados para representar diferentes elementos:

 representa uma pasta que pode conter todos os outros elementos (incluindo
outras pastas).

 representa um ponto de vista salvo no modo ortogonal.

 representa um ponto de vista salvo no modo de perspectiva.

 representa um clip de animação do ponto de vista.

 representa um corte inserido em um clip de animação do ponto de vista.

É possível selecionar mais de um ponto de vista mantendo pressionada a tecla
Ctrl e clicando com o botão esquerdo do mouse ou clicando com o botão
esquerdo no primeiro elemento e então clicando no último elemento enquanto
mantém pressionada a tecla Shift.

Você pode arrastar pontos de vista em torno da janela Saved Viewpoints
mas não pode salvar quaisquer alterações.

Existem botões nesta janela e comandos são invocados através de menus de
atalho.

Para alternar a janela Saved Viewpoints

■ Clique na guia Viewpoint painel  ➤ Save, Load & Playback
inicializador de ferramenta  ➤ Saved Viewpoints  .

Menu: Interface de usuário Classic: View ➤ Control Bars ➤ Saved
Viewpoints

Entrada do comando: Ctrl + F11

Você obtém um menu de atalho diferente, dependendo de qual elemento foi
clicado com o botão direito do mouse na janela Saved Viewpoints. Todos
os menus de atalho compartilham a opção Sort, que classifica o conteúdo da
janela na ordem alfabética, incluindo pastas e seus conteúdos.

IMPORTANTE Quaisquer alterações feitas não podem ser salvas e somente se
aplicam para a duração de sua sessão do Autodesk Navisworks.
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Blank Space

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.

Saved Viewpoint

Add Copy Cria uma cópia do ponto de vista selecionado na janela Saved
Viewpoints. A cópia é nomeada com o mesmo nome do ponto de vista
selecionado, mas inclui o número da versão entre colchetes. Por exemplo,
View1(1), View1(2), e assim por diante.

Edit Abre a caixa de diálogo Edit Viewpoint , e permite editar manualmente
os atributos do ponto de vista.

Update Torna o ponto de vista selecionado igual ao ponto de vista atual na
Scene View.

Transform Abre a caixa de diálogo Transform. Permite transformar a posição
da câmera. Essa opção não está disponível em um espaço de trabalho 2D.

Delete Exclui o ponto de vista da janela Saved Viewpoints.

Rename Permite renomear o ponto de vista selecionado.

Copy Name Copia o nome do ponto de vista selecionado para a Área de
transferência.

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.

Animação do ponto de vista

Add Copy Cria uma cópia da animação do ponto de vista selecionada na
janela Saved Viewpoints. A cópia é nomeada com o mesmo nome da
animação de ponto de vista selecionada, mas inclui o número da versão entre
colchetes. Por exemplo, View1(1), View1(2), e assim por diante.

Edit Abre a caixa de diálogo Edit Animation , e permite definir a duração
da animação do ponto de vista selecionada, o tipo de suavização e se efetua
ou não o ciclo.

OBSERVAÇÃO Clicar em Edit sobre um quadro-chave da animação, abre a caixa
de diálogo Edit Viewpoint; e clicar em Edit sobre um corte da animação, abre
a caixa de diálogo Edit Animation Cut.
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Update Atualiza todos os quadros-chave na animação de ponto de vista com
o estilo de renderização, iluminação e modo ou ferramenta de navegação
atuais.

OBSERVAÇÃO Clicar em Update sobre um quadro-chave único somente irá
atualizar aquele quadro com os modos atuais.

Transform Abre a caixa de diálogo Transform. Permite transformar a posição
da câmera. Essa opção não está disponível em um espaço de trabalho 2D.

Delete Exclui a animação do ponto de vista selecionada da janela Saved
Viewpoints.

OBSERVAÇÃO Clicar em Delete sobre um quadro-chave ou corte, remove o
quadro-chave ou corte da animação do ponto de vista.

Rename Permite renomear a animação de ponto de vista selecionada,
quadro-chave ou corte.

Copy Name Copia o nome da animação de ponto de vista selecionada,
quadro-chave ou corte para a Área de transferência.

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.

Folder

Add Copy Cria uma cópia da pasta selecionada na janela Saved Viewpoints.
A cópia é nomeada com o mesmo nome da pasta selecionada, mas inclui o
número da versão entre colchetes. Por exemplo, Folder1(1), Folder1(2) e assim
por diante.

Update Atualiza todos os pontos de vista na pasta com o estilo de renderização,
iluminação e modo ou ferramenta de navegação atuais. Escolher Update para
um ponto de vista único, somente irá atualizar aquele ponto de vista com os
modos atuais.

Transform Abre a caixa de diálogo Transform. Permite transformar a posição
da câmera. Essa opção não está disponível em um espaço de trabalho 2D.

Delete Remove a pasta selecionada e todo seu conteúdo da janela Saved
Viewpoints.

Rename Permite renomear a pasta selecionada.

Copy Name Copia o nome da pasta selecionada para a Área de transferência.

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.
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Chamar pontos de vista

Você pode retornar para qualquer um dos pontos de vista anteriormente salvos.
Ao chamar pontos de vista no modo de navegação que estava ativo quando
o ponto de vista foi criado, será novamente selecionado. Quaisquer linhas de
marcação e comentários associadas com ponto de vista também serão
restaurados.

Para chamar um ponto de vista a partir da janela Saved Viewpoints

1 Se a janela Saved Viewpoints não for exibida, clique na guia
Viewpoint ➤ painel Save, Load & Playback ➤ iniciador de
ferramentas Saved Viewpoints  .

2 Clique no ponto de vista desejado na lista. Ele agora é exibido na Scene
View.

Organizar pontos de vista

Os pontos de vista podem ser organizados em pastas, como necessário.

Para organizar pontos de vista em pastas

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback lista
suspensa  ➤ Current Viewpoint ➤ Manage Saved Viewpoint.

Isto abre a janela Saved Viewpoints, e a torna a janela ativa.

2 Clique com o botão direito do mouse em um espaço vazio na Saved
Viewpoints e clique em New Folder.
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3 Digite um novo nome e pressione Enter.

4 Arraste os pontos de vista requeridos para sua nova pasta.

Editar pontos de vista

Dependendo se você trabalha em um espaço de trabalho 2D ou 3D, é possível
editar todos ou alguns dos seguintes atributos dos pontos de vista, incluindo
a posição da câmera, o campo de visão, a velocidade do movimento e os
atributos salvos. Todas as entradas são medidas em Unidades de exibição na
página 96.

DICA Clique na guia Viewpoint e deslize o painel Navigate para ajustar
rapidamente a velocidade linear e a angular do movimento para o seu ponto de
vista atual em um espaço de trabalho 3D.

Para editar o ponto de vista atual

1 Clique na guia Viewpoint ➤  painel Save, Load & Playback  ➤ Edit

Current Viewpoint  .

2 Utilize a caixa de diálogo Edit Viewpoint na página 287 para ajustar os
atributos do ponto de vista.
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3 Clique em OK.

Para editar um ponto de vista

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback lista
suspensa  ➤ Current Viewpoint ➤ Manage Saved Viewpoint.

2 Na janela Saved Viewpoints, clique com o botão direito no ponto de
vista que você deseja modificar, e clique em Edit.

3 Utilize a caixa de diálogo Edit Viewpoint na página 287 para ajustar os
atributos do ponto de vista.

4 Clique em OK.

Para excluir um ponto de vista

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback lista
suspensa  ➤ Current Viewpoint ➤ Manage Saved Viewpoint.

2 Na janela Saved Viewpoints, clique com o botão direito no ponto de
vista que deseja remover e clique em Delete.
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Reproduzir animações

No Autodesk Navisworks há dois tipos de animação: animação de ponto de vista e
animação de objeto.

A animação de ponto de vista contém movimentos no modelo por usuário e câmera
pré-gravados. A animação de objeto contém movimento pré-gravado do objeto no
modelo. Você não pode gravar nenhuma animação no Autodesk Navisworks mas
pode reproduzir animações salvas com o modelo. Se houver quaisquer scripts de
animação, você pode ativá-los e interagir com objetos com animação.

Reproduzir animações e scripts
Você pode reproduzir animações de objetos e de ponto de vista pré-gravadas na
Scene View.

As animações do ponto de vista são reproduzidas em tempo real. Isso significa
que o mecanismo do Autodesk Navisworks ainda está tentando manter a
frequência de quadros garantida, portanto, algum descarte ainda pode ocorrer,
da mesma forma que na navegação em tempo real.

FinalidadeControle

Rebobina a animação atual de volta ao início.

Volta um quadro ou um quadro-chave da
animação.

Reproduz a animação atual no sentido inverso.

Pára a reprodução da animação.
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FinalidadeControle

Pausa a reprodução da animação.

Reproduz a animação no momento selecionada.

Avança adiante um quadro ou quadro-chave na
animação.

Move adiante em direção ao fim da animação.

O deslizador de tempo de reprodução.

O girador de tempo de reprodução.

Para reproduzir uma animação

1 Clique na guia Animation painel  ➤ Playback lista suspensa
 ➤ Available Animations e selecione a animação que deseja reproduzir.

2 No painel Playback, clique em Play  .

Use os botões VCR no painel Playback para controlar a animação. O
deslizador Playback Position permite rapidamente mover adiante e
para trás através da animação. Todo a esquerda é o início e todo a direita
é o final.

A direito do deslizador Playback Position, existem dois indicadores
de andamento da animação: porcentagem e tempo (em segundos). É
possível digitar um número em cada caixa para definir a câmera em um
determinado ponto.

3 Nas animações do ponto de visão, pode-se notar que a estrutura na
animação na janela Saved Viewpoints (clique na guia View painel
 ➤ Workspace menu suspenso  ➤ Windows ➤ Saved Viewpoints)
é ressaltada quando a animação está sendo executada. Clique em qualquer
quadro para definir a câmera para aquele ponto no tempo na animação
de ponto de vista e continuar a reproduzir dali em diante.
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Para ativar scripts de animação

■ Clique na guia Animation painel  ➤ Scripts ➤ Enable Scripts  .

Você agora pode interagir com seu modelo. Por exemplo, se houver um
script para abrir uma porta ao pressionar uma tecla específica no teclado,
pressionar esta tecla irá abrir a porta.
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Trabalhar em equipe

O Autodesk Navisworks Freedom 2012 permite que múltiplos usuários participem
em uma única sessão de revisão de projeto através de uma rede de Área Local (LAN).

A ferramenta Collaborate tem duas limitações dignas de atenção.
■ Colaboração entre diferentes versões do Autodesk Navisworks não é suportada.

■ Este recurso está disponível somente para os usuários do Windows XP, uma vez que este
utiliza as operações de programas compartilhados do Windows NetMeeting, o qual não
está disponível nos sistemas operacionais Vista e Windows 7.

Painel Collaborate
As ferramentas de colaboração necessárias para executar sessões de colaboração
estão localizadas na guia Review ➤ painel Collaborate.

Por padrão, o painel Collaborate não é exibido. Para exibi-lo, clique com o
botão direito na guia Review e clique em Show Panels ➤ Collaborate no
menu de atalho.

Sessão de colaboração
Todos os participantes de reuniões requerem acesso aos arquivos NWF e NWD
do Autodesk Navisworks, numa localização compartilhada. Um dos participantes
será o hospedeiro da reunião e fará uma chamada convidando os outros para a
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mesma. Qualquer um dos participantes que se juntou à reunião pode exercer
o controle e conduzir a sessão. Toda navegação executada pelo condutor será
exibida na Scene View de cada uma das máquinas dos participantes. Qualquer
pontos de visão ou linhas de marcação, por exemplo, adicionadas durante a
sessão, podem ser atualizadas em todos os equipamentos participantes com
apenas um clique num botão.

OBSERVAÇÃO Se uma sessão de revisão colaborativa, como aqui descrita, não
for conduzida em uma mesma sala, então podem ser necessárias provisões
adicionais de teleconferência. Isso pode ser através da utilização do NetMeeting
Whiteboard ou através de seu próprio sistema de telefonia.

Para iniciar uma sessão de colaboração

1 Abra o arquivo do Autodesk Navisworks no qual deseja colaborar a partir
de um diretório compartilhado.

2 Clique na guia Review ➤ painel Collaborate ➤ Collaborate  .

Isso inicializa o Windows® NetMeeting®.
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OBSERVAÇÃO Na primeira vez que o Windows NetMeeting é inicializado,
um assistente de configuração irá levá-lo através do processo de configuração.
Será necessário inserir seu nome e endereço de e-mail. Quando estiver
utilizando o NetMeeting em uma LAN, não será necessário se conectar a
um servidor de diretórios, uma vez que estes não lhe estarão disponíveis.

Para fazer uma chamada para convidar que os participantes se unam à sessão

1 Tendo inicializado o Windows NetMeeting, clique no botão Call
na caixa de diálogo NetMeeting.

2 Na caixa de diálogo Place a Call , insira o nome da máquina ou o
endereço IP da máquina com a qual deseja se juntar à reunião, na caixa
To.
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3 Clique no botão Call para enviar o convite.

Após a pessoa que recebe o convite o aceita, o nome dela e o seu serão
listados na caixa de diálogo NetMeeting.

4 Repita este procedimento para convidar todos os participantes necessários.

Para aceitar um convite

1 Quando você é convidado a se juntar à uma reunião, a caixa de diálogo
Incoming Call será exibida.

2 Clique no botão Accept para se juntar á reunião ou em Ignore para
declinar do convite.

OBSERVAÇÃO Após ter aceitado uma chamada, será preciso clicar na guia

Review ➤ painel Collaborate ➤ Collaborate  para iniciar a sua própria
sessão de colaboração.

Para se tornar o condutor

Durante a reunião, qualquer um participante da chamada pode assumir o
controle da sessão e se tornar o condutor. O condutor irá controlar a navegação
do modelo compartilhado em todas as máquinas na chamada.

1 Clique na guia Review ➤ painel Collaborate ➤ Drive  .

2 Após clicar no botão do condutor, todos os outros usuários na chamada
irão receber uma mensagem avisando que você está solicitando o
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controle. Eles terão que responder Yes para esta mensagem para que
você possa conduzir o Autodesk Navisworks na máquina deles.

Para atualizar todas as máquinas dos participantes

Embora a navegação em tempo real no Autodesk Navisworks possa ser
executada em todas as máquinas em uma chamada por um usuário, não é
possível rever dados salvos, como pontos de vista, comentários e linhas de
marcação, para que sejam automaticamente atualizados em todas as máquinas
do usuários. Essa informação, no entanto, pode ser atualizada em suas
máquinas ao atualizar o modelo. Este processo de atualização pode ser
executado em uma máquina de usuário e ser atualizado em todas as máquinas
na chamada.
■ Clique na guia Review ➤ painel Collaborate ➤ Refresh  .

Sessão de colaboração | 267



268



Compartilhar dados

Print
Você pode imprimir uma cópia impressa do ponto de vista atual em qualquer
impressora ou plotadora.

Print Preview

Antes de imprimir uma cópia do modelo ou da folha em que estiver trabalhando,
você pode desejar verificar sua aparência.

Para visualizar um modelo/uma folha antes de imprimir

1 Clique na guia Output ➤ painel Print ➤ Print Preview  .

2 Utilize os botões Zoom In e Zoom Out para fazer o mesmo que a imagem
de visualização.

3 Clique em Print.

4 Na caixa de diálogo Print clique em OK.

Print Setup

Esta opção permite definir o tamanho do papel e as opções de orientação.
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Para alterar a configuração de impressão

1 Clique na guia Output ➤ painel Print ➤ Print Settings  .

2 Na caixa de diálogo Print Setup faça as modificações necessárias para
o tamanho de papel e orientação.

3 Clique no botão Properties se desejar alterar configurações específicas
da impressora.

4 Retorne à caixa de diálogo Print e clique em OK.

Imprimir o ponto de vista atual

Quando a opção de impressão é selecionada, o Autodesk Navisworks imprime
o ponto de vista atual, dimensionado para caber e centralizado na página.

Para imprimir o ponto de vista atual

1 Clique na guia Output ➤ painel Print ➤ Print  .

2 Verifique as configurações necessárias da impressora e clique em OK.

OBSERVAÇÃO O tamanho máximo da imagem é de 2048x2048 pixels.

O botão Properties controla as configurações de tinta e papel específicas
da impressora.

Barra de ferramentas: Classic user interface: Standard ➤ Print
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TimeLiner Playback

O comandoTimeLiner Playback permite visualizar uma sequência de construção
do TimeLiner. Nesta seção, você aprende a simular sua sequência do TimeLiner
através da duração do planejamento do projeto.

Visão geral da ferramenta TimeLiner
A ferramenta TimeLiner adiciona a simulação de planejamento 4D ao Autodesk
Navisworks.

o Autodesk Navisworks Freedom 2012 do ProdNameLong tem uma opção de
somente reprodução. permitindo que quaisquer dados de projeto externamente
criado seja simulado, mas nenhuma alteração pode ser feita nestes dados.

Janela TimeLiner Playback.

A janela encaixável TimeLiner Playback permite configurar e executar
simulações.

Para ativar a janela TimeLiner Playback

■ Clique na guia Home painel  ➤ Tools ➤ TimeLiner Playback

Menu: Interface de usuário clássica: Tools ➤ TimeLiner Playback

Guia Simulate

Na janela TimeLiner Playback a guia Simulate permite simular a sequência
do TimeLiner através da duração do planejamento do projeto.
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Os controles de reprodução

Utilize os botões padrão de VCR para entrar e executar adiante e para atrás
através da simulação.

Rewind  irá rebobinar a simulação de volta para o início.

Step Back  irá voltar atrás um único tamanho de etapa.

Reverse Play  irá reproduzir a simulação de trás para a frente.

Pause  irá pausar a simulação no momento em que você a pressiona. Você
pode olhar em torno e interrogar o modelo, ou ir adiante ou para atrás através
da simulação. Para continuar a reproduzir do ponto da pausa, basta pressionar
Play novamente.

Stop  irar parar a reprodução da simulação e irá rebobinar de volta ao início.

Play  irá reproduzir a simulação da hora no momento selecionada.

Step Forwards  irá adiantar um único tamanho de etapa.

Forward  irá adiantar rápido a simulação até o final.

Você pode utilizar o deslizador Simulation Position para mover rapidamente
para adiante e para atrás através da simulação. Todo a esquerda é o início e
todo a direita é o final.
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A caixa Date/Time próxima dos botões VCR mostra o ponto no tempo através
da simulação. Você pode clicar no ícone suspenso no lado direito da data para
exibir um calendário, no qual é possível selecionar uma data para ir para a
mesma.

O botão Settings

O botão Settings abre a caixa de diálogo Simulation Settings na página 275,
que permite definir como o planejamento é simulado.

A visualização da tarefa

Todas as tarefas ativas são exibidas em uma tabela com múltiplas colunas.
Você pode mover e redimensionar as colunas da tabela, se necessário.

Você pode visualizar o tempo da simulação atual para cada uma das tarefas
ativas, e quão perto está de ser completada (o Andamento é exibido em
percentual). O Status de cada tarefa ativa também é exibido como um ícone.
Para as simulações onde as datas Planejado e Real estão disponíveis, o status
fornece uma representação visual sobre se há uma variação entre as datas de
planejado e real. Consulte Os ícones de status para obter mais informações.

Os ícones de status

Cada tarefa tem seu próprio status identificado por um ícone. Duas barras
separadas são desenhadas para cada tarefa, comparando as relações planejadas
com as atuais. A cor é usada para diferenciar as porções mais cedo (azul), na
hora (verde), atrasado (vermelho) e planejado (cinza), das tarefas. Pontos
marcam as datas de início e final do planejamento.

Ao parar o ponteiro do mouse sobre o ícone Status é exibida uma dica de
ferramenta explicando o status da tarefa.

Finished before planned start.

Early start, early finish.

Early start, on-time finish.

Early start, late finish.

On-time start, early finish.
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On-time start, on-time finish.

On-time start, late finish.

Late start, early finish.

Late start, on-time finish.

Late start, late finish.

Started after planned finish.

No comparison.

A vista do gráfico Gantt

O gráfico Gantt exibe um gráfico de barras coloridas ilustrando o status do
projeto. Cada tarefa ocupa uma linha. O eixo horizontal representa o intervalo
de tempo do projeto, dividido em incrementos (tais como dias, semanas, meses
e anos) e o eixo vertical representa as tarefas do projeto. As tarefas podem ser
executadas sequencialmente, em paralelo, ou sobrepostas.

Reproduzir simulações

Para reproduzir uma simulação

1 Se a janela TimeLiner Playback ainda não estiver aberta, clique na

guia Home painel  ➤ Tools ➤ TimeLiner Playback  .

2 Clique no botão Play  na guia Simulate.

A janela TimeLiner Playback exibe as tarefas da forma como são
executadas, e a Scene View mostra as seções do modelo que foram
adicionadas ou removidas ao longo do tempo, de acordo com os tipos
de tarefas.

Para ajustar a reprodução da simulação

1 Se a janela TimeLiner ainda não tiver sido aberta, clique na guia

Home ➤ painel Tools ➤ TimeLiner  .

2 Clique na guia Simulation , e clique no botão Settings.

3 Quando a Caixa de diálogo Simulation Settings na página 275 for aberta,
modifique as configurações de reprodução e clique em OK.
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Caixa de diálogo Simulation Settings

O botão Settings na guia Simulate fornece o acesso à caixa de diálogo
Simulation Settings.

É possível sobrepor as datas Inicial e Final entre as quais a simulação é
executada. A seleção da caixa de seleção Override Start/End Dates ativa
as caixas de datas e permite escolher as datas iniciais e finais. Ao fazer isso,
você pode simular uma pequena subseção de todo o projeto. As datas serão
exibidas na guia Simulate. Estas datas também serão utilizadas ao exportar
animações.

Você pode definir o Tamanho do intervalo para utilizar a passagem através
da simulação utilizando os controles de reprodução. O tamanho do intervalo
pode ser definido como um percentual da duração total da simulação ou como
um número absoluto de dias ou semanas, e assim por diante.

Visão geral da ferramenta TimeLiner | 275



Utilize a lista suspensa para selecionar a unidade de intervalo, e a seguir utilize
os botões de seta Up e Down para aumentar ou diminuir o tamanho do
intervalo.

Também é possível realçar todas as tarefas nas quais se está trabalhando durante
o intervalo. Ao selecionar a caixa de seleção Show All Tasks in Interval,
e, por exemplo, definindo Interval Size para 5 dias, todas as tarefas sendo
executadas durante estes 5 dias serão definidas para sua Start Appearance
na Scene View, incluindo aquelas que começam e terminam dentro dos
limites do intervalo. O deslizador Simulation irá mostrar isso ao desenhar
uma linha azul sob o deslizador. Se esta caixa de seleção for desmarcada, as
tarefas que começam e terminam dentro dos limitas do intervalo não serão
realçadas desta maneira, e terão que coincidir com a data atual para serem
realçadas na Scene View.

Você pode definir a Duração de reprodução geral, para toda a simulação
(o tempo necessário para reproduzi-la do início ao fim). Utilize os botões de
seta Up e Down para aumentar ou diminuir a duração (em segundos). Você
pode também pode inserir a duração diretamente neste campo.

Você pode definir se a data da simulação atual deveria ser sobreposta na Scene
View, e se deveria aparecer na parte superior ou inferior da tela. No menu
suspenso, escolha entre None (para não exibir texto de sobreposição), Top
(para exibir o texto no topo da janela), ou Bottom (para exibir o texto na
parte inferior da janela).

Você pode usar a opção Edit para editar as informações exibidas no texto
sobreposto utilizando o Caixa de diálogo Overlay Text na página 280. A caixa
de diálogo torna alterar a Fonte Tipo, Estilo e Tamanho ao clicar no botão
Font contido.
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Você pode adicionar uma animação em um agendamento completo, para que
durante a reprodução da sequência do TimeLiner , o Autodesk Navisworks
também irá reproduzir a animação ou câmera do ponto de vista especificado.

As seguintes opções podem ser selecionadas no campo Animation:
■ No Link - nenhuma animação ou câmera do ponto de vista será

reproduzida.

■ Saved Viewpoints Animation - vincula seu planejamento para o ponto
de vista ou a animação do ponto de vista no momento selecionado.

■ Scene X -  ➤ Camera - vincula o planejamento à animação da câmera na
cena de animação selecionada.

É possível animações pré-gravadas com a simulação do TimeLiner (consulte
Reproduzir animações e scripts na página 259).

Área View. Cada vista irá reproduzir o planejamento indicando os
relacionamentos de Planejado e Real:
■ Actual. Escolha esta vista para simular somente o planejamento Real (ou

seja, utiliza somente as datas de Início real e Final real).

■ Actual (Planned Differences). Escolha esta vista para simular o
planejamento Real contra o planejamento Planejado. Esta vista somente
realça os itens anexados na tarefa na faixa de datas Real ( ou seja entre
Inicial real e Final real. Veja o diagrama abaixo para uma representação
gráfica). Para períodos de tempo onde as datas de Real estão dentro das
datas de Planejado (no prazo), os itens anexados na tarefa serão exibidos
na Task Type Start Appearance. Para períodos de tempo onde as datas
de Actual estão antecipadas ou atrasadas em comparação às datas de
Planned (há uma variação), os itens anexados na tarefa serão exibidos
em Task TypeEarly ou Late Appearance, respectivamente.
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■ Planned. Escolha esta vista para simular somente o planejamento
Planejado (ou seja, somente utilizar as datas Inicial planejado e Final
planejado).

■ Planned (Actual Differences). Escolha esta vista para simular o
planejamento Real contra o planejamento Planejado. Esta vista somente
realçará os itens anexados à tarefa na faixa de datas Planned (ou seja,
entre PlannedStart and Planned End. Veja o diagrama abaixo para
uma representação gráfica). Para períodos de tempo onde as datas Actual
estão dentro das datas Planned (no prazo), os itens anexados à tarefa
serão exibidos em Task Type Start Appearance. Para períodos de tempo
onde as datas de Actual estão antecipadas ou atrasadas em comparação
às datas de Planned (há uma variação), os itens anexados na tarefa serão
exibidos em Task TypeEarly ou Late Appearance, respectivamente.
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■ Planned Against Actual. Escolha esta vista para simular o planejamento
Real contra o planejamento Planejado. Isso realçará os itens anexados
à tarefa em toda a faixa de datas Planned e Actual (ou seja, a primeira
data de Actual e PlannedStart e na última data de Actual e
PlannedEnd. Veja os diagramas abaixo para uma representação gráfica).
Para períodos de tempo onde as datas Actual estão dentro das datas
Planned (no prazo), os itens anexados à tarefa serão exibidos em Task
Type Start Appearance. Para períodos de tempo onde as datas de Actual
estão antecipadas ou atrasadas em comparação às datas de Planned (há
uma variação), os itens anexados na tarefa serão exibidos em Task
TypeEarly ou Late Appearance, respectivamente.
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Caixa de diálogo Overlay Text

Você tem a opção de definir o texto sobreposto na Scene View durante a
simulação ao clicar em Edit na Caixa de diálogo Simulation Settings na página
275.

Por padrão, a data e a hora são exibidas utilizando o formato especificado em
Painel de Controle ➤ Configurações Regionais. Você pode especificar
o formato exato a ser utilizado ao inserir texto na caixa de texto. A maioria
dos textos aparecem como foram inseridos, exceto que as palavras pré-fixadas
por um caractere "%" ou "$" agem como palavras-chave e são substituídas por
valores variados. Os botões Date/Time e Extras podem ser utilizados para
selecionar e inserir todas as palavras-chave possíveis. O botão Colors pode
ser utilizado para definir a cor to texto de sobreposição.

O botão Font traz a caixa de diálogo padrão de seleção de fontes do Microsoft
Windows. Após selecione a fonte, estilo da fonte e tamanho da fonte corretos,
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pressione OK para retornar para a caixa de diálogo Overlay Text. A seleção
da fonte atual é mostrada junto ao botão Font , e durante a simulação do
TimeLiner , todo o texto na sobreposição será mostrado utilizando esta fonte.

Palavras-chave de data/hora

%a  Nome abreviado do dia da semana.

%A Nome completo do dia da semana.

%b Nome abreviado do mês.

%B Nome completo do mês.

%c Representação apropriada de data e hora para o local.

%d Dia do mês como um número decimal (01 - 31).

%H Hora no formato de relógio de 24 horas (00 -23).

%I Hora no formato de relógio de 12 horas (01 -12).

%j Dia do ano como um número decimal (001 - 366).

%m Mês como um número decimal (01 - 12).

%M Minuto como um número decimal (00- 59).

%p Indicador atual de A.M/P.M local para o relógio de 12 horas.

%S Segundo como um número decimal (00- 59).

%U Semana de um ano como um número decimal, com Domingo sendo o
primeiro dia da semana (00 -53).

%w Dia da semana como um número decimal (0 - 6; Domingo é 0).

%W Semana de um ano como um número decimal, com Segunda-feira sendo
o primeiro dia da semana (00 -53).

%x Representação da data para o local atual.

%X Representação da hora para o local atual.

%y Ano sem o século, como um número decimal (00 - 99).

%Y Ano com o século, como um número decimal.

%z Abreviatura do fuso horário; nenhum caractere se o fuso horário for
desconhecido.

%Z Nome do fuso horário; nenhum caractere se o fuso horário for
desconhecido.
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Palavras-chave de cores

$COLOR_RED  Define a cor do texto sobreposto como vermelho.

$COLOR_BLUE Define a cor do texto sobreposto como azul.

$COLOR_GREEN Define a cor do texto sobreposto como verde.

$COLOR_WHITE Define a cor do texto sobreposto como branco.

$COLOR_BLACK Define a cor do texto sobreposto como preto.

$RGBr,g,b$RGB Define o texto exibido sobreposto como qualquer cor
especificada usando os valores RGB explícitos entre 0 e 255. Por exemplo,
“$RGB127,127,127$RGB” define a cor como cinza.

Palavras-chave extras

$TASKS  Adiciona o nome de cada tarefa no momento ativa para o texto de
exibição sobreposto. Cada tarefa é exibida em um nova linha.

$DAY Dias desde o início da primeira tarefa no projeto (iniciando em 1).

$WEEK Semanas desde o início da primeira tarefa no projeto (iniciando em
1).

CTRL + Enter Digite CTRL + Enter para inserir uma nova linha no texto exibido
sobreposto.

%% Sinal de percentual.
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Reference

Caixa de diálogo Background Settings
Utilize esta caixa de diálogo para escolher um efeito de segundo plano para
utilização na Scene View.

Mode Seleciona o tipo de efeito de segundo plano. Escolha entre:
■ Plain

■ Graduated

■ Horizon

OBSERVAÇÃO Modo horizonte e as cores associadas somente estão disponíveis
para modelos 3D.

Color Define a cor para um segundo plano simples.

Top Color Define a cor superior em um segundo plano graduado.

Bottom Color Define a cor inferior em um segundo plano graduado.

Sky Color Define a cor do céu (topo) em um segundo plano de horizonte. Esta
opção somente está disponível para os modelos 3D.

Horizon Sky Color Define a cor do céu (inferior) em um segundo plano de
horizonte. Esta opção somente está disponível para os modelos 3D.

Horizon Ground Color Define a cor do chão (topo) em um segundo plano de
horizonte. Esta opção somente está disponível para os modelos 3D.

Ground Color Define a cor do chão (inferior) em um segundo plano de
horizonte. Esta opção somente está disponível para os modelos 3D.
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Faixa de opções:  Guia View ➤ painel Scene View ➤ Background
Menu de atalho: Clique em uma área em branco na cena, e clique em
Background no menu de atalho.

Menu: Classic user interface: Tools ➤ Background

Caixa de diálogo Collision
Utilize essa caixa de diálogo para ajustar as configurações de colisão para o
ponto de vista selecionado em um espaço de trabalho 3D.

Por padrão, as vistas Collision, Gravity, Auto Crouch, e Third Person
estão desativadas.

OBSERVAÇÃO Esta caixa de diálogo somente está disponível para modelos 3D.

Collision Selecione esta caixa de seleção para definir um visualizador como
um volume de colisão nos modos Walk e Fly. Como resultado, um
visualizador adquire alguma massa e não pode passar através de outros objetos,
pontos ou linhas na Scene View.

OBSERVAÇÃO A seleção desta caixa de seleção altera a prioridade de renderização,
para que os objetos em torno do visualizador sejam exibidos com muito mais
detalhes do que o normal. O tamanho da região de alto detalhe tem base no raio
do volume de colisão e na velocidade do movimento.

Gravity Selecione esta caixa de seleção para fornecer alguma espessura ao
visualizador no modo Walk. Esta opção somente funciona em conjunto como
Collision.

Auto Crouch Selecione esta caixa de seleção para ativar um visualizador para
agachar sob objetos que estão muito baixos para passar por baixo no modo
Walk. Esta opção somente funciona em conjunto como Collision.

Viewer

Radius Especifica o raio do volume de colisão.

Height Especifica a altura do volume de colisão.

Eye Offset Especifica a distância abaixo do topo do volume de colisão, onde
a câmera irá focar se a caixa de seleçãoAuto Zoom estiver selecionada.

284 | Capítulo 13    Reference



Third Person

Enable Selecione esta caixa de seleção para utilizar a vista Third Person. Em
uma vista Third Person, um avatar é exibido na Scene View para representar
o visualizador.

A seleção desta caixa de seleção altera a prioridade de renderização, para que
os objetos em torno do avatar sejam exibidos com muito mais detalhes do
que o normal. O tamanho da região de alto detalhe tem base no raio do volume
de colisão, na velocidade do movimento e na distância da câmera atrás do
avatar.

Auto Zoom Selecione esta caixa de seleção para trocar automaticamente da
vista Third Person para a vista de primeira pessoa sempre que a linha de
visão fique obscurecida por um item.

Avatar Especifica o avatar que é utilizado na vista Third Person.

Ângulo Especifica o ângulo no qual a câmera olha para o avatar.

Por exemplo, 0º posiciona a câmera diretamente atrás do avatar, 15º faz com
que a câmera olhe para baixo para o avatar em um ângulo de 15º graus.

Distance Especifica a distância entre a câmera e o avatar.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Dispositivo apontador:  Caixa de diálogo Edit Viewpoint ➤ Settings

Caixa de diálogo Default Collision
Utilize esta caixa de diálogo para especificar e salvar suas configurações de
colisão preferidas em um espaço de trabalho 3D.

Por padrão, as vistas Collision, Gravity, Auto Crouch, e Third Person
estão desativadas. Quando você modifica as configurações padrão de colisão,
suas alterações não afetam o arquivo do Autodesk Navisworks aberto no
momento. Elas são utilizadas assim que abrir um novo arquivo do Autodesk
Navisworks ou iniciar uma nova sessão do Autodesk Navisworks.
Collision Selecione esta caixa de seleção para definir um visualizador como
um volume de colisão nos modos Walk e Fly. Como resultado, um
visualizador adquire alguma massa e não pode passar através de outros objetos,
pontos ou linhas na Scene View.
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OBSERVAÇÃO A seleção desta caixa de seleção altera a prioridade de renderização,
para que os objetos em torno do visualizador sejam exibidos com muito mais
detalhes do que o normal. O tamanho da região de alto detalhe tem base no raio
do volume de colisão e na velocidade do movimento.

Gravity Selecione esta caixa de seleção para fornecer alguma espessura ao
visualizador no modo Walk. Esta opção somente funciona em conjunto como
Collision.

Auto Crouch Selecione esta caixa de seleção para ativar um visualizador para
agachar sob objetos que estão muito baixos para passar por baixo no modo
Walk. Esta opção somente funciona em conjunto como Collision.

Viewer

Radius Especifica o raio do volume de colisão.

Height Especifica a altura do volume de colisão.

Eye Offset Especifica a distância abaixo do topo do volume de colisão, onde
a câmera irá focar se a caixa de seleçãoAuto Zoom estiver selecionada.

Third Person

Enable Selecione esta caixa de seleção para utilizar a vista Third Person. Em
uma vista Third Person, um avatar é exibido na Scene View para representar
o visualizador.

A seleção desta caixa de seleção altera a prioridade de renderização, para que
os objetos em torno do avatar sejam exibidos com muito mais detalhes do
que o normal. O tamanho da região de alto detalhe tem base no raio do volume
de colisão, na velocidade do movimento e na distância da câmera atrás do
avatar.

Auto Zoom Selecione esta caixa de seleção para trocar automaticamente da
vista Third Person para a vista de primeira pessoa sempre que a linha de
visão fique obscurecida por um item.

Avatar Especifica o avatar que é utilizado na vista Third Person.

Ângulo Especifica o ângulo no qual a câmera olha para o avatar.

Por exemplo, 0º posiciona a câmera diretamente atrás do avatar, 15º faz com
que a câmera olhe para baixo para o avatar em um ângulo de 15º graus.

Distance Especifica a distância entre a câmera e o avatar.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.
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Dispositivo apontador:  Caixa de diálogo Options Editor nó  ➤ Interface
página  ➤ Viewpoint Defaults ➤ Settings

Caixa de diálogo Edit Viewpoint
Utilize esta caixa de diálogo para editar atributos do ponto de vista.

Camera

Position Insira os valores das coordenadas X, Y e Z para mover a câmera para
esta posição. Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.

Look At Insira os valores das coordenadas X, Y e Z para alterar o ponto focal
para a câmera. Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.

Vertical Field of View, Horizontal Field of View Define a área da cena que
pode ser visualizada através da câmera somente em um espaço de trabalho
3D. Você pode ajustar os valores para os ângulos de visão vertical e horizontal.

Um valor maior produz um ângulo mais largo de visão e um valor menor
produz um ângulo mais estreito ou um ângulo de visão para precisamente
focado.

OBSERVAÇÃO Quando você modifica o Vertical Field of View, o Horizontal
Field of View é automaticamente ajustado, e vice-versa, para coincidir com a
relação de aspecto no Autodesk Navisworks.

Rolar Rotaciona a câmera em torno de seu eixo frontal-traseiro. Um valor
positivo rotaciona a câmera no sentido anti-horário e um valor negativo
rotaciona no sentido horário.

OBSERVAÇÃO Este valor não é editável quando o vetor superior do ponto de
vista permanece em pé (isto é, quando você usa as ferramentas de navegação
Walk, Orbit e Constrained Orbit).

Motion

Linear Speed A velocidade do movimento em uma linha reta para o ponto
de vista em um espaço de trabalho 3D. O valor mínimo é 0 e o valor máximo
tem base no tamanho da caixa de delimitação da cena.

Angular Speed A velocidade na qual a câmera gira em um espaço de trabalho
3D.
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Saved Attributes

Esta área somente se aplica para pontos de vista salvos. Se você está editando
um ponto de vista atual, esta área fica acinzentada.

Hide/Required Selecione esta caixa de seleção para salvar informações de
revisão ocultas/requeridas sobre objetos em seu modelo com o ponto de vista.
Quando você utiliza novamente um ponto de vista, as revisões
ocultas/requeridas definidas quando o ponto de vista foi salvo são aplicadas.

OBSERVAÇÃO Salvar o estado da informação com cada ponto de vista requer
um quantidade relativamente grande de memória.

Override Material Selecione esta caixa de seleção para salvar informações de
sobreposição de material com o ponto de vista. Quando você utiliza novamente
um ponto de vista, as sobreposições de material definidas quando o ponto de
vista foi salvo são aplicadas.

OBSERVAÇÃO Salvar o estado da informação com cada ponto de vista requer
um quantidade relativamente grande de memória.

Collision

Settings Abre a caixa de diálogo Collision na página 284. Esta função está
disponível somente em um espaço de trabalho 3D.

Faixa de opções:  Guia Viewpoint ➤ painel Save, Load &

Playback ➤ Edit Current Viewpoint
Menu: Interface do usuário Classic: Viewpoint ➤ Edit Current

Viewpoint

Caixa de diálogo File Options
Utilize esta caixa de diálogo para controlar a aparência do modelo e a
velocidade de navegação em torno do mesmo.

OBSERVAÇÃO Algumas das guias estão disponíveis somente ao trabalhar com
modelos 3D.

Quando você modifica qualquer uma das opções nesta caixa de diálogo, suas
alteração são salvas no arquivo do Autodesk Navisworks no momento aberto,
e somente se aplica à este arquivo.
Faixa de opções:  Painel Home ➤ guia Project ➤ File Options

Menu: Interface de usuário Classic: Tools ➤ File Options.
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Guia Culling

Utilize esta guia para ajustar a seleção da geometria no arquivo aberto do
Autodesk Navisworks.

OBSERVAÇÃO As opções de planos de corte e face traseira estão disponíveis
somente para modelos 3D.

Area

Enable Especifica se a seleção da área é utilizada ou não.

Number of Pixels Below Which Objects Are Culled Especifica um valor para
a área de tela em pixels abaixo do qual os objetos são selecionados. Por
exemplo, definir este valor como 100 pixels, significa que qualquer objeto
dentro modelo que seria desenhado com um tamanho menor do que 10x10
pixels, será descartado.

Clipping Planes

Near
Automatic Selecione este botão para que o Autodesk Navisworks controle
automaticamente a posição dos planos de recorte próximos para oferecer a
melhor vista do modelo. A caixa Distance se torna indisponível.

Constrained Selecione este botão para restringir o plano de recorte próximo
para o valor definido na caixa Distance.

O Autodesk Navisworks utiliza os valores fornecidos, a menos que isso afete
o desempenho do sistema (por exemplo, tornar todo o modelo invisível).
Nesse caso, ele ajusta a posição dos planos de recorte como necessário.

Fixed Selecione este botão para definir o plano de recorte próximo para o
valor fornecido na caixa Distance.

Distance Especifica a distância mais afastada entre a câmera e a posição do
plano de recorte próximo no modo restringido.

Especifica a distância exata entre a câmera e a posição do plano de recorte
próximo no modo fixo.

OBSERVAÇÃO Nada é desenhado entre a câmera e o plano de recorte próximo.
Quando você sobrepõe o modo automático, torne este valor suficientemente
pequeno para exibir seus dados. Também, a sobreposição do modo automático
com valores abaixo de 1 pode produzir resultados imprevisíveis.
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Far
Automatic Selecione este botão de opção para que o Autodesk Navisworks
controle automaticamente a posição dos planos de recorte afastados para
oferece a melhor vista do modelo. A caixa Distance se torna indisponível.

Constrained Selecione este botão para restringir o plano de recorte afastado
com o valor definido na caixa Distance.

O Autodesk Navisworks utiliza os valores fornecidos, a menos que isso afete
o desempenho do sistema (por exemplo, tornar todo o modelo invisível).
Nesse caso, ele ajusta a posição dos planos de recorte afastados como necessário.

Fixed Selecione este botão para definir o plano de recorte afastado com o valor
definido na caixa Distance.

Distance Especifica a menor distância entre a câmera e a posição do plano de
recorte afastado no modo restringido.

Especifica a distância exata entre a câmera e a posição do plano de recorte
afastado no modo fixo.

OBSERVAÇÃO Nada é desenhado além deste plano. Quando você sobrepõe o
modo automático, torne este valor suficientemente grande para incluir seus dados.
Adicionalmente, a utilização da relação do plano de recorte afastado para o plano
de recorte próximo em excesso de 10.000 pode produzir efeitos indesejados.

Backface

Ativa a seleção da face traseira para todos os objetos. Selecione entre as
seguintes opções:
■ Off. Desativa a seleção de face traseira.

■ Solid. Ativa a seleção da face traseira para objetos sólidos somente. Esta é
a opção padrão.

■ On. Ativa a seleção da face traseira para todos os objetos.

DICA Se você pode ver através de alguns objetos ou algumas partes do objeto
estão faltando, desative a seleção da face traseira.

DICA Caso deseje restaurar os valores padrão, clique no botão Reset to Defaults.

Guia Orientation

Utilize esta guia para ajustar a orientação no mundo real de seu modelo.
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OBSERVAÇÃO Esta guia está disponível somente para os modelos 3D.

Up

X, Y, Z Especifique os valores de coordenada X, Y, e Z. Por padrão, o Autodesk
Navisworks identifica o eixo Z positivo como Up.

North

X, Y, Z Especifique os valores de coordenada X, Y, e Z. Por padrão, o Autodesk
Navisworks identifica o eixo Y positivo como o North.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Guia Speed

Utilize esta guia para ajustar a velocidade da taxa de quadro para reduzir o
montante de navegação descartada.

DICA Caso isto não aprimore a navegação, tente desativar a opção Guarantee
Frame Rate.

Frame Rate Especifica o número de quadros por segundo (FPS) que são
renderizados na Scene View.

A configuração padrão é 6. Você pode definir a frequência de quadro de 1 a
60 quadros por segundo. A redução do valor reduz o descarte, mas pode causar
um movimento com sobre-saltos durante a navegação. Aumentar o valor
assegura uma navegação mais suave, mas aumenta o descarte.

DICA Caso deseja restaurar os valores padrão clique no botão Defaults.

Guia Headlight

Utilize esta guia para alterar a intensidade da luz ambiente da cena e a luz
frontal para o modo Head Light.

OBSERVAÇÃO Esta guia está disponível somente para os modelos 3D.

Ambient Mova o deslizador para controlar o brilho da cena.
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Headlight Utilize o deslizador para controlar o brilho da luz localizada na
câmera.

OBSERVAÇÃO Para ver os efeitos de suas alterações no modelo na Scene View,
aplique o modo Head Light na faixa de opções.

Guia Scene Lights

Utilize esta guia para alterar a intensidade da luz ambiente da cena para o
modo Scene Lights.

OBSERVAÇÃO Esta guia está disponível somente para os modelos 3D.

Ambient Mova o deslizador para controlar o brilho da cena.

OBSERVAÇÃO Para ver os efeitos de suas alterações no modelo na Scene View,
aplique o modo Scene Lights na faixa de opções.

Caixa de diálogo Configurações do InfoCenter
Use esta caixa de diálogo para especificar as configurações de InfoCenter e
Communication Center.

Botões

OK Salva as alterações e fecha a caixa de diálogo InfoCenter Settings.

Cancel Descarta as alterações e fecha a caixa de diálogo InfoCenter Settings.

Help Exibe a ajuda sensível ao contexto.

Dispositivo apontador: Na caixa InfoCenter, clique no botão Subscription
Center/Communication Center/Favorites  ➤ botão InfoCenter Settings

Nó General

Use o nó General para selecionar a sua localização atual, frequência para
verificar por novo conteúdo on-line e para ativar ou desativar os efeitos de
transição animados para os painéis do InfoCenter.
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Please Indicate the Country/Region Nearest to Your Current Location
Define o país no qual os usuários do Autodesk Navisworks trabalham. Isso é
utilizado para ajustar o conteúdo específico da localização para o
Communication Center.

Check for New Online Content Especifica a frequência com que o
Communication Center verifica a existência de novo conteúdo.

Use Animated Transition Effects for Panels Selecione para animar transições
de painéis.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ General

Nó Communication Center

Use o nó Communication Center para definir a idade máxima dos artigos
exibidos no painel Communication Center.
Hide Results Which Are More Than X Days Old Selecione esta caixa de
seleção para que o InfoCenter oculte resultados de pesquisa mais antigos do
que o valor numérico especificado.

CAD Manager Channel Usado por outros produtos da Autodesk para
especificar as alimentações RSS publicadas por um gerente de CAD, o CAD
Manager Channel não está ativado no Autodesk Navisworks.

Display Name Digite o nome a ser exibido no painel Search Results.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ Communication Center

Página Autodesk Channels

Utilize as configurações desta página para ajustar as configurações para o
Communication Center.

Por padrão, todos os canais são selecionados. Você não pode adicionar ou
remover canais da grade e não pode editar os dados na grade.
Select Channels to Display in the Communication Center Panel Selecione
os canais e o número de artigos que você deseja exibir no painel
Communication Center.
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Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ Communication Center página  ➤ Autodesk Channels

Página Balloon Notification

Utilize as configurações nesta página para ajustar as notificações em balão.
Enable Balloon Notification for These Sources Selecione esta caixa de seleção
para ativar notificações em balão no produto. Notificações em balão aparecem
sobre a caixa do InfoCenter quando qualquer nova informação está disponível
das origens selecionadas.

Live Update Channel (New Software Updates) Selecione esta caixa de seleção
para receber notificações em balão de atualizações de software disponíveis.

Product Support Information Channel Selecione esta caixa de seleção para
receber notificações em balão de novas informações do produto.

CAD Manager Channel O CAD Manager Channel não está ativado no
Autodesk Navisworks.

RSS Feeds Selecione esta caixa de seleção para receber notificações em balão
de novas alimentações RSS.

Number of Seconds Balloon Notification Displays Insira um valor numérico
para indicar a quantidade de tempo para exibir notificações em balão.

% Transparency of Balloon Notification Insira um valor numérico para
indicar a transparência das notificações em balão.

Alternativamente, arraste o deslizador em direção a Opaque para diminuir a
porcentagem da transparência da notificação em balão ou em direção a
Transparent para aumentar a porcentagem da transparência.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings ➤ nó
Centro de comunicações ➤ página Balloon Notification

Página RSS Feeds

Use as configurações nesta página para alimentações RSS.
RSS Subscription Add. Especifica o caminho para a alimentação RSS que você
deseja adicionar. Após a alimentação RSS ter sido adicionada à lista RSS
Subscription, em Items to Display insira um valor numérico para indicar
o número de itens a serem exibidos.
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Remove. Remove uma alimentação RSS selecionada na lista RSS
Subscription.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ Communication Center página  ➤ RSS Feeds

Caixa de diálogo Options Editor
Utilize o Options Editor para ajustar as configurações do programa para as
sessões do Autodesk Navisworks.

As configurações definidas no Options Editor são persistentes em todas as
sessões do Autodesk Navisworks. Você também pode compartilhar as
configurações personalizadas com outros membros de sua equipe.

As opções são apresentadas em uma estrutura de árvore hierárquica. Clicar em
 expande os nós, clicar em  retrai os nós.

Faixa de opções: Botão do aplicativo  ➤ Options

Botões

Export Exibe a caixa de diálogo Select Options to Export, onde é possível
selecionar as opções globais que você deseja exportar (ou "serializar"). Se uma
opção não pode ser exportada, ela não está disponível.

Import Exibe a caixa diálogo Open , onde é possível navegar para o arquivo
com as configurações de opções globais.

OK Salva as alterações e fecha o Options Editor.

Cancel Descarta as alterações e fecha o Options Editor.

Help Exibe a ajuda sensível ao contexto.

Nó General

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Dispositivo apontador:  Caixa de diálogo Options Editor nó  ➤ General
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Página Undo

Utilize as configurações nesta página nesta página para ajustar o tamanho do
buffer.

Dispositivo apontador: caixa de diálogo Options Editor ➤ nó
General ➤ página Undo
Buffer Size (KB) Especifica o montante de espaço que o Autodesk Navisworks
aloca para salvar as ações de desfazer/refazer.

Página Locations

Utilize as opções nesta página para compartilhar as configurações globais do
Autodesk Navisworks, espaços de trabalho, ferramentas de dados, avatars,
regras do Clash Detective, arquivos do Presenter, testes personalizados do
Clash Detective, scripts de animação de objeto, e assim por diante, com outros
usuários.

Estas configurações podem ser compartilhadas através de todo um local de
projeto, ou através de um grupo de projetos específico, dependendo no nível
de granularidade requerido.

Quando você executa o Autodesk Navisworks pela primeira vez, as
configurações são obtidas do diretório de instalação. Subsequentemente, o
Autodesk Navisworks examina o perfil do usuário atual e os perfis de todos os
usuários na máquina local e, a seguir, verifica as configurações no Project
Directory e no Site Directory. Os arquivos no Project Directory tem
prioridade.

Project Directory Clique em  para abrir a caixa de diálogo Browse for
Folder, e localize o diretório que contém as configurações do Autodesk
Navisworks específicas do grupo de projetos.

Site Directory Clique em  para abrir a caixa de diálogo Browse for Folder,
e localize o diretório que contém as configurações padrão do Autodesk
Navisworks em todo o local do projeto.

Nó Interface

Utilize as configurações neste nó para personalizar a interface do Autodesk
Navisworks.
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DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Página Display Units

Utilize esta página para personalizar as unidades utilizadas pelo Autodesk
Navisworks.

Linear Units Utilize a lista suspensa para selecionar o valor linear desejado.
Metro é utilizado por padrão.

Angular Units Utilize a lista suspensa para selecionar o valor angular desejado.
Graus são utilizados por padrão.

Decimal Places Especifica o número de casas decimais utilizadas por unidades.

Fractional Display Precision Especifica o nível de fração utilizado por
unidades. Esta caixa somente é ativada por unidades fracionais.

Página Selection

Utilize as opções nesta página para configurar a forma pela qual os objetos de
geometria são selecionados e realçados.

Pick Radius Especifica o raio em pixels no qual o item tem de estar para poder
ser selecionado.

Resolution Especifica o nível de seleção utilizado por padrão.

Ao clicar na Scene View, o Autodesk Navisworks requer um ponto inicial
para o caminho do objeto na caixa Selection Tree para identificar o item
selecionado. É possível selecionar entre as seguintes opções:

■ Model - o caminho do objeto começa no nó do modelo, e como resultado,
todos os objetos no modelo são selecionados.

■ Layer - o caminho do objeto começa no nó da camada, e como resultado,
todos os objetos em uma camada são selecionados.

■ First Object - o caminho do objeto começa no nível mais alto de objetos
abaixo do nó da camada, se aplicável.

■ Last Object - o caminho do objeto começa no nível baixo alto de objetos
na Selection Tree. O Autodesk Navisworks procura primeiro por objetos
compostos e se nenhum for encontrado, o nível de geometria é utilizado.
Esta é a opção padrão.
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■ Last Unique - o caminho do objeto começa no primeiro nível único de
objetos (não com múltiplas instâncias) na Selection Tree.

■ Geometry - o caminho do objeto começa do nível da geometria na
Selection Tree.

Compact Tree Especifica o nível de detalhes mostrados na guia Compact da
Selection Tree.

Utilize uma das seguintes opções:

■ Models - a árvore é restrita para somente exibir arquivos de modelo.

■ Layers - a árvore pode ser expandida para o nível de camada.

■ Objects - pode ser expandida para o nível de objetos, mas sem os níveis
de instâncias mostrados na guia Standard.

Highlight

Enabled Indica se o Autodesk Navisworks realça os itens selecionados na
Scene View.

Desmarque esta caixa de seleção se não desejar realçar os itens selecionados.

Method Especifica como os objetos são realçados. Selecione uma das seguintes
opções:
■ Shaded

■ Wireframe

■ Tinted

Color Clique em  para especificar a cor de realce.

Tint Level (%) Utilize o deslizador para ajustar o nível de matiz.

Página Measure

Utilize as opções nesta página para ajustar a aparência e estilo das linhas de
medição.

Line Thickness Especifica a espessura das linhas de medição.

Color Clique em  para especificar a cor das linhas de medição.

In 3D Selecione esta caixa de seleção para desenhar linhas de medição em 3D.
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Se as linhas de medição se tornam obscurecidas por outra geometria, desmarque
esta caixa de seleção para desenhar as linhas em 2D acima do topo da
geometria.

Show Measurement Values in Scene View Selecione esta caixa de seleção se
deseja exibir as legendas de cota na Scene View.

Use Center Lines Quando esta caixa de seleção estiver selecionada, as medições
de distância mais curta efetua o snap nas linhas centrais dos objetos
paramétricos.

Quando esta caixa de seleção estiver desmarcada, a superfície de objetos
paramétricos é utilizada para a medição da menor distância.

OBSERVAÇÃO A alteração desta opção não afeta qualquer medição em efeito.
Para visualizar quaisquer alterações, limpe a medição e comece novamente.

Página Snapping

Utilize as opções nesta página para ajustar o snap do cursor.

Picking

Snap to Vertex Selecione esta caixa de seleção para efetuar o snap do cursor
para o vértice mais próximo.

Snap to Edge Selecione esta caixa de seleção para efetuar o snap do cursor
para a aresta triangular mais próxima.

Snap to Line Vertex Selecione esta caixa de seleção para efetuar o snap do
cursor para a extremidade da linha próxima.

Tolerance Define a tolerância de snap. Quanto menor o valor, mais perto o
cursor precisa estar para aparecer no modelo antes de efetuar o snap.

Rotation

Angles Especifica o multiplicador para o ângulo de snap.

Angle Sensitivity Define a tolerância de snap. O valor aqui inserido determina
quão perto o cursor precisa estar do ângulo de snap para que o snap tenha
efeito.
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Página Viewpoint Defaults

Utilize as opções nesta página para definir atributos que sãos alvos com pontos
de vista quando você os cria.

Quando você modifica as configurações padrão do ponto de vista, suas
alterações não afetam o arquivo do Autodesk Navisworks aberto no momento.
Elas são utilizadas assim que você abre um novo arquivo do Autodesk
Navisworks ou inicia uma nova sessão do Autodesk Navisworks.
Save Hide/Required Attributes Selecione esta caixa de seleção para salvar
pontos de vista com informações de revisão ocultas/requeridas sobre objetos
em seu modelo. Quando você utiliza novamente um ponto de vista, as revisões
ocultas/requeridas definidas quando o ponto de vista foi salvo são aplicadas.

Por padrão, esta caixa de seleção está desmarcada, já salvar as informações de
estado com cada ponto de vista requer um quantidade relativamente grande
de memória.

Override Material Selecione esta caixa de verificação para salvar pontos de
vista com informações de sobreposição de material. Quando você utiliza
novamente um ponto de vista, as sobreposições de material definidas quando
o ponto de vista foi salvo são aplicadas.

Por padrão, esta caixa de seleção está desmarcada, já salvar as informações de
estado com cada ponto de vista requer um quantidade relativamente grande
de memória.

Override Linear Speed Por padrão, a velocidade de navegação linear está
diretamente relacionada ao tamanho de sue modelo. Selecione esta caixa de
seleção se você deseja definir manualmente uma velocidade específica de
navegação. Esta opção está disponível somente em um espaço de trabalho 3D.

Default Linear Speed Especifica o valor padrão da velocidade linear. Esta
opção está disponível somente em um espaço de trabalho 3D.

Default Angular Speed Especifica a velocidade padrão na qual a câmera gira.
Esta opção está disponível somente em um espaço de trabalho 3D.

Página Links

Utilize as opções nesta página para personalizar a forma como os links são
exibidos na Scene View.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.
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Show Links Alterna a exibição dos links na Scene View.

In 3D Indica se os ícones de link são desenhados em 3D na Scene View.

Selecione esta caixa se deseja que os links flutuem no espaço 3D justo em
frente de seus pontos de anexação à geometria.

Se os links se tornam obscurecidos por outra geometria, desmarque esta caixa
de seleção para desenhar os ícones de link em 2D acima do topo da geometria.

Max Icons Especifica o número máximo de ícones a serem desenhados na
Scene View.

Hide Colliding Icons Selecione esta caixa de seleção para ocultar os ícones
de link que aparecem sobrepostos na Scene View.

Cull Radius Especifica quão perto os links da câmera têm de estar antes de
serem desenhados na Scene View. Quaisquer links mais longe do que esta
distância não são desenhados. O valor padrão de 0 significa que todos os links
são desenhados.

X Leader Offset, Y Leader Offset Os links podem ser desenhados com linhas
de chamada de detalhe (setas) apontando para o ponto de anexação na
geometria à qual o link está anexado. Insira os valore de X- e Y- para especificar
o número de pixels para a direita e para acima que estas linhas de chamada
de detalhe irão utilizar.

Página Standard Categories

Utilize as configurações nesta página para alternar a exibição de links com
base em suas categorias.

Hyperlink

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão  e  na Scene View.

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.
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Legenda

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão  e  na Scene View.

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

TimeLiner Playback

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão na Scene View.

 - links para tarefas manualmente criadas■

■  - links para tarefas com links válidos

■  - links para tarefas com links quebrados

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

Hide Icons Without Comments Selecione esta caixa de seleção para somente
exibir os links que tenham comentários na Scene View.

Página User-Defined Categories

Utilize esta página para visualizar categorias de links personalizados.

O ícone de cadeado  indica que você não pode adicionar ou remover
categorias diretamente daqui.
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Página Quick Properties

Utilize as opções nesta página para personalizar a forma como as propriedades
rápidas são exibidas na Scene View.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Show Quick Properties Alterna a exibição das propriedades rápidas na Scene
View.

Hide Category Desmarque esta caixa de seleção para incluir nomes de
categorias nas dicas de ferramenta das propriedades rápidas.

Caso não deseje visualizar nomes de categorias nas dicas de ferramentas das
propriedades rápidas, selecione esta caixa de seleção.

Página Definitions

Página Developer

Utilize as opções nesta página para ajustar a exibição de propriedades do objeto.

Show Internal Properties Indica se as propriedades adicionais do objeto são
exibidas no Autodesk Navisworks.

Selecione esta caixa de seleção se deseja ter acesso à guia Geometry e à guia
Transform na barra de controle Properties.

Página Display

Utilize as opções nesta página para ajustar o desempenho de exibição.

Gráficos 2D

Nível de detalhe  É possível ajustar o nível de detalhe de seus gráficos 2D, o
que significa que você pode trocar entre o desempenho da renderização e a
fidelidade 2D. Selecione entre as seguintes opções:
■ Low - fornece fidelidade 2D inferior, mas um melhor desempenho de

renderização.
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■ Medium - fornece fidelidade 2D média e desempenho médio de
renderização, esta é a opção padrão.

■ High - fornece fidelidade 2D maior, mas menor desempenho de
renderização.

Detail

Guarantee Frame Rate Por padrão, esta caixa de seleção é selecionada e a taxa
alvo é mantida ao mover. Quando o movimento para, todo o modelo é
renderizado.

Se esta caixa de seleção estiver desmarcada, o modelo completo é sempre
renderizado durante a navegação, não importando quanto tempo levar.

Fill In Detail Indica se o Autodesk Navisworks preenche qualquer detalhe
descartado quando a navegação é parada.

Sistema de gráficos

Seleção automática  O Autodesk Navisworks suporta dois sistemas de gráficos:
gráficos do Presenter e gráficos da Autodesk. Por padrão, esta caixa de seleção
é selecionada e o Autodesk Navisworks controla qual sistema de gráficos que
deseja utilizar. Desmarque esta caixa de seleção se você mesmo deseja selecionar
o sistema. Isso ativa a caixa suspensa System.

Hardware Acceleration Selecione esta caixa de seleção para utilizar qualquer
aceleração por hardware OpenGL disponível em sua placa de vídeo.

Se os drivers de sua placa de vídeo não funcionam bem com o Autodesk
Navisworks, desmarque esta caixa de seleção.

OBSERVAÇÃO Se sua placa de vídeo não suporta a aceleração por hardware
OpenGL, esta caixa de seleção não está disponível.

System  Esta caixa suspensa está disponível quando você desmarca a caixa de
seleção Auto-Select. Selecione entre as seguintes opções:
■ Presenter - suporta a exibição dos materiais do Presenter e usa hardware

ou software OpenGL.

■ Autodesk - suporta a exibição dos materiais da Autodesk e usa o Direct3D
ou o Hardware OpenGL.

OBSERVAÇÃO Os modelos 3D podem usar um sistema de gráficos; o sistema
Presenter é a opção padrão. As folhas 2D só podem utilizar o Autodesk Graphics
e não serão renderizadas sem uma placa gráfica Direct 3D/OpenGL compatível.

304 | Capítulo 13    Reference



Occlusion Culling Selecione esta caixa de seleção para ativar a seleção da
obstrução. Isto significa que o Autodesk Navisworks somente desenha objetos
visíveis e ignora quaisquer objetos localizados atrás de outros objetos.

A seleção desta caixa de seleção aprimora o desempenho de exibição onde a
maior parte do modelo não está visível. Por exemplo, ao navegar por um
corredor de um edifício.

IMPORTANTE A seleção da oclusão somente pode ser utilizada em uma máquina
com uma placa gráfica compatível com o OpenGL. Além disso, a seleção da oclusão
não é utilizada em uma área de trabalho 2D.

Alerta

XYZ Axes Indica se o indicador XYZ Axes está exibido na Scene View.

Show Position  Indica se o Position Readout está exibido na Scene View.

Primitives

Point Size Insira um número de 1 a 9 para definir o tamanho em pixels de
pontos desenhados na Scene View.

Line Size Insira um número de 1 a 9 para definir a largura (em pixels) de linhas
desenhadas na Scene View.

Snap Size Insira um número de 1 a 9 para definir o tamanho (em pixels) de
pontos de snap desenhados na Scene View.

Enable Parametric Primitives Indica se o Autodesk Navisworks renderiza de
forma dinâmica primitivos paramétricos durante a navegação interativa.

A seleção desta caixa de seleção significa que o nível de detalhe muda durante
a navegação dependendo da distância da câmera.

Desmarque esta caixa de seleção para utilizar representações padrão de
primitivos. O nível de detalhe permanece o mesmo durante a navegação.

Transparency

Interactive Transparency Selecione esta caixa de seleção para renderizar itens
transparentes de forma dinâmica durante a navegação interativa.

Por padrão, esta caixa de seleção está desmarcada e, portanto, os itens
transparentes somente são desenhados quando a interação é parada.

OBSERVAÇÃO  Se sua placa de vídeo na suporta a aceleração por hardware
OpenGL, a seleção desta caixa de seleção pode afetar o desempenho de exibição.
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Página de drivers

Utilize as opções nesta página para ativar/desativar os drivers de exibição
disponíveis.

Drivers disponíveis

Esta é uma lista de todos os drivers que o Autodesk Navisworks pode suportar.
Por padrão, todos os drivers são selecionadas.

Software (OpenGL) Este é um driver legado, que funciona somente em
geometrias 3D. Se a caixa de seleção estiver desmarcada, o Autodesk Navisworks
irá ignorar o driver durante a renderização das geometrias.

Presenter (OpenGL) Este driver suporta o sistema de gráficos do Presenter e
somente funciona em geometrias 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (DirectX 9) Este driver suporta o sistema de gráficos da Autodesk
e funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (DirectX 10) Este driver suporta o sistema de gráficos da Autodesk
e funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (DirectX 11) Este driver suporta o sistema de gráficos da Autodesk
e funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (OpenGL) Este driver suporta o sistema de gráficos da Autodesk e
funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Página da Autodesk

Utilize as opções nesta página para ajustar os efeitos e os materiais usados no
modo de gráficos da Autodesk.
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Efeitos da Autodesk

Shader Style Define o estilo de sombreamento da Autodesk nas faces. Selecione
entre as seguintes opções:
■ Basic Material: exibição realista das faces, semelhante à maneira como

apareceriam no mundo real. Esta é a opção padrão.

■ Gooch: usa cores frias e quentes, em vez de escuras e claras, para melhorar
a exibição de faces que poderiam ficar sombreadas e difíceis de ver em uma
exibição realista.

Materiais da Autodesk

Use Fall Back  Esta opção fornece controle da exigência de usar o Basic Material
(material básico) em vez do material consistente da Autodesk. Se sua placa de
vídeo não funciona bem com o material consistente da Autodesk, esta opção
será utilizada automaticamente.

Use Lod Texture  Selecione esta caixa de seleção se desejar utilizar texturas
LOD.

Reflection Enabled  Selecione esta caixa de seleção para ativar a reflexão de
cores para o material consistente da Autodesk.

Highlight Enabled  Selecione esta caixa de seleção para ativar a cor de espectro
para o material consistente da Autodesk.

Bump Enabled  Selecione esta opção se você deseja usar um mapa de saliência,
o que faz com que um objeto pareça ter uma superfície com saliências ou
irregular. Por exemplo, quando você renderiza um objeto com um material
mapeado com saliência, as áreas mais claras (mais brancas) do mapa parecem
ser áreas elevadas e áreas mais escuras (mais pretas) parecem estar baixas. Se
a imagem estiver em cores, o valor de escala de cinza de cada cor é usada. O
mapeamento de curvas aumenta significativamente o tempo de renderização
mas adiciona ao realismo.

Image Library  Seleciona a biblioteca de materiais consistentes da Autodesk
com base na resolução da textura. Escolha entre as seguintes opções:
■ Base Resolution: biblioteca de materiais básicos, com resolução de

aproximadamente 256 x 256 pixels. Esta biblioteca é instalada por padrão
e é requerida pelo Autodesk Navisworks para suportar uma faixa completa
de funcionalidades de estilo visual e de cor.

■ Low Resolution: imagens de baixa resolução, aproximadamente 512 x
512 pixels.
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■ Medium Resolution: imagens de resolução média, aproximadamente
1024 x 1024 pixels.

■ High Resolution: imagens de alta resolução. Esta opção não é suportada
no momento.

Max Texture Dimensions  Esta opção afeta os detalhes visuais de texturas
aplicadas na geometria. Insira o valor desejado em pixels. Por exemplo, um
valor de "128" significa que o tamanho máximo da textura é de 128 x 128
pixels. Quanto maior o valor, maior a carga em sua placa gráfica, já que mais
MB de memória é necessário para renderizar texturas.

Procedural Texture Size  Esta opção fornece o tamanho das texturas geradas
a partir de mapas processuais. Por exemplo, um valor de "256" significa que o
tamanho da textura é de 256 x 256, gerada a partir de mapas processuais.
Quanto maior o valor, maior a carga em sua placa gráfica, já que mais MB de
memória é necessário para renderizar texturas.

Múltiplas amostras de suavização de serrilhado

MSAA Level Define o valor da suavização de serrilhado para renderizar no
modo de gráficos da Autodesk. A suavização de serrilhado é utilizada para
suavizar as arestas da geometria. Quanto maior o número, mais suave é a
geometria, mas a renderização levará mais tempo. 2x é a opção padrão.

OBSERVAÇÃO Se a sua placa de vídeo não suporta um MSAA maior, utilize um
MSAA inferior que a placa de vídeo possa suportar automaticamente.

Página 3Dconnexion

Utilize as opções nesta página para personalizar o comportamento de
dispositivos 3Dconnexion.

OBSERVAÇÃO Todas as opções são selecionados por padrão. Se você efetuar
quaisquer alterações, é possível clicar no botão Default para restaurar as
configurações originais.

Estas opções são oferecidas em adição aos ajustes que podem ser feitos
utilizando o Painel de controle para o dispositivo que é fornecido pelo
fabricante do dispositivo com a instalação.
Speed (Velocidade) Utilize o deslizador para ajustar a sensibilidade do
controlador.
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Keep Scene Upright Selecione esta caixa de seleção para desativar o eixo de
rolagem. Quando selecionado, não será possível rolar o modelo para os lados.

Center Pivot on Selection (Centralizar giro na seleção) Selecione esta caixa
de seleção para mover o ponto de giro para o centro de quaisquer seleções
feitas por você.

Pan/Zoom Selecione esta caixa de seleção para ativar a funcionalidade de pan
e zoom no dispositivo 3Dconnexion.

Tilt/Spin/Roll (Inclinar/Girar/Rolar) Selecione esta caixa de seleção para
ativar a funcionalidade de inclinação, giro e rolagem do dispositivo
3Dconnexion.

Página Navigation Bar

Utilize as opções nesta página para personalizar o comportamento das
ferramentas na barra de navegação.

Ferramentas Orbit

Use Classic Orbit Selecione esta caixa de seleção se deseja mudar da ferramenta
Órbita padrão para o modo Órbita clássico do Autodesk Navisworks na barra
de navegação.

Use Classic Free Orbit (Examine) Selecione esta caixa de seleção se deseja
mudar da ferramenta Órbita livre padrão para o modo Examinar clássico do
Autodesk Navisworks na barra de navegação.

Use Classic Constrained Orbit (Turntable) Selecione esta caixa de seleção se
deseja mudar da ferramenta Órbita restringida padrão para o modo clássico
Mesa giratória do Autodesk Navisworks na barra de navegação.

Ferramenta Walk

Use Classic Walk Selecione esta caixa de seleção se deseja mudar da ferramenta
Navegar padrão para o modo Navegar clássico do Autodesk Navisworks na
barra de navegação.

Constrain Walk Angle Quando esta caixa de seleção é selecionada, a
ferramenta Walk manterá a câmera em pé ao navegar. Se esta caixa de seleção
for desmarcada, a ferramenta permitirá que a câmera role enquanto navega
(resultando em um comportamento quase parecido com a ferramenta Fly).
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Use Viewpoint Linear Speed Quando esta caixa de seleção é selecionada, a
ferramenta Walk irá respeitar a configuração de Viewpoint Linear Speed. Neste
caso, o deslizador de velocidade Walk irá agir como um multiplicador.

Quando esta caixa de seleção é desmarcada, a ferramenta Walk irá trabalhar
independente da configuração de Viewpoint Linear Speed, usando um valor
fixo definido com o deslizador.

Walk Speed Define e velocidade da ferramenta Walk de 0.1 (muito lenta) para
10 (muito rápida).

Página ViewCube

Utilize as opções nesta página para personalizar o comportamento ViewCube.

Show the ViewCube Indica se o ViewCube é ou não exibido na Scene View.

DICA Também é possível alternar o ViewCube ao clicar na guia View  ➤  painel

Navigation Aids  ➤  ViewCube  .

Size Especifica o tamanho do ViewCube. Você pode escolher entre as seguintes
opções:
■ Automatic

■ Tiny

■ Small

■ Medium

■ Large

OBSERVAÇÃO No modo automático, o tamanho do ViewCube é relativo ao
tamanho da Scene View, e se encontra médio e bem pequeno.

Opacidade de inatividade Quando o ViewCube está inativo, ou seja, seu
cursor está distante do ViewCube, e ele aparece transparente. Para controlar
o nível de opacidade, escolha entre as seguintes opções:
■ 0%

■ 25%

■ 50%

■ 75%

■ 100%
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Keep Scene Upright Indica se as orientações de cabeça para baixo da cena é
permitida quando você utiliza o ViewCube.

Quando esta caixa de seleção estiver selecionada, arrastar o ViewCube produz
um efeito de mesa giratória.

Ao arrastar no ViewCube

Enquanto estiver sendo arrastado, o ViewCube e a cena rotacionam de uma
forma como um bola de arco, a não ser que a caixa de seleção Manter cena
em pé esteja selecionada.

Snap to the Closest View Indica se o ViewCube efetua o snap para uma das
vistas fixas quando estiver angularmente perto de uma das vistas fixas.

Ao clicar no ViewCube

Fit-to-View on Change Quando esta caixa de seleção estiver selecionada,
clicar no ViewCube rotaciona em torno do centro da cena e afasta o zoom
para que a cena caiba na Scene View. Antes de arrastar o ViewCube, a vista
muda para olhar para o centro da cena (mas não efetua o zoom) e continua a
usá-lo como o ponto de rotação ao arrastá-lo.

Se esta caixa de seleção estiver desmarcada, clicar ou arrastar o ViewCube,
rotaciona em torno do ponto de giro atual e não aproxima ou afasta o zoom.

Use Animated Transitions When Switching Views Se esta caixa de seleção
estiver selecionada, uma transição animada é exibida quando se clica em uma
seção do ViewCube para ajudá-lo a visualizar o relacionamento espacial entre
o ponto de vista atual e o ponto de vista selecionado.

OBSERVAÇÃO Ao navegar em cenas 3D que contêm grandes quantidades de
geometria, a taxa do quadro do aplicativo pode cair e tornar difícil para o sistema
animar com suavidade uma transição de ponto de vista.

Show the Compass Below the ViewCube Indica se a bússola é exibida abaixo
da ferramenta ViewCube.

SteeringWheels

Utilize as opções nesta página para personalizar os menus do SteeringWheels.
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Big Wheels

Size Especifica o tamanho dos círculos grandes. Você pode escolher entre as
seguintes opções:
■ Small (64x64)

■ Normal (128x128)

■ Large (256x256).

Normal  esta é a opção padrão.

Opacity Controla o nível de opacidade dos círculos grandes. O valor-padrão
é 50%. Você pode escolher entre as seguintes opções:
■ 25% (o mais transparente)

■ 50%

■ 75%

■ 90% (o mais opaco)

Mini Wheels

Size Especifica o tamanho dos minicírculos. Você pode escolher entre as
seguintes opções:
■ Small (16x16)

■ Normal (32x32)

■ Large (64x64).

■ Extra Large (256x256)

Normal  esta é a opção padrão.

Opacity Controla o nível de opacidade dos minicírculos. O valor-padrão é
50%. Você pode escolher entre as seguintes opções:
■ 25% (o mais transparente)

■ 50%

■ 75%

■ 90% (o mais opaco)

Mensagens na tela

Show Tool Messages Alterna a exibição de dicas de ferramentas para as
ferramentas de navegação. Quando esta caixa de seleção é selecionada, as dicas
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de ferramentas são exibidas abaixo do cursor quando você utiliza as
ferramentas.

OBSERVAÇÃO Esta configuração está sempre ativa para os círculos View Object
e Tour Building, e não pode ser desativada.

Show Tooltips Alterna a exibição de dicas de ferramentas de círculos. Quando
esta caixa de seleção é selecionada, as dicas de ferramentas são exibidas quando
você passa o cursor sobre os setores nos círculos.

OBSERVAÇÃO Esta configuração está sempre ativa para os círculos View Object
e Tour Building, e não pode ser desativada.

Show Tool Cursor Text Alterna a exibição da legenda da ferramenta abaixo
do cursor.

OBSERVAÇÃO Esta configuração está sempre ativa para os círculos View Object
e Tour Building, e não pode ser desativada.

Ferramenta Look

Invert Vertical Axis A seleção desta caixa de seleção troca o eixo acima-abaixo
pela ferramenta Look, ou seja, empurrando o mouse adiante olha para baixo
e puxando o mouse para atrás olha acima.

Ferramenta Walk

Constrain Walk Angle A seleção desta caixa de seleção faz com que a
ferramenta Walk respeite o vetor acima universal (como definido em File
Options  ➤  Orientation). Como resultado, a ferramenta Walk faz com que a
câmera efetue o snap ao vetor acima atual.

Quando esta caixa de seleção está desmarcada, a ferramenta Walk desconsidera
o vetor acima e a câmera é movimentada com esta orientação acima atual não
afetada.

Use Viewpoint Linear Speed Quando esta caixa de seleção é selecionada, a
ferramenta Walk irá respeitar a configuração de Viewpoint Linear Speed. Neste
caso, o deslizador de velocidade Walk irá agir como um multiplicador.

Quando esta caixa de seleção é desmarcada, a ferramenta Walk irá trabalhar
independente da configuração de Viewpoint Linear Speed, usando um valor
fixo definido com o deslizador.

Walk Speed Define e velocidade da ferramenta Walk de 0.1 (muito lenta) para
10 (muito rápida).
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Ferramenta Zoom

Enable Single-Click Incremental Zoom In Quando esta caixa de seleção
estiver selecionada, clicar uma vez sobre a seção Zoom aumenta a ampliação
do modelo. Quando esta caixa de seleção está desmarcada, nada acontece
quando você clica uma vez na seção Zoom.

Ferramenta Orbit

Keep Scene Upright Quando esta caixa de seleção estiver selecionada, a
ferramenta Orbit se comporta de forma similar ao modo Orbit clássico, com
a órbita restringida ao longo do eixo XY e na direção Z.

Quando esta caixa de seleção está desmarcada, a ferramenta Orbit se comporta
de forma similar ao modo Examine clássico, e é possível rolar o modelo em
torno do ponto de giro.

Center Pivot on Selection (Centralizar giro na seleção) Quando esta caixa
de seleção estiver selecionada, os objetos selecionados antes da ferramenta
Orbit são usados para calcular o ponto de giro para uso ao orbitar. O ponto
de giro é calculado com base no centro das extensões dos objetos selecionados.

Página User Interface

Utilize as opções nesta página para escolher a interface de usuário (padrão ou
clássica), e selecionar o tema de cor.

User Interface Selecione entre as seguintes opções:
■ Classic. Alterna para a interface clássica do Autodesk Navisworks com

menus e barras de ferramentas antigos.

■ Standard (recomendado). Alterna para a nova interface com uma paleta
de ferramentas da faixa de opções. Esta é a opção padrão.

Theme Utilize a lista suspensa para aplicar um dos temas de interface
predefinidos.

Nó Model

Utilize as configurações neste nó para otimizar o desempenho do Autodesk
Navisworks e para personalizar parâmetros para os arquivos NWD e NWC.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.
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Página Performance

Utilize as opções nesta página para otimizar o desempenho do Autodesk
Navisworks.

Memory Limit

Auto Indica se o Autodesk Navisworks determina automaticamente a memória
máxima que pode ser utilizada. A seleção desta caixa de seleção define o limite
de memória para a menor memória física disponível ou espaço de endereço,
menos o requerido por seu sistema operacional.

Limit (MB) Especifica a memória máxima que o Autodesk Navisworks pode
utilizar.

Merge Duplicates

Esta opção aprimora o desempenho ao multiplicar as instâncias de coincidência
de itens. Em vez de armazenar cada item na memória, se quaisquer itens forem
os mesmos, o Autodesk Navisworks pode armazenar uma instância deles e
"copiar" aquela instância em outras posições. Isso tem particular benefício em
modelos grandes, onde há significativo número destas geometrias duplicadas.

On Convert Selecione esta caixa de seleção para mesclar duplicados quando
um arquivo CAD é convertido para o formato do Autodesk Navisworks.

On Append Selecione esta caixa de seleção para mesclar duplicados quando
um novo arquivo é anexado ao arquivo do Autodesk Navisworks aberto no
momento.

On Load Selecione esta caixa de seleção para mesclar duplicados quando um
arquivo é carregado no Autodesk Navisworks.

On Save NWF Selecione esta caixa de seleção para mesclar duplicatas quando
a cena atual é salva no formato de arquivo NWF.

On Load

Collapse on Convert Retrai a estrutura de árvore na Selection Tree para o
nível especificado quando arquivos CAD nativos são convertidos ao Autodesk
Navisworks. Selecione entre as seguintes opções:
■ None - toda a árvore é expandida. Use esta opção para permitir que

polilinhas sejam divididas em segmentos individuais ao importar DWGs
e DGNs para suportar múltiplas intersecções de interferência. Para arquivos
DGN, também é preciso selecionar File Readers ➤ DGN ➤ caixa de
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seleção Split Lines, e desmarcar File Readers ➤ DGN ➤ caixa de
seleção Merge Lines and Arcs. Para arquivos DWG, também é preciso
definir File Readers ➤ DWG/DXF ➤ menu suspenso Line Processing
como Separate All Lines.

■ Composite Objects - a árvore é retraída ao nível de objetos compostos.

■ All Objects - a árvore é retraída ao nível de objetos.

■ Layers - a árvore é retraída ao nível de camadas.

■ Files - a árvore é retraída ao nível de arquivos.

Isto permite que o desempenho seja priorizado acima da estrutura/propriedades
e tem o benefício adicional de aprimorar a racionalização ao cortar para baixo
da estrutura lógica.

OBSERVAÇÃO Embora o Autodesk Navisworks tente retrair itens para o menor
número possível, pode ser necessário prevenir a retração em alguns casos para
preservar a fidelidade do modelo. Por exemplo, se um item tem propriedades ou
materiais que lhe são únicos, então a retração iria prejudicar esta informação e,
portanto, ele não será retraído.

Close NWC/NWD files on Load Indica se os arquivo NWC e NWD são
fechados após serem carregados na memória.

Quando você abre arquivos NWC/NWD, o Autodesk Navisworks, eles são
bloqueados para edição. Ao selecionar esta caixa de seleção, você instrui o
Autodesk Navisworks a fechar os arquivos NWC ou NWD assim que estiverem
carregados na memória. Isso significa que os arquivos podem ser abertos e
editados por outros usuário enquanto você os está visualizando.

Create Parametric Primitives Selecione esta caixa de seleção para permitir a
criação de modelos paramétricos (modelos descritos por fórmula e não por
vértices).

A utilização desta opção permite obter visualização de melhor aparência,
renderização mais rápida, menor espaço de memória (especialmente ao carregar
arquivos DGN e RVM com alto volume de dados paramétricos que não mais
precisam ser convertidos em vértices no Autodesk Navisworks).

OBSERVAÇÃO A modificação desta opção entra em feito após a próxima carga
ou atualização do arquivo.

Create Presenter Materials Selecione esta caixa de seleção para permitir a
criação de materiais do Presenter quando arquivos NWC são carregados.

Desmarcar esta caixa desativa a criação de materiais do Presenter.
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Temporary File Location

Auto Indica se o Autodesk Navisworks seleciona automaticamente sua pasta
Temp.

Location  Clique em  para abrir a caixa de diálogo Browse for Folder
, e selecione a localização desejada da pasta Temp.

Página NWD

Utilize as opções nesta página para ativar e desativar a compressão de geometria
e selecionar se a precisão de determinadas opções é reduzida ao salvar ou
publicar arquivos NWD.

Geometry Compression

Enable Selecione esta caixa de seleção para ativar a compressão da geometria
quando arquivos NWD são salvos.

A compressão da geometria resulta em menos memória necessária e, portanto,
arquivos NWD menores.

Reduce Precision

Coordinates Selecione esta caixa de seleção para reduzir a precisão de
coordenadas.

Precision Especifica o valor de precisão para coordenadas. Quanto maior o
valor menor a precisão das coordenadas.

Normals Selecione esta caixa de seleção para reduzir a precisão de normais.

Colors Selecione esta caixa de seleção para reduzir a precisão de cores.

Texture Coordinates Selecione esta caixa de seleção para reduzir a precisão
de coordenadas de textura.

Página NWC

Utilize as opções desta página para gerenciar a leitura e gravação de arquivos
cache (NWC).

Por padrão, quando o Autodesk Navisworks abre um arquivo CAD nativo (por
exemplo, AutoCAD ou MicroStation), primeiro ele verifica no mesmo diretório
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se um arquivo cache está presente com o mesmo nome que o arquivo CAD,
mas com uma extensão .nwc. Se houver e este arquivo cache for mais recente
que o arquivo CAD nativo, o Autodesk Navisworks abre esse arquivo, já que
o mesmo já foi convertido para o formato do Autodesk Navisworks e, portanto,
abre muito mais rápido. No entanto, se não houver um arquivo cache presente
ou se o arquivo cache for mais antigo do que o arquivo CAD nativo, o Autodesk
Navisworks precisa abrir o arquivo CAD e convertê-lo. Por padrão, ele grava
um arquivo cache no mesmo diretório e com o mesmo nome do arquivo CAD,
mas com a extensão .nwc, para acelerar a abertura deste arquivo no futuro.

Caching

Read Cache Selecione esta caixa de seleção para utilizar arquivos cache quando
o Autodesk Navisworks abre arquivos CAD nativos.

Desmarque esta caixa de seleção se não desejar utilizar arquivo cache. Isto
assegura que o Autodesk Navisworks converta arquivos CAD nativos sempre
que eles são abertos.

Write Cache Selecione esta caixa de seleção para salvar arquivos cache quando
o arquivo CAD nativo é convertido. Geralmente, os arquivo cache são bem
menores do que os arquivos CAD originais e, portanto, a seleção desta opção
não ocupa muito espaço em disco.

Desmarque esta caixa de seleção se não desejar salvar arquivos cache.

Geometry Compression

Enable Selecione esta caixa de seleção para ativar a compressão da geometria
quando arquivos NWC são salvos.

A compressão da geometria resulta em menos memória necessária e, portanto,
arquivos NWC menores.

Reduce Precision

Coordinates Selecione esta caixa de seleção para reduzir a precisão de
coordenadas.

Precision Especifica o valor de precisão para coordenadas. Quanto maior o
valor menor a precisão das coordenadas.

Normals Selecione esta caixa de seleção para reduzir a precisão de normais.

Colors Selecione esta caixa de seleção para reduzir a precisão de cores.

Texture Coordinates Selecione esta caixa de seleção para reduzir a precisão
de coordenadas de textura.
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Glossário

Glossário de termos técnicos relativos ao Autodesk Navisworks Freedom 2012.

Terminologia de exibição

taxa média de quadros Mostra a taxa de quadro medida atual, com a média calculada sobre
o último segundo.

tempo médio de quadros Mostra o tempo decorrido para renderizar o último quadro.

taxa média triangular Mostra a taxa na qual os triângulos estão sendo renderizados e é uma
medida de quão bem sua placa gráfica está funcionando.

seleção A seleção é um processo para determinar itens para que não sejam desenhados durante
a renderização de uma cena. O Autodesk Navisworks cria um nível de seleção priorizada com
o método de descarte na página 319 para renderizar cenas interativas, mas você tem algum
controle sobre os aspectos da seleção, como face traseira e planos de recorte próximo e afastado.

descarte Para manter a interatividade e garantir uma frequência de quadros na página 319
definida pelo usuário, o Autodesk Navisworks somente renderiza o que pode na fração de
segundo que ele tem. O restante é 'descartado' ou não renderizado.

O Autodesk Navisworks prioriza o que é renderizado e o que é descartado, com base no
tamanho da caixa de delimitação do item, distância do visualizador e tamanho na cena,
portanto, somente os itens menos significativos na cena são descartados.

Após a navegação tiver terminada, a cena continua a ser renderizada até que todos itens
estejam visíveis.

taxa de quadro A taxa de quadro é o número de quadros por segundo (FPS) que são
renderizados na janela de navegação principal. O Autodesk Navisworks garante um frequência
de quadros definida pelo usuário para manter a interatividade.

Terminologia de arquivo

arquivos de dados publicados (NWD) Os arquivos NWD publicados são úteis ao se desejar
obter um instantâneo do modelo em determinado momento. Toda a informação de geometria
e revisão é salva nos arquivos NWD, não podendo assim ser alterada. Os arquivos NWD
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publicados também podem conter informações sobre o arquivo, assim como são capazes de
serem protegidos por senha e marcados no tempo para fins de segurança. Estes arquivos são
também bem pequenos, comprimindo os dados de CAD em até 80% de seu tamanho original.

Os arquivos NWD publicados são úteis ao emitir modelos para a visualização com o
visualizador grátis Autodesk Navisworks Freedom 2012, assim como podem ser anexados
no Autodesk Navisworks para construir uma cena maior.

Terminologia de seleção

Estes são termos específicos ao Autodesk Navisworks que são utilizados em relação a seleção
de itens.
objetos compostos Um objeto composto é um grupo de geometrias que é considerado um
objeto único na árvore de seleção. Por exemplo, um objeto de janela pode ser comporta de
uma esquadria e um painel. Se um objeto composto, o objeto de janela seria a esquadria e
o painel e seriam selecionados todos de uma só vez.

instâncias Uma instância é um objeto único, que é referido diversas vezes em um modelo,
por exemplo uma árvore. Isso tem a vantagem de cortar o tamanho do arquivo ao não repetir
desnecessariamente um objeto.

nome do item O identificador atribuído ao CAD original ou ao Autodesk Navisworks.
Qualquer item podem ter um nome e este nome normalmente cem do pacote de CAD
original no qual o modelo foi criado.

tipo de item Cada item no Autodesk Navisworks tem um tipo. Exemplos de tipos são os
arquivos de referência, as camadas, as instâncias (algumas vezes chamadas de inserção), e
os grupos. Cada pacote CAD possui também um número de tipos de geometria, por exemplo,
polígonos, sólidos 3D, e assim por diante.

resolução de seleção A resolução de seleção é o nível na árvore de seleção no qual você
começa a selecionar. É possível percorrer itens na árvore ao manter pressionada a tecla SHIFT
durante uma seleção.

nome do usuário e nome interno Cada categoria e nome de propriedade tem duas partes
- uma sequência de usuário visível que está localizada e uma sequência interna que não está
e é usada principalmente pelo API. Por padrão, ao coincidir nomes nas caixas de diálogo
Smart Tags  e Find Items , ambas as partes precisam ser as mesmas, mas você pode utilizar
identificadores para coincidir somente uma parte. Você pode utilizar Ignore User Name
se desejar coincidir algo sem relação com a versão localizada que está sendo utilizada.

Terminologia do ponto de vista

velocidade angular A velocidade na qual a câmera se move ao virar para a direita e esquerda
em qualquer modo de navegação.
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suavização de serrilhado A suavização de serrilhado aprimora a qualidade da imagem ao
suavizar a aparência da aresta com desvio de linhas afiadas. 2x para 64x se refere ao número
extra de quadros que são necessários para o processo de suavização de serrilhado. Quanto
maior o número de quadros, mais fino o efeito (com o consequente aumento no tempo de
renderização).

relação de aspecto A relação de aspecto é a proporção do tamanho dos eixo X e Y. Por
exemplo, ao exportar um bitmap de um ponto de vista, manter a relação de aspecto iria
manter a proporção da vista, mesmo se o número de pixels fosse diferente.

centrado na câmera Os modos de navegação nos quais a câmera é movida em torno do
modelo.

campo de visão O campo de visão da câmera é o ângulo que a câmera pode ver. Um campo
e visão largo irá caber mais na vista, mas parecerá distorcido, e um campo de visão pequeno
terá a tendência de tornar a vista mais plana, tendendo em direção de uma vista ortogonal.
Há dois campos de visão no Autodesk Navisworks - vertical e horizontal. A edição de um
deles alterará o outro e os dois estão relacionados pela relação de aspecto na página 321 do
ponto de vista.

ponto focal O ponto focal é a posição no espaço 3D no qual a câmera irá rotacionar em
torno ou aproximar o zoom nos modos de examinar, orbitar, mesa giratória e zoom.

centrado no modelo Os modos de navegação nos quais o modelo é movido em frente da
câmera.

rolagem A rolagem da câmera é seu ângulo em torno do eixo de visualização. Este não pode
ser editado em um modo de navegação onde o vetor acima universal fica de pé (navegar,
orbitar e mesa giratória).

atributos salvos Cada ponto de visão pode opcionalmente salvar o estado dos seus itens
ocultos e "exigidos", assim como qualquer substituição de material (cor e transparência).
Então, ao chamar novamente o ponto e visão, estes itens são novamente ocultos, tornados
novamente requeridos, e os materiais são recolocados. Isso pode ser útil na criação de
animações ao arrastar em pontos de vista em uma animação vazia.

ângulo de inclinação Isto é indicado nas unidades de cena abaixo (negativa) ou acima
(positiva) horizontal (0) na base da janela Tilt.

vetor acima do ponto de vista A direção que o Autodesk Navisworks considera "para cima"
é chamada de "vetor para cima do ponto de vista". Esta é mantida nos modos de navegação,
órbita e de mesa giratória. Este pode ser também referido como "vetor mundial para cima".
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